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1 General Information | 1.1 Text Conventions and Link Types ZEISS

1 General Information
This Instruction Manual is considered to be part of the SEM workstation. Herein after referred to
as Microscope System.

This Instruction Manual contains basic steps and safety information that must be observed during
operation and maintenance. Therefore, it must be read by the operator prior to commissioning
and must always be available at the place of use of the Microscope System. This Instruction Man-
ual is a permanent part of the Microscope System and, if resold, must remain with the Microscope
System or be handed over to the new owner.

This manual contains the following chapters:

Chapter Content

General Information Explains the function and structure of this manual.

Safety Summarizes important safety details.

Product and Func-
tional Description

Describes the microscope and its main hardware components and
provides an overview of the user interface.

Installation Refers to the ZEISS service representatives.

Commissioning and
First Operating Steps

Contains information about starting the microscope and the software,
obtaining a first image, adjusting important parameters, and power-
ing down the microscope, also in emergency.

Care and Mainte-
nance

Informs you about preventive maintenance work and intervals and the
change of consumables.

Troubleshooting Describes common issues and how to resolve them.

Decommissioning
and Disposal

Summarizes notes on shutdown and disposal.

Technical Data and
Conformity

Lists hardware specifications as well as the manufacturer’s declaration
that the equipment is in conformity with all applicable European Di-
rectives.

Parts and Tools Lists consumables, spare parts, tools, and accessories.

Glossary Lists important technical terms.

Index Lists keywords to help you find relevant information quickly.

1.1 Text Conventions and Link Types

The following text conventions and link types are used:

Text convention Meaning

Click Start.

Press the STANDBY button.

Press [Enter] on the keyboard.

The names of controls and important infor-
mation are shown in bold letters.

Press <Ctrl+Alt+Del> Press several keys on the keyboard simultane-
ously.

Select Tools > Goto Control Panel > Air-
lock.

Follow a path in the software.
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ZEISS 1 General Information | 1.2 Explanation on Warnings and Additional Information

Text convention Meaning

Text input Text to be entered by the user

Programming and Macros Anything typed in literally during program-
ming, including, for example, macro codes,
keywords, data types, method names, vari-
ables, class names, and interface names.

Tab. 1: Text convention

Link type Meaning

See: Text Conventions and Link Types [} 6]. Link to further information for this topic.

https://www.zeiss.com/corporate/int/
home.html

Link to a website on the internet.

Tab. 2: Link types

1.2 Explanation on Warnings and Additional Information

DANGER, WARNING, CAUTION, and NOTICE are standard signal words used to determine the lev-
els of hazards and risks of personal injury and property damage. Not only the safety instructions
and warnings in the Safety chapter are to be considered but also the safety instructions and
warnings in other chapters. Failure to comply with these instructions and warnings can result in
both personal injury and property damage and involve the loss of any claims for damages.

The following symbols and warnings indicating dangerous situations and hazards are used in this
document.

 DANGER

Type and source of danger
DANGER indicates an imminently hazardous situation which, if not avoided, will result in death
or serious injury.

 WARNING

Type and source of danger
WARNING indicates a potentially hazardous situation which, if not avoided, may result in
death or serious injury.

 CAUTION

Type and source of danger
CAUTION indicates a potentially hazardous situation which, if not avoided, may result in minor
or moderate injury.

NOTICE

Type and source of danger
NOTICE indicates a potentially harmful situation which, if not avoided, may result in property
damage.
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1 General Information | 1.3 Further Applicable Documents ZEISS

Info
Provides additional information or explanations to help users better understand the contents
of this Instruction Manual.

1.3 Further Applicable Documents

Please take also note of the following documents:

Brochures and
Certificates

For Brochures, ISO certificates, CSA certificates and EU declarations of conformity ask your ZEISS
Sales & Service Partner.

Installation
Requirements

For more details on technical data, refer to the corresponding Installation Requirements.

Local and National
health and safety

regulations

Local and national health and safety regulations should be adhered to for the site and the use of
the Microscope System. Please consult with your ZEISS Sales & Service Partner in the event of
these regulations conflicting with the installation requirements of the Microscope System.

Safety data sheets Observe the enclosed safety data sheets. The instructions and guidelines given in the respective
safety data sheets must be complied with.

Software For more detailed information on how to use SmartSEM, please refer to its Online Help or ask
your ZEISS Sales & Service Partner.

System and 3rd
Party Components,

Accessories

The Microscope System can be configured in many ways. Information about the individual com-
ponents, enhancements and accessories can be obtained from your ZEISS Sales & Service Partner.
Also refer to the 3rd Party documentation of the manufacturer.

1.4 Contact

If you have any questions or problems, please contact your local ZEISS Sales & Service Partner or
one of the following addresses:

Headquarters

Phone: +49 1803 33 63 34

Fax: +49 3641 64 3439

Email: info.microscopy.de@zeiss.com

Courses and training

Email: courses.microscopy.de@zeiss.com

ZEISS Portal

The ZEISS Portal (https://portal.zeiss.com/) offers various services that simplify the daily work with
your ZEISS systems (machines and software). It is being constantly improved and extended to bet-
ter meet your needs and requirements.

ZEISS Sales & Service Partner

You can find a ZEISS Sales & Service Partner in your area under https://www.zeiss.de/mikroskopie/
website/forms/sales-and-service-contacts.html.

Service Germany

Phone: +49 7364 20 3800
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Fax: +49 7364 20 3226

Email: service.microscopy.de@zeiss.com
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2 Safety | 2.1 Intended Use ZEISS

2 Safety
This chapter contains general requirements for safe working practices. Any person using the Mi-
croscope System or commissioned with installation or maintenance must read and observe these
general safety instructions. Knowledge on basic safety instructions and requirements is a precon-
dition for safe and fault-free operation. Operational safety of the supplied Microscope System is
only ensured if it is operated according to its intended use.

If any work is associated with residual risks, this is mentioned in the relevant parts of this docu-
ment in a specific note. When components must be handled with special caution, they are
marked with a warning label. These warnings must always be observed.

2.1 Intended Use

The microscope has been designed to generate an image or to analyze appropriate specimens,
which is achieved by scanning a focused electron beam across the specimen (SEM Imaging).

In addition to microscopic examination, the microscope also allows for the modification of appro-
priate specimens. For these purposes, the specimen is placed in the evacuated specimen chamber.

The microscope has been designed for the following applications:

§ Imaging
Image generation and specimen analysis can be performed by means of a focused electron
beam that is scanned across the specimen.
This application allows for the analysis of surface structures and near-surface structures of ap-
propriate specimens.

§ Analytics
Elemental analysis with optional EDS spectroscopy at the focused electron beam position.
Crystal structure and orientation with optional EBSD detectors.

Info
Not for therapeutic, treatment or medical diagnostic evidence.

Info
Not all products are available in every country. Contact your local ZEISS representative for
more information.

SmartSEM
Software

The SmartSEM software is intended for the operation of scanning electron microscopes (SEMs).

The SmartSEM software has to be run exclusively on a personal computer delivered by ZEISS. Any
other applications are not allowed.

Regarding the operation of the microscope, the following regulations must be met:

§ Only operate the microscope according to the operating conditions after correct installation
by a ZEISS service representative.

§ The microscope is only to be used by operators who have been trained by a ZEISS service rep-
resentative. Basic operator training and safety instructions will be provided within the scope
of the initial start-up by ZEISS. Make sure that everyone who operates the microscope only
performs the tasks for which he/she is trained.

§ Operators of the microscope must not deviate from the instructions provided in this manual.

§ Only perform preventive maintenance tasks described in this manual. All tasks of mainte-
nance, service, and repair not described in this manual have to be performed by an authorized
ZEISS service representative.

§ The microscope is to be used in a laboratory environment for commercial and scientific pur-
poses only.

Using the microscope for any other purpose is not allowed and can be hazardous.
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ZEISS 2 Safety | 2.2 General Safety Information

Improper use can easily lead to impairment of its function or even damage to the Microscope Sys-
tem. Damage caused by incorrect operation, negligence or unauthorized intervention, in particu-
lar by removing, modifying or replacing parts of the device, can not be held liable by the device
manufacturer. Third-party devices or components that are not expressly approved by ZEISS may
not be used.

2.2 General Safety Information

This Instruction Manual must be read before commissioning in order to ensure safe and uninter-
rupted operation. Pay particular attention to all listed safety notes. Make sure, that

§ the operating personnel has read and understood this Instruction Manual, associated docu-
ments and particularly all safety regulations and instructions, and applies the same.

§ the local and national safety and accident prevention regulations must be observed, as well as
the applicable laws and regulations in your country.

§ this Instruction Manual is always available with/together with the Microscope System.

§ the Microscope System is always in perfect condition.

§ the Microscope System is secured against access by unauthorized persons.

§ maintenance and repair work, remodeling, removal or replacement of components, as well as
any other intervention in the Microscope System not described in this Instruction Manual, may
only be carried out by the manufacturer ZEISS or persons expressly authorized by ZEISS to do
so.

2.2.1 Safe Operation Conditions

If the product safety labels are covered or worn or if any of the safety devices are not in proper
working condition, operation of the microscope can be hazardous.

§ Periodically check the function of safety equipment and that all protective cover panels are in-
stalled.

§ Always follow the instructions given on the safety labels.

§ Inspect and clean the product safety labels to maintain good legibility.

2.2.2 Requirements for Personnel

Deviating from the instructions given in this manual and on the safety labels can be hazardous or
can lead to property damage.

§ Do not operate the microscope until you have completely read and understood the entire user
documentation delivered with the microscope.

§ Observe all safety labels on the microscope and within this manual.

§ Only operate the microscope according to the operating conditions after correct installation
by a ZEISS service representative.

§ Only ZEISS service representatives, who have specialized knowledge of radiation protection,
are permitted to service the microscope.

Operator Training

Within the scope of initial start-up, the ZEISS service representative will perform a basic operator
training. The basic operator training consists of fundamental operation procedures including
safety instructions. Besides, an introduction to basic maintenance tasks will be given for an ad-
vanced operator, who has to be an electrically skilled person. The training performed must be
documented appropriately.

Special application training is offered on request.
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2.2.3 Preventive Maintenance

Deviating from the maintenance and repair tasks described in this manual can be hazardous or
can lead to property damage:

§ Only perform preventive maintenance and repair tasks described in this manual.

§ All tasks of maintenance, service, and repair not described in this manual have to be per-
formed by an authorized ZEISS service representative.

§ To maintain best performance of the microscope, it is essential to perform preventive mainte-
nance on a regular basis. Moreover, it is recommended that you conclude a service contract
with your local ZEISS service representative or organization.

2.2.4 Safe Handling of Spare Parts

Using spare parts that are not provided by ZEISS can be hazardous or can lead to property dam-
age:

§ Only genuine parts supplied by ZEISS are to be used in servicing the microscope.

§ Contact your ZEISS service representative for information regarding how to order spare parts.

§ Unless authorized by ZEISS, all spare parts should be installed by a ZEISS service representa-
tive.

2.3 Prevention of Hazards

This section summarizes potential hazards and recommended safety precautions. Failure to follow
the safety instructions and instructions may result in personal injury and property damage.

2.3.1 Biological Hazards

 WARNING

Biological hazards
Biological substances may pose a threat to the health of humans and other living organisms.

4 Keep a logbook of the biological substances loaded into the microscope and show it to
the ZEISS service representatives before they perform any work on the microscope.

2.3.2 Burn Hazards

NOTICE

Hot surfaces during bakeout
Parts of the enclosure in the upper range of the column may become hot during bakeout, par-
ticularly after a long bakeout cycle.

4 Do not place any combustible objects on the grids of the electron optical column during
bakeout.

4 After the bakeout procedure, let surfaces cool down before working around the column.

4 Only advanced operators are allowed to perform the bakeout procedure.
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2.3.3 Chemical Hazards

 WARNING

Aggressive or toxic chemicals
Aggressive or toxic chemicals can cause chemical burns.

4 When handling aggressive or toxic chemicals, wear suitable protective clothing, gloves,
and eye/face protection.

4 Do not eat, drink, or smoke while handling toxic chemicals.

4 Refer to local safety regulations.

4 Read and follow the instructions in the material safety data sheet of the chemical. The ma-
terial safety data sheet can be obtained from the supplier of the chemicals.

 CAUTION

Oil mist around the rotary pump
The rotary pump RV12 may emit oil mist especially at high gas load (e.g. door accidently
open). Inhaled oil mist is harmful to health.

4 Regularly service the oil mist filter (refer to pump manual and material safety data sheets).
Recommended is the connection to an exhaust line.

NOTICE

Environmental risk due to disposal of aggressive or toxic chemicals
When disposing of aggressive or toxic chemicals, there is a threat of damage to the environ-
ment.

4 When disposing of waste that has been generated during a service operation (e.g. used ro-
tary pump oil), comply with all national and local safety and environmental protection reg-
ulations.

2.3.4 Electrical Hazards

 WARNING

Hazardous voltage inside the microscope
High voltages are present inside the microscope. Contact may cause burn or electrical shock.

4 Do not remove any parts.

4 Only authorized ZEISS service representatives are allowed to service the microscope.

4 Do not try to service the microscope yourself.

4 Disconnect power before opening.
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 WARNING

High leakage current
High leakage currents are present in the microscope. Contact may cause burn or electrical
shock.

4 Ensure proper grounding. For more information, refer to the Installation Requirements
document.

4 Do not operate the microscope without the separate ground connection.

 WARNING

Residual voltage at the mains plug
After unplugging the mains plug residual voltage is present at the pins of the plug which may
cause electrical shock.

4 After unplugging the mains plug wait at least 5 s before touching the pins of the mains
plug.

2.3.5 High Pressure Hazards

 WARNING

High pressure in gas cylinders
Gas cylinders containing for example nitrogen or compressed air have a high internal pressure
of approximately 200 bar. If not properly handled, the contained gas can abruptly escape and
cause the gas cylinder to move in an uncontrollable manner.

4 Observe all safety labels on the gas cylinders and all safety instructions given by the gas
cylinder manufacturer.

4 Always operate gas cylinders in an upright position and secure them so they will not tip
over.

4 Before transporting gas cylinders, place protective caps on them.

2.3.6 Magnetic Field Hazards

 WARNING

Malfunction of medical devices near ion getter pumps
Magnetic fields present at the ion getter pumps may disturb the function of medical devices.
The magnetic fields are also present if the microscope is switched off.

If you wear medical implants that are susceptible to magnetic fields (e.g. cardiac pacemakers),
do the following:

4 Keep a distance of at least 30 cm from the ion getter pumps.

4 Follow the safety instructions provided by the pump manufacturer.
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2.3.7 Mechanical Hazards

 WARNING

Crushing hazard when lowering the microscope
The microscope and its components are heavy. When the load is lowered during transport and
positioning, body parts can be crushed.

4 Maintain a safe distance.

4 Do not walk or place your hands or feet under the load while it is being lowered.

4 Wear safety shoes and gloves.

 CAUTION

Crushing hazard when moving ancillary equipment
The microscope and its components are heavy. When the load is lowered during transport and
positioning, body parts can be crushed.

Ancillary equipment associated with the microscope is very heavy. When the chiller, the rotary
pump(s), or the vibration block is moved, body parts can be crushed.

4 Take care when moving ancillary equipment.

 CAUTION

Moving the specimen stage
Fingers can be trapped by the moving specimen stage.

4 Always close the chamber door before moving the specimen stage.

4 To remove parts fallen into or near to the stage use a tool (e.g. tweezers) instead of your
fingers.

 CAUTION

Closing the chamber door
Fingers can be pinched when closing the chamber door.

4 Use the door handle to close the chamber door.

4 Ensure not to get your fingers caught in the chamber door gap.

 CAUTION

Fingers between isolated table and plinth
Fingers can be crushed in the gap between isolated table and plinth. The gap varies during op-
eration and while the air feet are adjusted.

4 Do not place your fingers between isolated table and plinth.
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NOTICE

Short working distance
When opening the chamber door, the microscope or specimen can be damaged if the speci-
men stage is at a short working distance. If a BSD detector is inserted, it can be damaged as
well.

4 Always retract any retractable detectors before opening the chamber door.

4 Always move the specimen stage to a long working distance before opening the chamber
door.

NOTICE

Contamination caused by fingerprints
Contamination caused by fingerprints can lead to vacuum deterioration or prolonged pumping
times.

4 Always wear lint-free gloves when touching the specimen, specimen holder, or stage.

2.3.8 Radiation Hazards

 CAUTION

Laser radiation class 1M
If the optional Raman Spectrometer is installed, then diffuse laser reflection may be visible
when the chamber door is open.

4 Do not view directly with optical instruments into the laser reflection.

 WARNING

Radiation hazard due to X-rays
X-rays are generated inside the microscope during operation. This is unavoidable because elec-
trons are accelerated by voltages up to 30 kV.

4 Do not remove any parts around the column and chamber that are essential for radiation
protection.

4 Use genuine ZEISS parts exclusively.

4 Ensure that all local safety and X-ray protection regulations are met.

4 Only authorized ZEISS service representatives are allowed to service the microscope.

The microscope is equipped with several radiation protection devices, which, under regular oper-
ating conditions, ensure that the microscope operates in accordance with the German X-ray pro-
tection regulation (RöV), the German radiation protection regulation (StrSchV) as well as with the
EC Directive 2013/59/EURATOM.

In the EU, the operation of the microscope is permission-free as the following requirements are
fulfilled:

§ The acceleration voltage is limited to 30 kV.

§ The local dose rate at a distance of 0.1 m from the accessible surface of the microscope does
not exceed 1 μSv/h.

§ A respective label is attached to the microscope.

Outside the EU, the user of the microscope has to comply with the local regulations of the coun-
try where the microscope is operated.
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Contact Radiation
Protection

For questions regarding radiation protection, contact the ZEISS Radiation Safety Officer, Carl Zeiss
AG, 73447 Oberkochen, Germany

phone: +49 (0) 7364 20 0

2.3.9 Suffocation Hazards

 WARNING

Suffocation hazard due to lack of oxygen
Gaseous dry nitrogen is used to vent the specimen chamber during specimen exchange. Inhal-
ing nitrogen may cause unconsciousness.

4 During specimen exchange, keep the chamber door open as short as possible.

4 Do not inhale the air from within the specimen chamber.

4 Ensure that the area around the microscope is sufficiently vented.

4 If you begin to experience symptoms of asphyxia (for example: rapid breathing, loss of
mental alertness and/or muscular coordination, depression of sensations, emotional insta-
bility, fatigue) leave the room immediately and inform the facility’s safety officer.

Concerning the hazards of nitrogen installations and associated safety precautions refer to the
current version of the guideline IGC Doc 44/18: Hazards of Oxygen-Deficient Atmospheres, pub-
lished by EIGA (European Industrial Gases Association).

To download the document:

1. Go to EIGA homepage www.eiga.eu.

2. Select Publications > EIGA Documents.

3. From the list, select Doc. 44/18.

4. Click Download.
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2.4 Warning Labels and Lights

All locations that may pose specific hazards are marked with additional warning labels (pic-
tograms) on the Microscope System. These warning labels indicate potential hazards and form
part of this Instruction Manual. They are to be kept in clean and easily legible condition. Damaged
or illegible warning labels must be replaced immediately. Always observe all warning labels on the
complete Microscope System.

2.4.1 Warning Labels

Appropriate safety labels on the microscope warn operators of hazards. Each safety label is af-
fixed close to the point where a particular hazard exists. Several labels also provide legal informa-
tion.

Front Side of
Microscope

2

1

3

4

5

1

2

4

5

3
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Rear Side of
Microscope

6

7

Rear Side of Plinth

8

9

10

11

13

12

CEE Connector
14
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The safety labels always need to be attached to the correct spots at the microscope. If a safety la-
bel is lost or unreadable, it needs to be reordered via the following reorder numbers:

Position and Figure of the Safety La-
bel

Description

1  At the front of the chamber door. Only present if the optional Raman Spectrometer
is installed.

Laser Radiation

Class 1M laser product

Do not view directly with optical instruments.

Diffuse laser reflection possible when chamber
door is open.

Reorder no. 344700-0033-000-15en

2  At the front of the chamber door.

347800-0007-000

Nitrogen Hazard

WARNING

Danger of suffocation

Ensure area around

instrument is sufficiently

ventilated

Nitrogen Hazard

Danger of suffocation

Ensure area around instrument is sufficiently ven-
tilated

Reorder no. 347800-0007-000

3  At the front of the chamber door.

CAUTION
 

Risk of injury

347800-0033-000-02en

Fingers could be trapped.

Always close the chamber door
before you move the stage.

Risk of injury

Fingers could be trapped. Always close the cham-
ber door before you move the stage.

Reorder no. 347800-0033-000-02en

4  At the front of the chamber door.

Risk of damage

CAUTION

347800-0033-000-04en

The FESEM or specimen could be
damaged if specimen stage is at a

short working distance.
Move the specimen stage to a long

working distance before opening
the chamber door.

Risk of damage

The FESEM or specimen could be damaged if
specimen stage is at a short working distance.

Move the specimen stage to a long working dis-
tance before opening the chamber door.

Reorder no. 347800-0033-000-04en

5  At the front of the plinth

Avoid injury

CAUTION

347800-0033-000-01en

Make sure you have read and 

understood the instruction 
manual before operating this 

product.

 

Avoid injury

Make sure you have read and understood the in-
struction manual before operating this product.

Reorder no. 347800-0033-000-01en

6  At the rear of the microscope

347800-0018-000

Interaction with metallic objects

may produce Pinch Hazards.
Persons with Medical Implants

KEEP BACK 12 inches.

Magnetic Field

CAUTION
 

Magnetic Field

Interaction with metallic objects may produce
Pinch Hazards.

Persons with Medical Implants KEEP BACK 12
inches.

Reorder no. 347800-0018-000
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Position and Figure of the Safety La-
bel

Description

7  At the rear of the microscope

347823-0016-000

HAZARDOUS VOLTAGE
INSIDE

WARNING

Contact may cause electric
shock or burn.
Disconnect power before
opening.

HAZARDOUS VOLTAGE INSIDE

Contact may cause electric shock or burn.

Disconnect power before opening.

Reorder no. 347823-0016-000

8  At the rear side of the plinth

347800-0016-100

X-rays are generated inside

the electron microscope
during operation.

Do not remove any parts.
Use genuine ZEISS parts

exclusively.
Observe local safety and

X-ray protection regulations.

Radiation hazard

CAUTION

Radiation hazard

X-rays are generated inside the electron micro-
scope during operation.

Do not remove any parts.

Use genuine ZEISS parts exclusively.

Observe local safety and X-ray protection regula-
tions.

Reorder no. 347800-0016-100

9  At the rear side of the plinth

Im EVO/SIGMA entstehen Röntgenstrahlen!
Die Beschleunigungsspannung ist auf 30 kV begrenzt.
Die Ortsdosisleistung an der Geräteoberfläche liegt unterhalb
des zulässigen Grenzwertes.

ACHTUNG:

X-rays are produced within the EVO/SIGMA instrument
The acceleration voltage is limited to 30 kV. Dose rates
around the microscope are less than the maximum permissible
values.

CAUTION:

CAUTION:

X-rays are produced within the EVO/SIGMA in-
strument

The acceleration voltage is limited to 30 kV. Dose
rates around the microscope are less than the
maximum permissible values.

10  At the rear side of the plinth

347823-0016-000

HAZARDOUS VOLTAGE
INSIDE

WARNING

Contact may cause electric
shock or burn.
Disconnect power before
opening.

HAZARDOUS VOLTAGE INSIDE

Contact may cause electric shock or burn.

Disconnect power before opening.

Reorder no. 347823-0016-000

12  At the rear side of the plinth Risk of electrical shock

Residual voltage at the mains plug after unplug-
ging.

Wait at least 5 s after unplugging the mains plug
before touching the pins of the mains plug.

Reorder no. 344700-0033-000-11en

13  At the rear side of the plinth

347800-0004-000

Instrument can be damaged
Instrument must not be
operated without separate
ground connection

High leakage current
ensure proper grounding

CAUTION

High leakage current ensure proper ground-
ing

Instrument can be damaged

Instrument must not be operated without sepa-
rate ground connection

Reorder no. 347800-0004-000
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Position and Figure of the Safety La-
bel

Description

14  At the CEE connector Risk of electrical shock

Residual voltage at the mains plug after unplug-
ging.

Wait at least 5 s after unplugging the mains plug
before touching the pins of the mains plug.

354700-7113-000

The microscope should be
approved by the
national regulations.
Do not remove any parts.

X-Rays produced
when energized

CAUTION
X-Rays produced when energized

The microscope should be approved by the na-
tional regulations.

Do not remove any parts.

Reorder no. 354700-7113-000

347800-0003-000

Skin burns under contact

Do not touch

This area may get hot

Hot Surface

CAUTION
Hot Surface

Skin burns under contact

Do not touch

This area may get hot

Reorder no. 347800-0003-000

347800-003-200

CAUTION

Hot surfaces inside during bakeout

procedure.
Do not place any combustible objects on

the grids of the electron optical column.
Only authorized service staff are allowed

to service the equipment.
Disconnect power and let surfaces cool

before opening.

Burn hazard

Burn hazard

Hot surfaces inside during bakeout procedure.

Do not place any combustible objects on the
grids of the electron optical column.

Only authorized service staff are allowed to ser-
vice the equipment.

Disconnect power and let surfaces cool before
opening.

Reorder no. 347800-003-200

Position and Figure of the Type Plate Description

11  At the rear of the microscope

16 A / SCCR 3.5 kA

Manufactured in year 2020

230 VAC ± 10%

208 VAC ± 10%

50 - 60 Hz

Made in Germany

356100-9057-100

Serial number

Carl Zeiss Microscopy GmbH
Carl-Zeiss-Straße 22

73447 Oberkochen, Germany

Sigma 300

1/N/PE

2/PE

The Type plate contains a unique serial number,
the Sigma model designation with the according
part number, the manufacturing year, and the
mains voltage for which the Sigma is configured.

Order no. 356100-9057-000 (Sigma 300)

Order no. 352100-9903-000 (Sigma 500)

2.5 Safety Devices and Interlocks

In order to prevent injuries and/or property damage, the Microscope System is equipped with sev-
eral safety devices and interlocks. Defects and other damaged safety devices may cause injuries
and property damage. In case of damage or defect, the affected parts of the Microscope System
must be taken out of operation immediately and be secured against unintentional use.

For verifying the safety of the Microscope System, please contact your ZEISS service representa-
tive. Please keep the service logs and logbooks.
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2.5.1 Protective Cover Panels

Due to hazardous voltages and X-rays inside the microscope, the microscope is equipped with
protective cover panels.

3

1

2

Fig. 1: Protective cover panels

1 Electron optical column protective cover
panels

2 Specimen chamber protective cover
panels

3 Plinth protective cover panels

Operation of the microscope is only allowed with attached protective cover panels.

2.5.2 Main Disconnect Device

To disconnect the microscope with all its components from the mains supply, unplug the CEE con-
nector (blue for 208–230 VAC).

Fig. 2: CEE connector

If the Emergency Off (EMO) Option is installed, the Main Switch of the EMO Option may be used
as Main Disconnect Device for the microscope and its components, refer to Emergency Off (EMO)
Option External [} 24].
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2.5.3 Circuit Breaker

The circuit breaker (F10) at the rear of the plinth will disconnect the mains power from the elec-
tronics in the plinth in case of an over-current (including the first pre-vacuum pump and PC). The
other circuit breaker (F11) disconnects mains power from the heaters and the second pre-vacuum
pump.

However, some other components will still be connected to mains power.

Fig. 3: Circuit breaker

The circuit breaker does not completely isolate the plinth from the mains power. This can only be
done using the Main Disconnect Device.

2.5.4 Emergency Off (EMO) Option External

The Emergency Off Circuit with the Main Switch is essential for compliance with the SEMI stan-
dard.

The Emergency Off Circuit is mounted at the wall near the mains power supply and connects the
mains power supply to the microscope and all its accessories.

Fig. 4: Emergency Off (EMO) Circuit

With the optional Emergency Off Circuit, the microscope is equipped with the following additional
safety equipment.
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2.5.4.1 Main Switch

If the Emergency Off Circuit is installed, the Main Switch of the EMO Circuit shall be used as Main
Disconnect Device for the microscope and its components.

In its OFF position the Main Switch cuts off both phases of the mains power from the microscope
and all devices directly connected to the EMO Circuit.

The Main Switch can be locked in the OFF position to keep it from being switched on, e.g. during
repair and maintenance work.

The Main Switch is located at the front of the EMO Circuit.

The Main Switch of the external EMO box guarantees an ampere interrupting capacity (AIC) of at
least 10,000 A rms.

Fig. 5: Main Switch

2.5.4.2 Start Button

The green Start button is located at the front of the EMO Circuit below the Main Switch.

The Start button must be pushed to switch the mains power to the outputs of the EMO Circuit if
the Main Switch is in the ON position and no EMO button is pressed.

Fig. 6: Start button
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2.5.4.3 Emergency Off (EMO) Button

The EMO button is located on the plinth adjacent to the specimen chamber.

The EMO button must be pressed in an emergency to cut off mains power from the microscope
and all devices connected to the AC Unit.

The EMO button must always be readily accessible and operable.

Fig. 7: EMO button

Info
Possible loss of data if any of the safety features are activated.

If the microscope is switched off using one of the safety devices, then the programs running
on the computer are not properly closed. Any unsaved changes to files are lost.

The Emergency Off function ensures that all power to the microscope is safely cut off.

The Emergency Off is not appropriate for shutting down the microscope in normal operation.

4 If the EMO button is pressed in the event of an emergency the button will remain in its de-
pressed position.

4 Once the emergency situation has been resolved, the EMO button is released by pulling it
out.

4 The microscope can then be restarted, refer to Energizing the Microscope [} 78].

2.5.5 Vacuum Locking Device

The vacuum locking device ensures that gun vacuum and system vacuum are better than the re-
quired thresholds.
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2.5.6 Interlock System of Optional Airlock

The interlock function ensures that the gate valve can only be operated if the chamber door and
the airlock door are properly closed.

Fig. 8: Airlock Error LED

Additional blocking functions ensure that the specimen can only be transferred if the following
conditions are fulfilled:

§ The airlock rod is retracted.

§ The specimen stage is in transfer position.

§ The EHT (Extra high tension) is off.

§ The column chamber valve is closed.

This is to prevent any risk of damaging the airlock rod or the gate valve.

2.5.7 Energy Isolating Devices

At the site of installation, the electrical power connection and the fluid connections must be
equipped with energy isolating devices.

As energy isolating devices, the following main shut-off valves are required:

§ Water supply

§ Water runback

§ Nitrogen supply

§ Compressed air supply

The energy isolating devices

§ must be easily accessible

§ must be mounted near the microscope in such a way that the person actuating or inspecting
an energy isolating device is not be exposed to serious risks

§ must close off the connections to the corresponding media when needed

§ must be lockable in their off position in order to prevent accidental re-activation
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3 Product and Functional Description

Info
Additional information and detailed descriptions are available in the further applicable docu-
ments, or ask your ZEISS Sales & Service Partner.

Info
This chapter describes only the overall product and its functionality. The microscope must not
be operated before this manual has been fully read and understood. Also refer to manuals of
accessories if applicable. Especially the chapters "Installation" and "Commissioning and First
Operating Steps" are important.

3.1 System Overview

Main Components
1

2

3

4

6

8

7

5

Fig. 9: Main components of the microscope

1 Electron optical Gemini column

Refer to Electron Optical Column | Gem-
ini 1 [} 32]

2 Specimen chamber with door handle

3 Plinth with ON/STANDBY/OFF buttons 4 Monitors

5 Control panel (optional) 6 Work desk

7 Dual joystick (optional) 8 Personal Computer (PC)
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Optional
Components and

Accessories

A range of options and accessories is available for the microscope. Examples of available options
and accessories are the following:

Detectors BSD detectors for high efficiency and angle selective material charac-
terization.

Refer to BSE Detectors [} 57], HDAsB Detector [} 64], and YAG BSD
Detector [} 65]

CL detector for the analysis of cathodoluminscent materials

Refer to CL Detector [} 67]

STEM detector for transmission imaging of ultrathin sections

Refer to STEM Detector [} 65]

VPSE detector

Refer to VPSE Detector [} 49]

C2D detector

Refer to C2D Detector [} 52]

Specimen Current Detector (SCD)

Refer to SCD Detector [} 67]

Stage accessories Coolstage

Faraday cup

Right-hand tilt (Sigma 300)

Further options Additional chamberscope, stubscope, and external navigation camera

Column maintenance kit, O-ring kit

Airlock for quick specimen transfer without breaking the system vac-
uum

Refer to Using the Optional Airlock [} 110]

Plasma cleaner for the decontamination of specimens and the speci-
men chamber

Refer to Using the Optional Plasma Cleaner [} 118]

Raman spectroscopic microscope for material characterization

Refer to Using the Optional Raman Spectroscopic Microscope [} 122]

Dual joystick for stage control and specimen navigation

Refer to Dual Joystick [} 68]

Control panel that allows direct access to the most frequently used
functions

Refer to Control Panel [} 69]

Software add-ins and enhancements

For full details about the available options and accessories, please contact your local ZEISS service
representative, or sales representative.
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3.2 Main Components

3.2.1 Vacuum System

Purpose For operation of the microscope, the gun head, the column, and the specimen chamber have to
be evacuated. The vacuum is essential to operate the gun and to prevent collisions of electrons
with gas molecules.

1

2

3

4

5

8

9

10

6

7

Fig. 10: Schematics of the vacuum system

1 Gun with filament 2 Gun head

3 Multihole aperture 4 Column chamber valve

5 Turbo pump 6 Ion getter pump (IGP)

Sigma 300 and Sigma 500 have one ion
getter pump, Sigma 300 VP and Sigma
500 VP have two ion getter pumps, as
shown here

7 Specimen chamber 8 Penning gauge

9 Vent valve 10 Pre-vacuum pump

System Vacuum The pre-vacuum pump 10  and the turbo pump 5  evacuate the specimen chamber 7 .
The vacuum in the specimen chamber is measured by a Penning gauge 8 . The detected vac-
uum values are displayed as System vacuum in the SmartSEM user interface. As long as the de-
tected pressure in the specimen chamber is not ready for operation, the column chamber valve

4  is closed in order to separate the specimen chamber from the column.

Gun Vacuum In the gun head, an ultra high vacuum is maintained by ion getter pumps 6 . The vacuum in
the gun head is displayed as Gun vacuum in the SmartSEM software. It should be below
1 × 10⁻⁸ mbar.

Venting The specimen is located in the evacuated specimen chamber. To open the specimen chamber for
specimen exchange, you have to break the vacuum in a controlled manner. This is done by the
Vent command via the SmartSEM user interface or by pressing the Exchange push button on the
optional control panel.
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When the Vent command is received, the column chamber valve closes and gaseous nitrogen
flows into the specimen chamber via the vent valve 9 . As soon as the pressure equilibrium is
obtained, the chamber door can be opened to change the specimen.

Evacuating In order to continue operation, the Pump command makes the pre-vacuum pump and the turbo
pump evacuate the specimen chamber.

As soon as the vacuum in the specimen chamber is ready for operation, the column chamber
valve opens and the EHT Vac ready message is displayed in the SmartSEM user interface. Gun
and EHT can be switched on.

Quiet Mode The automatically controlled Quiet Mode is optionally available. This option allows switching off
the pre-vacuum pump after specimen exchange when the vacuum threshold is achieved.

3.2.2 Vacuum System Pressure Modes

Purpose For operation of the microscope, the gun head, the column, and the specimen chamber have to
be evacuated. The vacuum is essential to operate the gun and to prevent collisions of electrons
with gas molecules.

With the variable pressure mode option, the microscope can be operated in different vacuum
modes:

§ High vacuum (HV) mode

§ Variable pressure (VP) mode

3.2.2.1 HV Mode

Purpose When changing to HV mode, the acceleration voltage decreases to zero and the column chamber
valve closes. The GFV closes and as soon as the chamber pressure drops below the minimum
chamber pressure (MCP = 15 Pa) the RBV closes and the TIV opens. Then the column chamber
valve opens and the acceleration voltage is turned on again.

The booster voltage is turned on in this mode.

3.2.2.2 Variable Pressure Mode

Purpose The variable pressure (VP) mode enables you to use the scanning electron microscope to image
specimens that are non-conducting, strongly gassing, or humid, without the need for vapor depo-
sition or other preparation procedures.

A differential pumping system makes it possible to set partial pressures above 10 Pa in the speci-
men chamber while maintaining a high vacuum or ultra-high vacuum in the gun area and in the
beam path.

When changing to VP mode, the acceleration voltage decreases to zero, the column chamber
valve closes, the turbo isolation valve (TIV) closes, the Roughing backing valve (RBV) and the gas
flow valve (GFV) open. As soon as the chamber pressure has reached the user value, acceleration
voltage switched on again and the column chamber valve opens.

The booster voltage is turned off in this mode.

Electron detection is provided via a VPSE detector.

Function The residual gas atmosphere in the specimen chamber creates an interaction region of electrons
and residual gas molecules between the objective lens and the specimen. In this region, high-en-
ergy electrons in the primary electron beam hit the residual gas molecules and ionize them. The
ions generated in these collisions contribute to the compensation of negative charge on the speci-
men.

However, another effect of these collisions is to scatter the electron beam. This is called the “skirt
effect”. The electrons that are lost from the primary beam as a result of this effect provide only a
resolution-limited background signal for imaging purposes. Although it is possible to tolerate
these leakage losses at chamber pressures up to a few hundred Pa, it is necessary to carefully se-
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lect and control the important factors such as acceleration voltage, chamber pressure, and beam
path. The signal-to-noise ratio in variable pressure mode can also be improved via the noise re-
duction features of SmartSEM. For details refer to the Software manual SmartSEM.

Fig. 11: Non-conducting specimen imaged with an acceleration voltage of 20 kV and a 30 μm aperture. Left: High
vacuum (HV) mode, showing strong charging effects. The electron beam is distorted and high-quality imaging is not
possible. Right: VP mode at 21 Pa. Charges are completely compensated, allowing easy imaging of the specimen.

3.2.3 Electron Optical Column | Gemini 1

Purpose The Gemini 1 column is the part of the microscope, where electrons are emitted, accelerated, de-
flected, focused, and scanned. Main characteristics of the Gemini optics are the beam booster
and an objective lens that consists of a combined electrostatic/electromagnetic lens doublet.

UEHT

UExt USup

UB

2

1

3

4

5

6

7

8

9
Fig. 12: Schematics of the electron optics

1 Gun

Generates the electron beam.

2 Extractor

Positive electrode that extracts elec-
trons from the filament.

3 Anode aperture 4 Multihole aperture (aperture changer)

5 Condenser

Collects and focuses the electron beam
onto the specimen.

6 InLens SE detector / InLens Duo detec-
tor
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7 Objective lens

Focuses the electron beam on to the
specimen surface.

8 Scanning coils

Deflect the beam across the specimen
surface in what is usually referred to as
a raster scan.

9 Specimen

USup Suppressor voltage UExt Extractor voltage

UEHT Acceleration voltage UB Liner tube voltage

Gun A Schottky field emitter serves as gun 1 . The filament is heated by applying the filament cur-
rent. Electrons are emitted from the heated filament while an electrical field, called extractor volt-
age (UExt), is applied. To suppress unwanted thermionic emission from the shank of the Schottky
field emitter, a suppressor voltage (USup) is applied as well.

EHT The emitted electrons are accelerated by the acceleration voltage (UEHT), for example 10 kV.

Beam Booster The beam booster is a feature of the electron optical column and has the following functions:

§ It minimizes beam widening that may occur due to stochastic electron-electron interactions.
Consequently there is almost no loss in beam brightness, even at low acceleration voltages.

§ It enhances protection against external stray fields.

Anode 3  and liner tube are connected mechanically and electrically and form the beam
booster. A booster voltage (UB, liner voltage) of +8 kV is applied to the beam booster in addition
to the acceleration voltage, so that a high beam energy is maintained throughout the entire col-
umn. The function of the beam booster depends on the acceleration voltage UEHT:

§ EHT ≤ 20 kV: liner tube/beam booster is connected to +8 kV

§ EHT > 20 kV: liner tube/beam booster is connected to ground, i.e. is switched off

Because of the danger of arcing, the beam booster function is not available in variable pressure
(VP) mode.

Apertures The electron beam passes through the anode aperture 3  first, afterwards through the multi-
hole aperture 5 .

The anode aperture defines the maximum possible probe current.

The multihole aperture is the final beam limiting aperture. It is decisive for the probe current. The
standard is the 30 μm aperture hole that is the central aperture. Other aperture sizes are se-
lectable to meet the requirements of a wide range of applications.

For the Gemini 1 column, two types of multihole aperture are available:

§ 20 nA high resolution configuration

Anode aperture di-
ameter

Multihole aperture
type

Probe current Typical application

40 μm 7 hole aperture

30, 7, 10, 15, 20,
60, 120 μm

3 pA to 20 nA High resolution

§ 100 nA high current configuration

Anode aperture di-
ameter

Multihole aperture
type

Probe current Typical application

90 μm 6 hole aperture

30, 10, 20, 60, 120,
300 μm

6 pA to 100 nA High current
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Condenser The condenser 4  is used for aperture matching of the objective lens in order to guarantee op-
timum resolution at each probe current and EHT setting.

Together with the multihole aperture, the condenser allows to regulate the probe current.

Stigmator The stigmator is located inside the condenser and compensates for astigmatism so that the elec-
tron beam becomes rotationally symmetrical.

Objective Lens and
Deflection System

The objective lens 7  focuses the electron beam onto the specimen 9 . The objective lens
consists of an electromagnetic lens and an electrostatic lens, which reduce spherical and chro-
matic aberrations, especially at low acceleration voltages. The electromagnetic lens is water
cooled.

The deflection system consists of a set of scan coils 8  that move the electron beam in a point-
to-point scan across the specimen. The scan coils deflect the beam in the X and Y directions rela-
tive to the electron-optical axis.

Before the electron beam exits the objective lens, the electrostatic lens creates an opposing field
which reduces the potential of the electrons by +8 kV. The energy of the electrons reaching the
specimen surface therefore corresponds to the set acceleration voltage (EHT).

Signal Detection When the primary electron beam hits the specimen, certain interaction products are released,
which can be recorded by specific detectors, e.g. the InLens SE detector 6 . For more informa-
tion refer to Principle of Signal Detection [} 34].

3.2.4 Gun Modes

The microscope can operate in different gun modes:

§ Imaging

§ Analytic

Imaging Gun Mode In Imaging gun mode, the temperature of the Schottky emitter and the extraction voltage are re-
duced in comparison to the Analytic gun mode. This leads to a reduction of the energy spread of
the primary electrons.

Imaging gun mode is suitable for lower probe currents. Imaging gun mode is especially useful at
low kV to reduce chromatic aberration and to achieve a better resolution.

Analytic Gun Mode Analytic gun mode is suitable for higher probe currents. Overall, the probe current in Analytic gun
mode is about twice the probe current in Normal gun mode.

3.2.5 Detectors

This chapter describes the generation of secondary and backscattered electrons, and describes
how the detector types, that are available for use with the microscope, use these electrons to pro-
vide imaging, topographical, and other information. It also lists some characteristics of each de-
tector type.

For more information about any of the detectors, contact your local ZEISS service representative.

3.2.5.1 Principle of Signal Detection

When a primary electron (PE) beam hits a specimen, certain electron beam interaction processes
occur. The interaction products most frequently used for the generation of images in scanning
electron microscopy are secondary electrons (SEs) and backscattered electrons (BSEs).

Specific types of detectors are able to detect the SEs and BSEs. The detector signals can be used
to create images and produce information about the properties of the specimen.
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1

2

3

Fig. 13: Interaction between primary electron beam and specimen

1 Objective lens 2 Interaction volume

3 Specimen
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Fig. 14: Interaction between primary electron beam and specimen

1 Primary electrons 2 Auger electrons

3 Secondary electrons 4 Backscattered electrons

5 Characteristic X-rays 6 Continuum X-rays

7 Fluorescent X-rays

Primary Electrons Primary Electrons (PEs) are electrons forming the scanning beam before hitting the specimen.

Secondary
Electrons

Secondary electrons are emitted from the topmost layer of the specimen.

§ SE1 Electrons
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Electrons emitted at the point of impact between the beam and the specimen are known as
SE1 type electrons. The amount of electrons emitted at the point of impact is related to the
shape of the specimen.

Secondary electron detectors, such as the InLens SE detector, collect SE1 type electrons from
the surface layer of the specimen and are thus ideal for displaying surface structures.

§ SE2 Electrons

The emergence of backscattered electrons from the specimen excites further emission of sec-
ondary electrons. These are known as SE2 type electrons.

Detectors that collect SE2 type electrons are especially suitable where the working distance is
large. Surface detail as the effect of “lateral illumination” emphasizes the topography of the
specimen.

Backscattered
Electrons

All electrons with energy higher than 50 eV are known as backscattered electrons (BSEs). BSEs are
generated by elastic scattering in a much deeper range of the interaction volume (up to 1 µm) and
carry depth information. The backscatter coefficient increases with increasing atomic number of
the elements within the specimen. This allows the BSE detector to generate atomic number con-
trast, or compositional contrast images.

Fig. 15: Backscattered electron coefficient against atomic number

BSE detectors are used to display the materials contrast because the backscatter coefficient is de-
pendent on the mean atomic number of the material under investigation.

Transmitted
Electrons

This comprises primary electrons that are transmitted through an ultrathin specimen and weakly
scattered primary electrons with a small range of angles. Depending on the material, primary elec-
trons are scattered under different angles and can be detected by a STEM detector placed below
the specimen. Unscattered electrons are detected in the center of the STEM detector and give a
bright field image. Electrons scattered under higher angles are detected by outer areas of the
STEM detector and produce dark field images.

Cathodoluminesce
nce

Electrons impacting on luminescent materials cause the emission of photons (Cathodolumines-
cence, CL) which may have wavelengths in the visible spectrum and can be imaged by specialized
detectors.

3.2.5.2 Detectors Overview

The beam scans the specimen and initiates particles to be emitted. A detector collects the emis-
sion and produces an electric signal with an amplitude proportional to the number of particles at
any given time.

Standard Detectors Detected Signals Typical Application

InLens SE Detector [} 38]

annular SE detector

SE1 Surface structure

SE Detector [} 44] SE2 Topography
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Standard Detectors Detected Signals Typical Application

Everhart-Thornley type Surface structure

Compositional contrast

Optional Detectors Detected Signals Typical Application

VPSE Detector [} 49]

optional, on VP systems only

SE2 Variable pressure

Topography and surface
structure in VP mode

C2D Detector [} 52]

optional, on VP systems only

SE Variable pressure

Topography and surface
structure in VP mode

InLens Duo Detector [} 56]

optional, only Sigma 500

SE1

BSE

Surface structure

Material contrast

Compositional contrast

BSE Detectors [} 57]

including HDBSD, aBSD1-LH
Detector [} 63], and HDAsB
Detector [} 64]

BSE Topographical (crystal orien-
tation)

Compositional contrast

YAG BSD Detector [} 65] BSE Compositional contrast

Electron backscatter diffrac-
tion (EBSD) detector

BSE camera Metallurgy, geology, and
electronics

Kikuchi patterns, crystallo-
graphic orientation and tex-
ture, grain size

STEM Detector [} 65]

Scanning Transmission Elec-
tron Microscopy detector

Transmitted electrons Transmission imaging of ul-
trathin sections in biological
and mineralogical examina-
tions

CL Detector [} 67]

Cathodoluminscence detec-
tor

Light photons Mineralogy

SCD Detector [} 67]

Specimen current detector
(SCD)

Absorbed electrons Electron beam induced cur-
rent (EBIC)

Wavelength dispersive X-ray
detector (WDX)

X-ray Materials elemental composi-
tion evaluation

Energy dispersive X-ray de-
tector (EDX)

X-ray Materials elemental composi-
tion evaluation

For more details, refer to the document Product Specification of the microscope.
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3.2.5.3 InLens SE Detector

Purpose The InLens SE detector is a high-efficiency detector for high resolution SE imaging and detects
secondary electrons directly in the beam path. The very high detection efficiency of this detector
results from its geometric position in the beam path and from the combination with the electro-
static/electromagnetic lens.

Position The annular shaped in-column detector is located above the objective lens.
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Fig. 16: InLens SE detector

1 Primary electron (PE) beam 2 Filtering grid

3 Beam booster 4 Magnetic lens

5 SE detector 6 Secondary electron paths

7 Specimen 8 InLens SE detector

9 Scan coils 10 Electrostatic lens

11 BSD 12 Interaction volume

Function The primary electrons 1  are accelerated by the acceleration voltage at the anode and, up to
an acceleration voltage of 20 kV, by an additional beam booster 3  voltage of 8 kV at the liner
tube. To ensure that the electrons reach the specimen surface 7  with the energy set as accel-
eration voltage, an opposing electrostatic field of the same magnitude as the beam booster volt-
age (8 kV) is generated at the end of the objective lens by the electrostatic lens 10 .

This electrostatic field acts as acceleration field for the SEs generated on the specimen surface.
The secondary electrons are absorbed, re-accelerated, and focused through the electromagnetic
field to the InLens SE detector 8 .

At the InLens SE detector, the electrons hit a scintillator. This generates a flash of light that is led
out of the beam path and onto a photomultiplier by means of a lightguide. The photomultiplier
converts the light information into an electronic signal, which can be displayed on the monitor.

The interaction between the primary electron beam and the specimen generates a large number
of SEs.
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The efficiency of the InLens SE detector is mainly determined by the electric field of the electro-
static lens, which decreases exponentially with the distance.

Thus, the working distance (WD) is one of the most important factors affecting the signal-to-noise
ratio of the InLens SE detector.

As the tilt angle of the specimen surface affects the emission angle of the electrons, you should
avoid strong specimen tilting.

Info
The InLens SE detector can be used up to an acceleration voltage of 20 kV. At higher accelera-
tion voltages, the beam booster and thus the field of the electrostatic lens are switched off.
Without the field of the electrostatic lens, which attracts the secondary electrons, the effi-
ciency of the InLens SE detector is reduced.

3.2.5.3.1 Detector Efficiency and Working Distance

Working Distance The efficiency of the InLens SE detector mainly depends on the electric field of the electrostatic
lens, which decreases exponentially with the distance. Thus, the working distance (WD) is one of
the most important factors tat affects the signal-to-noise ratio and therefore the efficiency of the
InLens SE detector.

For different imaging applications, the working distance needs to be selected depending on the
geometry of the specimen and depending on the acceleration voltage.

§ At acceleration voltages in the range of 1 kV to 5 kV, the working distance should be as low
as possible.

§ At very low interaction energies in the range of 100 V to 1 kV, the working distance should
not be greater than 4 mm. Often it is reasonable to set the working distance to 2 mm. This al-
lows the SE1 electrons to be efficiently attracted by the 8 kV voltage from the beam booster
towards the InLens SE detector.

Tilted Specimen The signal from the InLens SE detector can also be affected by the direction of the specimen sur-
face. Large angles of specimen tilt affect the emission angle of the secondary electrons, and fewer
electrons are emitted in the direction of the final lens. This reduces the detection efficiency.

Large angles of specimen tilt also prevent the use of very short working distances.

It is therefore recommended to avoid large angles of tilt when using the InLens SE detector.

Fig. 17: Changed SE distribution when using a tilted specimen
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Effect BSE Detector The BSE detector is located directly below the objective lens. The BSE detector may therefore in-
fluence the electrostatic field of the objective lens and affect the efficiency of the InLens SE detec-
tor.

The presence of a BSE detector may also prevent imaging at very short working distances, which
reduces the efficiency of the InLens SE detector (this applies only to the retractable BSE detectors).

When using only the InLens SE detector for imaging, it is recommended to move the BSE detector
to its parking position in order to reduce the working distance and to increase the efficiency of
the InLens SE detector.

Fig. 18: Effect on electrostatic field by the BSE detector

3.2.5.3.2 Benefits of the InLens SE Detector

The main benefit of the InLens SE detector is its high detection efficiency, particularly at very low
acceleration voltages, and the almost pure detection of secondary electrons.

Surface Detail The InLens SE detector is an ideal tool to map the surface of a specimen: Even at high acceleration
voltages, the images include more surface information than would be possible with the SE detec-
tor. This is because of the pure SE detection capability of the InLens SE detector.

Fig. 19: Comparison of surface information at high acceleration voltages. InLens SE detector (left): Clear edge effect
with good imaging of the surface structures. SE detector (right): Little surface information. Acceleration voltages: 10
kV.
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Fig. 20: Comparison of surface information with contamination. InLens SE detector (left): Imaging of thin layers on
the specimen surface. SE detector (right): Layers are not detected. Acceleration voltages: 10 kV.

Influence
Acceleration

Voltage

The InLens SE detector is frequently used at lower acceleration voltages.

At low acceleration voltages, the primary electrons carry less energy and have a smaller interac-
tion volume and a lower depth of penetration. The secondary electrons are generated in the up-
per layers of the specimen and enable good imaging of surface structures and contaminations.

At higher acceleration voltages, the penetration depth of the primary electrons increases. More in-
formation stems from the bulk of the material.

These effects of acceleration voltage are visualized in the following images:

Fig. 21: Comparison of surface information at different acceleration voltages. 0.2 kV acceleration voltage (top left):
Homogenous illumination, mapping of actual surface. 1 kV acceleration voltage (top right): Increasing edge effect. 5
kV acceleration voltage (bottom left): Increasing edge effect, reversed contrast of some structures. 10 kV acceleration
voltage (bottom right): Transparent surface due to increased penetration depth
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The effects of the acceleration voltage also are dependent on the atomic number of the material:

Fig. 22: Comparison of surface information at 1 kV and 5 kV – low atomic number. 1 kV acceleration voltage (left):
Good surface imaging. 5 kV acceleration voltage (right): Transparent surface due to increased penetration depth

Fig. 23: Comparison of surface information at 1 kV and 15 kV – high atomic number, 1 kV acceleration voltage (left):
Good surface-sensitive imaging. 15 kV acceleration voltage (right): Transparent surface due to increased penetration
depth

Charging Effects Another reason to use low acceleration voltages is to minimize and compensate the local charg-
ing on the surface of the specimen. If electrons hit a non-conducting or a partially-conducting
specimen, they accumulate on the surfaces and cannot discharge. Generated local charges affect
the electron beam and can significantly reduce the image quality. It is possible to reduce or com-
pensate for this effect by reducing the primary energy of the electrons and reducing the probe
current (aperture size).

Fig. 24: Compensation for charging using lower acceleration voltage. 7 kV acceleration voltage (left): Poor image
quality due to charging effects. 1 kV acceleration voltage (right): No charging effects.
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Topographic
Contrast

Because the InLens SE detector views the specimen from directly above, images obtained by this
detector seem to be “flat” and contain only little information about the topography. However,
surface-specific information is detected sufficiently well. In comparison to the InLens SE detector,
the SE detector emphasizes topography. The electrons penetrate deeper into the specimen and a
large number of backscattered electrons contribute to the image information. Generally, more sig-
nal can be obtained from surfaces that are tilted towards the detector.

Fig. 25: Comparison of topographic contrast of a fracture surface. InLens SE detector (left): Significant edge effect,
low topographic contrast. SE detector (right): Good topographic imaging. Acceleration voltages: 15 kV

Fig. 26: Comparison of topographic contrast of an integrated circuit: InLens SE detector (left): Good imaging of sur-
face structures, low topographic contrast. SE detector (right): Good topographic imaging. Acceleration voltages: 15
kV

The InLens SE detector is not always the appropriate detector for image navigation at low magni-
fications:

§ It requires the use of a small working distance, which limits the smallest possible magnifica-
tion.

§ A small spot can appear in the center of the image field at very low magnifications.

Whether or not such a spot appears strongly depends on the geometry of the specimen, on
the working distance, and on the selected acceleration voltage.

The SE detector is most suitable for generating images with a large field-of-view for navigating on
the specimen surface and for using long working distances.

Parameter Recommended conditions

Acceleration voltage

0.02 kV to 20 kV Suitable up to 20 kV, at more than 20 kV the beam booster is
switched off
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Parameter Recommended conditions

0.02 kV to 3 kV Low-voltage applications for the compensation of charges and for
surface-sensitive imaging

3 kV to 10 kV The average voltage range is suitable for many different applications

10 kV to 20 kV Voltage range frequently used for analytical purposes

Working distance

Up to 10 mm Due to the dependence on the electrostatic field of the objective lens,
the working distance should be as small as possible

2 mm to 3 mm For low-voltage applications (100 V to 3 kV)

3 mm to 6 mm Useful for the average voltage range (3 kV to 10 kV)

Aperture

30 μm The standard aperture is recommended for many applications

7.0 μm to 20 μm Limitation of the probe current for the compensation of charges, or
for the analysis of beam-sensitive specimens

60 μm and 120 μm Only recommended for analytical purposes

Specimen tilt Avoid large angles of tilt, if possible

Operation mode Only suitable in high vacuum, because the beam booster is switched
off in the VP mode

Tab. 3: Summary of InLens SE detector characteristics

3.2.5.4 SE Detector

Purpose The SE detector is an Everhart-Thornley type detector. It detects SEs as well as BSEs.

Position The SE detector is mounted on the wall of the specimen chamber, and is therefore classified as a
“chamber detector”. Due to its position in the chamber, the SE detector views the specimen later-
ally.
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Fig. 27: Schematics of the SE detector

1 Preamplifier 2 Photomultiplier

3 Light guide 4 Scintillator

5 Collector grid 6 Specimen
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Function Electrons moving to the detector are attracted/repelled by the collector grid and directed to the
scintillator. The electrons gain energy from the scintillator and thus are able to interact with a
phosphor layer, which generates photons (light). The light travels up a light pipe to a photomulti-
plier. The photomultiplier multiplies the flashes of light and outputs a signal that can be used for
imaging.

The collector voltage can be varied in the range between −250 V and +400 V.

A positive collector voltage generates an electrical field in front of the detector, thus directing the
low energy SEs towards the scintillator.

A negative collector voltage generates a field deflecting the low energy SEs so that they cannot
reach the scintillator and do not contribute to the signal. Only high-energy BSEs reach the scintil-
lator contributing to the image generation. This produces a pseudo-backscattered image, which
shows pronounced material contrast, but largely cancels surface properties and topography.

Fig. 28: Comparison of SE detector images using positive and negative collector bias voltage: SE detector using
+300 V collector bias: Good display of surface structures and topography (left), SE detector using –150 V collector
bias: Extremely strong topography, including shadow generation (right)

§ Positive collector bias voltage

When using a positive collector bias voltage, surfaces that are tilted in the direction of the de-
tector are emphasized, but there are no shadowing effects.

§ Negative collector bias voltage

When using a negative collector bias voltage, the image shows enhanced topographical con-
trast, which arises mainly from the extreme shadowing effects. However, the fine surface de-
tails are less visible.

Info
For all standard applications, the collector bias should be set to +300 V.

Surface images that show enhanced topographical information can also be generated using
BSE detectors, but they do not show the shadows that can be created using the SE detector.

Applications Unlike the InLens SE detector, which can be used only with acceleration voltages up to 20 kV, the
SE detector can be used in the complete high-voltage range.
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Fig. 29: Comparison of surface information at different acceleration voltages: Acceleration voltage = 1 kV: Good, sur-
face-sensitive imaging (left); Acceleration voltage = 10 kV: Thin layers are not seen (right)

Fig. 30: Comparison of surface information at different acceleration voltages: Acceleration voltage = 5 kV: Good, sur-
face-sensitive imaging (left); Acceleration voltage = 15 kV: Transparent surface caused by increased penetration
depth (right)

The working distance has a significant effect on the efficiency of the SE detector. Shadowing ef-
fects occur when the working distance is too short. If the specimen is too close to the objective
lens, most of the electrons will be deflected by the field of the electrostatic lens or move to the
objective lens itself. This means they cannot be detected by the SE detector.

Depending on the specimen material and on the specimen geometry, a minimum working dis-
tance of approximately 4 mm should be used. Extreme signal loss is likely to occur if shorter work-
ing distances than this are used. Conversely, the SE detector is very good when used for imaging
at long working distances. This is particularly important for low magnification imaging that is nec-
essary for adjusting the orientation of the specimen holder or locating a specific area on the speci-
men.

Optimal Initial
Settings

The following settings provide a good field of view for navigating on the specimen at low magni-
fications:

§ Initial working distance in the range of 10 mm to 20 mm.

§ Acceleration voltage of approximately 10 kV.

The imaging conditions can be readjusted for a desired application after identifying the area of in-
terest on the specimen.
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Fig. 31: Field of view at different working distances: The smallest possible magnification depends on the working dis-
tance: Field of view at 30 mm WD: Reasonably good signal-to-noise ratio, minimum magnification levels can be set
(left); Field of view at 5 mm WD: Limits exist on the lowest magnification setting possible (right)

Although images produced by the SE detector always include some backscattered electron com-
ponents, most of the signal is generated by the secondary electrons and the fraction of backscat-
tered signal is negligible. The images obtained by the SE detector are therefore primarily sec-
ondary electron images.

Fig. 32: Comparison of material contrast using SE/BSE detectors on a polished specimen: WD = 5 mm using SE detec-
tor: Material contrast is very poor (left); WD = 9 mm using BSE detector: Clear image showing good material contrast
(right)

In the previous figure the SE image taken at 5 mm working distance shows relatively poor mate-
rial contrast. In this example the reduced yield of secondary electrons is caused by the specimen
preparation technique of polishing the specimen surface. The ratio of SE to BSE electrons is there-
fore altered in favor of backscattered electrons.

Because the SE detector is mounted on the chamber at a certain angle to the specimen, the speci-
men is always viewed laterally. The SE detector, therefore, provides good surface information. All
other detectors (InLens SE and BSE) view the specimen from above, providing only limited infor-
mation about the topography of the specimen. Surfaces tilted towards the detector provide more
surface detail with brighter edges; specimens tilted away from the detector display shadowing ef-
fects and less surface detail.
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Fig. 33: Comparison of topographic contrast – SE/BSE detectors on a fracture surface: SE detector: Image with large
depth of field (left); BSE detector: Good material contrast but with limited topographical detail (right)

Some imaging applications require both, compositional and topographical details. The generation
of mixed SE and BSE images is recommended for such applications. The signal mixing option is
available in the Detectors tab in the SEM Controls panel.

Tilting the specimen increases the signal in the SE detector and sometimes improves the topo-
graphical information. Tilting the specimen towards the SE detector also results in a change of the
solid angle in which both the backscattered and secondary electrons are emitted from the speci-
men.

Parameter Description

Acceleration voltage

0.02 kV to 30 kV In principle suitable for the entire high-voltage range

1 kV to 5 kV Low-voltage applications for the compensation of charges and for
surface-sensitive imaging

5 kV to 20 kV The average voltage range is suitable for many different applications

20 kV to 30 kV Voltage range frequently used for analytical purposes

Working distance

≥ 4 mm If the working distance is too short, shadowing effects occur which
diminish the efficiency of the detector. Below 20 kV, the SEs are ab-
sorbed by the field of the electrostatic lens

4 mm to 6 mm For low-voltage applications (1 kV to 5 kV)

6 mm to 12 mm Useful for the average voltage range (5 kV to 20 kV)

12 mm to 30 mm Recommended only for low magnifications and to increase the depth
of field

Collector voltage

300 V Standard value of the collector voltage

0 V to 400 V Variation of the collector voltage at high magnifications to obtain the
mixed signal

−150 V to 0 V For pseudo-BSE images

48 Instruction Manual ZEISS SIGMA series | en-US | Rev. 7 | 352102-9344-006



ZEISS 3 Product and Functional Description | 3.2 Main Components

Parameter Description

Aperture

30 μm The standard aperture is recommended for many applications

7.0 μm to 20 μm Limitation of the probe current for the compensation of charges, or
for the analysis of beam-sensitive specimens

60 μm and 120 μm Only recommended for analytical purposes

Specimen tilt Tilting the specimen towards the detector increases collection effi-
ciency

Operation mode Only suitable in high vacuum

3.2.5.5 VPSE Detector

Purpose The Variable Pressure Secondary Electron (VPSE) detector is a specific type of SE detector for use
in Variable Pressure mode where a standard SE detector cannot be used. The VPSE detector is not
usable and will not operate in HV mode.

The Variable Pressure mode enables analyzing and imaging of non-conducting specimens without
charging artefacts. This is possible, because positively ionized gas molecules stabilize local charg-
ing. Variable Pressure mode can also be used for strongly gassing or moist specimens without any
need for specimen preparation.

Position The VPSE detector is attached to the MP-Port 1.

1
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5

Fig. 34: Schematics of the VPSE detector

1 Preamplifier 2 Photomultiplier

3 Objective lens 4 Light guide with collector electrode

5 Specimen

Function The collector electrode mounted on the light guide 4  is held on a positive potential forming a
collecting field for SEs. Thus, SEs move towards the detector. In VP mode gas molecules are
present in the specimen chamber. The accelerated SEs excite gas molecules, which emit a photon
when they de-excite to the ground state. Although BSEs also cause collisions, their contribution is
less than 1 % because of the lower ionizing cross section.

The emitted photons are detected by the rod-like light guide pointing at the specimen. The photo-
multiplier 2  amplifies the light signal and converts it into an electron current. The degree of
amplification is depending on the photomultiplier voltage, which regulates the contrast. The
preamplifier 1  amplifies the signal and regulates the brightness.

Chamber Pressure For an optimum use of the VPSE detector, the pressure in the specimen chamber must be high
enough. If the pressure is too low, then too few gas molecules are present and the collision prob-
ability is too low. This reduces the efficiency of the detector.

Instruction Manual ZEISS SIGMA series | en-US | Rev. 7 | 352102-9344-006 49



3 Product and Functional Description | 3.2 Main Components ZEISS

The optimum chamber pressure depends on the specimen and the operating parameters. It is usu-
ally in the range between 20 Pa and 60 Pa.

Info
If the chamber pressure rises, then the scattering of electrons is increased and the resolution of
the microscope is reduced.

Try to find the optimal chamber pressure for each individual application.

Dwell Time The dwell time is the amount of time that the electron beam stays at one position on the speci-
men before it moves to the next position.

If the dwell time is too short (i.e. the scan rate is too fast), then there is not enough time for an
“ion cascade” to develop and to create the imaging photons. This reduces the efficiency of the
detector.

If the dwell time is too long (i.e. the scan rate is too slow), then the electron beam delivers a large
amount of energy to each individual spot on the specimen. This may result in charging artifacts on
the images.

The optimal dwell time depends on the specimen and needs to be determined by experiment.

Info
To reduce charging effects, use the Frame Averaging function of SmartSEM. Use fast scan
speeds and increase the number of frames (N).

Collector Bias The collector bias corresponds to the voltage that is applied to the VPSE collector. The collector
bias accelerates the secondary electrons from the specimen surface towards the VPSE detector.

Typical VPSE collector bias values are between 50 % and 80 %.

If the collector bias is too low, the efficiency of the detector is reduced.

If the collector bias is too high, the VPSE detector may receive too much signal and may get satu-
rated. In this case, very bright lines are visible on the image in periodic intervals and proper imag-
ing is no longer possible. Whether a given value for the collector bias is too high, depends on the
specimen, the acceleration voltage, the probe current, and the pressure in the specimen chamber.

Fig. 35: Saturation of the VPSE detector. Bright lines become visible in the microscope image

To eliminate the bright lines in the images, either reduce the collector bias or reduce the chamber
pressure. However, the detector efficiency is reduced by either of these adjustments. You need to
find the optimum parameters for imaging different specimens. It is generally better to reduce the
collector bias, because reducing the chamber pressure can cause new charging effects.
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Fig. 36: Charge compensation by adjusting chamber pressure and collector bias. Left: Reducing the collector bias
from 82 % to 78 % results in the elimination of banding effects at 40 Pa. Right: Reducing the pressure in the speci-
men chamber from 40 Pa to 20 Pa results in the elimination of banding effects at a collector bias of 79 %.

Parameter Description

Acceleration voltage

3 kV to 30 kV Possible application range for VPSE G4 detector. However, sufficient
contrast can be obtained only at higher voltages.

3 kV to 7 kV Low voltage application with VPSE G4 detector.

7 kV to 25 kV Standard application for VPSE G4 detector.

Working distance

6 mm to 8 mm For low voltage applications (3 kV to 7 kV)

8 mm to 15 mm For standard applications (7 kV to 25 kV)

Aperture

30 μm The standard aperture is recommended for many applications.

7.0 μm to 20 μm With these apertures, the probe current is frequently too low to ob-
tain a sufficient signal-to-noise ratio and the required contrast.

60 μm Higher probe currents frequently improve the contrast.

120 μm Only recommended for analytical applications.

Specimen tilt Avoid large angles of tilt, if possible. Slight tilting can improve effi-
ciency.

Operation mode The VPSE G4 detector is used mainly in the VP mode.

As the VPSE G4 detector detects light, it can be used as a simple
cathodoluminescence (CL) detector in high-vacuum mode.
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3.2.5.6 C2D Detector

Purpose The cascade current detector (C2D) is a special type of detector that you can use instead of the SE
detector to create a secondary electron image under variable pressure conditions.

The SE detector cannot be used under variable pressure conditions: The high potential at the scin-
tillator would cause an electrical breakdown with a lightning flash that runs from the scintillator
to the outer body.

Fig. 37: C2D image of radiolaria

Function On the surface of the specimen, secondary electrons are created. The secondary electrons acceler-
ate towards the C2D detector due to the potential that is applied to the detector electrode.

On their way to the detector, the secondary electrons collide with residual gas molecules (nitro-
gen, air molecules, or water). The collisions ionize the residual gas molecules and create additional
electrons, as well as cations. The additional electrons also accelerate towards the detector and
collide with further gas molecules, which are ionized.

The result is a charge cascade that amplifies the original SE signal by a factor of up to 1000.

The electrons that result from the charge cascade are all collected by the electrode of the C2D de-
tector and the current is further amplified by the detector.

The cations that result from the charge cascade neutralize any negative charge on the specimen
that may have been created by the primary electron beam.

3.2.5.7 Chamber CCD Camera

Purpose The microscope contains a CCD camera (charge-coupled device camera) inside the specimen
chamber. It is referred to as the chamber CCD camera or chamberscope. It allows you to monitor
the position of the specimen stage and particularly the distance between the objective lens and
the specimen holder.

Position The chamber CCD camera is located at the backside of the specimen chamber.

1

2

Fig. 38: Sample image from chamber CCD camera.

1 Objective lens 2 Specimen holder
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NOTICE

Risk of collision
Use the chamber CCD camera to monitor the position of the specimen holder during stage
movements. Pay particular attention to the distance between the objective lens and the top of
the specimen. This applies to vertical movements, but also to horizontal movements, because a
thick specimen may collide with the objective lens from the side.

Depending on the selected detector, the chamber CCD camera is capable of acquiring black-and-
white images or colored images.

The performance of the diode detectors is negatively effected by the illumination that is required
for the camera. If a diode detector is selected, then by default the chamber CCD camera is dis-
abled:

Fig. 39: Chamber CCD camera disabled as indicated by a pause sign (e.g. if a diode detector is
selected).

3.2.6 Specimen Stage | Sigma 300

 WARNING

Suffocation hazard due to lack of oxygen
Gaseous dry nitrogen is used to vent the specimen chamber during specimen exchange. Inhal-
ing nitrogen may cause unconsciousness.

4 During specimen exchange, keep the chamber door open as short as possible.

4 Do not inhale the air from within the specimen chamber.

4 Ensure that the area around the microscope is sufficiently vented.

4 If you begin to experience symptoms of asphyxia (for example: rapid breathing, loss of
mental alertness and/or muscular coordination, depression of sensations, emotional insta-
bility, fatigue) leave the room immediately and inform the facility’s safety officer.

 CAUTION

Moving the specimen stage
Fingers can be trapped by the moving specimen stage.

4 Always close the chamber door before moving the specimen stage.

4 To remove parts fallen into or near to the stage use a tool (e.g. tweezers) instead of your
fingers.
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 CAUTION

Closing the chamber door
Fingers can be pinched when closing the chamber door.

4 Use the door handle to close the chamber door.

4 Ensure not to get your fingers caught in the chamber door gap.

Purpose The 5-axes motorized Cartesian specimen stage is used to navigate the specimen inside the speci-
men chamber.

Position The specimen stage is mounted on the chamber door. If the chamber door is closed, the speci-
men stage is inside of the specimen chamber.

2

11

2

Fig. 40: Specimen stage with dovetail fitting for precise fitting

1 Specimen holder 2 Specimen stage

Function The stage can be operated using the dual joystick or using the SmartSEM software.

Axis Description Movement

X X-axis Movement towards or away from the cham-
ber door (horizontal movement in the image)

Y Y-axis Movement to the left or right seen from the
chamber door (horizontal movement in the
image)

Z Height Vertical movement (movement towards or
away from the focal plane of the image)

R Rotation Stage rotation parallel to the X-Y plane

T Tilt Stage tilt about an axis parallel to the X axis

The focus on the stage is not maintained when the specimen is tilted. This can be compensated
for by using the Compucentric function in SmartSEM.
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3.2.7 Specimen Stage | Sigma 500

 WARNING

Suffocation hazard due to lack of oxygen
Gaseous dry nitrogen is used to vent the specimen chamber during specimen exchange. Inhal-
ing nitrogen may cause unconsciousness.

4 During specimen exchange, keep the chamber door open as short as possible.

4 Do not inhale the air from within the specimen chamber.

4 Ensure that the area around the microscope is sufficiently vented.

4 If you begin to experience symptoms of asphyxia (for example: rapid breathing, loss of
mental alertness and/or muscular coordination, depression of sensations, emotional insta-
bility, fatigue) leave the room immediately and inform the facility’s safety officer.

 CAUTION

Moving the specimen stage
Fingers can be trapped by the moving specimen stage.

4 Always close the chamber door before moving the specimen stage.

4 To remove parts fallen into or near to the stage use a tool (e.g. tweezers) instead of your
fingers.

 CAUTION

Closing the chamber door
Fingers can be pinched when closing the chamber door.

4 Use the door handle to close the chamber door.

4 Ensure not to get your fingers caught in the chamber door gap.

Purpose The 5-axes motorized eucentric specimen stage is used to navigate the specimen inside the speci-
men chamber

Function The specimen stage is mounted on the chamber door. If the chamber door is closed, the speci-
men stage is inside of the specimen chamber.

1

2

Fig. 41: Specimen stage with dovetail fitting for precise fitting

1 Specimen holder 2 Specimen stage

Function The stage can be operated using the dual joystick or using the SmartSEM software.
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Axis Description Movement

X X-axis Movement towards or away from the cham-
ber door (horizontal movement in the image)

Y Y-axis Movement

Z Height Vertical movement (movement towards or
away from the focal plane of the image)

R Rotation Stage rotation parallel to the X-Y plane

T Tilt Stage tilt about an axis parallel to the X axis

The stage is eucentric, which means that the tilt axis intersects the beam axis. The specimen sur-
face is located in the eucentric point, where the tilt axis meets the beam axis. This guarantees that
the focus and the point of interest are maintained when the specimen is tilted at a certain work-
ing distance.

3.3 Optional Components and Accessories

3.3.1 Optional Detectors

3.3.1.1 InLens Duo Detector

Purpose The InLens Duo detector 1  allows imaging and mixing of high contrast topography (SE) as well
as clear compositional contrast (BSE).

The InLens Duo Detector is only available for Sigma 500.

Position The annular shaped in-column detector is located above the objective lens and replaces the InLens
SE detector.

1

2

3

4

5

Fig. 42: Schematics of the InLens Duo detector

1 InLens Duo detector 2 Filtering grid

3 Beam path 4 Objective lens

5 Specimen

Function The SEs and BSEs generated at the impact point of the primary electron beam are intercepted by
the low electrical field of the Gemini column. These electrons are accelerated by the field of the
electrostatic lens.
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Filtering Grid Without switching on the filtering grid 2  voltage, the InLens Duo detector 1  has the same
characteristics as the InLens SE Detector [} 38]. The InLens Duo detector primarly detects sec-
ondary electrons (SEs).

By switching on the filtering grid voltage, the SEs will be rejected and only backscattered electrons
(BSEs) will be detected.

Below a landing energy of 1.5 kV the filtering grid has the additional function of selecting the de-
sired energy of the BSEs. The operator can select the threshold energy of inelastically scattered
BSEs to enhance contrast and resolution.

3.3.1.2 BSE Detectors

Purpose A signal source commonly used in electron microscopy are backscattered electrons (BSE). The use
of this type of signal makes it possible to effectively display compositional differences in the speci-
men. There are different types of detectors for backscattered electrons. Most of these detectors
use semiconductor diodes for signal detection. The following semiconductor detectors are avail-
able:

§ Backscattered electron detectors (BSD):
– aBSD1-LH
– 5-segment HDBSD

§ Angle-selective backscattered (AsB) detectors (lens mounted):
– HDAsB

Another type of detector is the YAG BSD. For more information on this detector, refer to YAG BSD
Detector [} 65].

Position Whereas the SE detector views the specimen from the side (refer to SE Detector [} 44]), BSE de-
tectors view the specimen from above. This position offers a very large solid angle that can be
used for the detection of backscattered electrons.

BSD Detectors BSD detectors are located in the specimen chamber and is usually moved into a “parked” position
when it is not being used. When needed, the detector is moved into its “active” position either
manually (HDBSD) or automatically (aBSD).

1

2

3

4

5

6

7

8

11

9

10

12

Fig. 43: Location of the HDBSD detector
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1 Primary electron (PE) beam 2 Filtering grid

3 Beam booster 4 Magnetic lens

5 SE detector 6 Backscattered electron paths

7 Specimen 8 InLens SE detector

9 Scan coils 10 Electrostatic lens

11 Retractable HDBSD detector 12 Interaction volume

HDAsB Detector The HDAsB detector is an integral part of the objective lens and cannot be moved.

1

1

2

Fig. 44: Location of the HDAsB detector

1 Primary electron beam 2 Fixed HDAsB detector

3 Specimen

NOTICE

Collision between specimen and detector
The diodes can be damaged easily by contact with hard objects.

4 When you move the detector below the objective lens, make sure the specimen stage can-
not hit the semiconductors.

4 If you need to change the working distance, use the TV camera mode to view the speci-
men and help avoid a collision between the specimen and the detector.

Info
Risk of malfunction: The diode segments are sensitive to the light that is used for illumination
in TV mode (infrared and white).

When you use a diode detector, always make sure that the TV illumination is switched off. If
the CCD Mode is set to Auto Detect, then the TV illumination is automatically switched off
when a diode detector is used.

Position Although BSE detectors can be used to image various types of specimen (crystal orientation con-
trast; magnetic contrast type II and so on), their main application is the display of material con-
trast (compositional differences). Their performance with respect to contrast is based on the
backscattering coefficient, which increases with increasing atomic number. A higher backscatter-
ing coefficient results in an increase in the number of backscattered electrons generated by the
primary electron beam, which are then made available for detection.

If different phases exist on the specimen, those with a higher average atomic number display
higher brightness than those with a small atomic number.
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Fig. 45: Display of material contrast with the BSE detector

3.3.1.2.1 BSE Detector Efficiency

The efficiency of BSE detectors (aBSD1-LH, HDBSD, HDAsB) is determined mainly by three factors:

§ Acceleration voltage

Since BSE detectors only use the energy of the generated backscattered electrons, the effi-
ciency of the detector therefore increases with increasing acceleration voltage.

§ Working distance

Since the BSE detectors are positioned directly below the objective lens, a hole exists in the
center of the detector through which the electron beam scans the specimen. The active layer
(top layer of the semiconductor diodes) is arranged around this hole. If the working distance
is too long, many electrons miss the detector, which also reduces the efficiency. If the se-
lected working distance is too short, only few backscattered electrons hit the detector and
most electrons pass through the hole without contributing to the signal. The optimum solid
angle for detection of the backscattered electrons exists only in a relatively small range of
working distances centered at approximately 9 mm.

Fig. 46: Factors that affect the BSE detector efficiency: Acceleration voltage (left), working distance (right)

§ Specimen tilt

Because of the viewing angle of the BSE detectors (directly from above), the specimen orien-
tation towards the detector has an effect on the detector efficiency. Whereas the SE detector
responds very well when the specimen is tilted towards it, tilting degrades the detector re-
sponse when using a BSE detector.

Tilting also distributes the generated backscattered electrons in different directions. Larger an-
gles of tilt mean that more electrons are scattered in the forward direction and fewer are
available to contribute to the signal of the BSE detector. Low angles of tilt should therefore be
used with the BSE detector.
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Fig. 47: The effects of working distance: WD too long (left), WD optimal (center), WD too short (right)

Parameter Description

Acceleration voltage

1 kV to 30 kV Use of very low and very high acceleration voltages is possible

Working distance

7 mm to 12 mm If the working distance is too short or too long, the solid angle avail-
able for detection deteriorates away from the optimum

Aperture

30 μm The standard aperture is recommended for many applications

7.0 μm to 20 μm With these apertures, the probe current is frequently too low to ob-
tain a sufficient signal-to-noise ratio and the required contrast

60 μm Higher probe currents frequently improve the contrast

120 μm Often only recommended for analytical applications

Specimen tilt Avoid large angles of tilt, if possible

Operation mode Use of the BSE detector is possible in high vacuum and VP mode

3.3.1.2.2 BSE Detector Segments

The HDBSD detector has five silicon diode segments:

Fig. 48: HDBSD detector with five segments

The HDAsB detector has four diode segments.

On the surface of the specimen, some of the primary electrons are backscattered. The backscat-
tered electrons then move towards the silicon segments of the detector, which are covered by a
thin layer of additional material. If the energy of the backscattered electrons is high enough, then
they can pass through the thin layer of material and create electron-hole pairs in the silicon seg-
ments.
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In each individual segment, the charge separation due to the electron-hole pairs is measured as a
current, which is used as a signal for image generation. Only electrons that have a high enough
energy can create electron-hole pairs and can contribute to image generation. Electrons that have
a lower energy (e.g. secondary electrons) are not detected.

The emission of backscattered electrons from a specimen is related to the atomic number of the
involved material: Elements with high atomic numbers generate more backscattered electrons (i.e.
the backscatter coefficient is higher). When imaging, regions that contain elements with higher
atomic numbers appear brighter. Regions that contain elements with lower atomic numbers ap-
pear darker.

These semiconductor detectors have a relatively small bandwidth and a high capacitance (rela-
tively long discharge time), and therefore a reduced scan rate is recommended when using them.
The SE detector can initially be used to adjust the electron-optical parameters (focus, stigmation),
then the signal source can be switched to the BSE detector to generate the image.

By selecting and combining different diode segments, it is possible to generate images with both
topographical and compositional information.

The following figure shows an example comparing the compositional contrast (COMPO) and to-
pographic contrast (TOPO) modes when using a BSD.

Fig. 49: COMPO mode image (left) and TOPO mode image (right) acquired with a BSD

The following figures show more examples of shadow mode images created using compositional
contrast and topographic contrast modes with a BSD.

Fig. 50: Compositional contrast image (left) and “Shadow mode” image (right) acquired using a BSD
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Fig. 51: Compositional contrast image (left) and “Shadow mode” image (right) acquired using a BSD

Fig. 52: Compositional contrast image (left) and “Shadow mode” image (right) acquired using a BSD
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3.3.1.2.3 aBSD1-LH Detector

Purpose The aBSD1-LH (large hole) detector is a pneumatically retractable, annular backscattered electron
detector (BSD). It is used for high efficiency material characterization even at low-kV applications.
It has five separate diode segments, one inner concentric ring and four outer quadrants. The inner
segment S1 provides mostly material contrast whereas the four outer quadrants S2 to S5 provide
more topographical contrast.

Fig. 53: aBSD1-LH detector with one inner concentric segment and four outer quadrants

NOTICE

Motorized specimen stage
Risk of damaging the detector when operating the motorized specimen stage.

4 Retract the detector head completely after you have finished the work with the detector.

Info
Risk of malfunction: The diode segments are sensitive to the light that is used for illumination
in TV mode (infrared and white).

When you use a diode detector, always make sure that the TV illumination is switched off. If
the CCD Mode is set to Auto Detect, then the TV illumination is automatically switched off
when a diode detector is used.

The BSD detector has applications mainly in materials analysis and in the life sciences.

Material analysis:

§ Metallurgical sections

§ Geological sections

§ Complex materials

§ Printed circuit boards

§ Semiconductors

§ Bond pads
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Life sciences:

§ Mineral deposits in plant structures

§ Biological sections

§ Bone structures

The detector has one video output channel. The detector has a relatively large central hole and
therefore has the advantage that it does not limit the field of view of the SEM and does not influ-
ence the electron optical properties of the objective lens. A disadvantage is that especially at low
kV a lot of backscattered electrons are lost in the central hole and cannot be detected.

Function On the surface of the specimen, some of the primary electrons are backscattered. The backscat-
tered electrons then move towards the silicon segments of the BSD detector. If the energy of the
backscattered electrons is high enough, then the electrons pass through the very thin dead layer
of the diode and create electron-hole pairs in the silicon segments.

In each individual segment, the charge separation due to the electron-hole pairs is measured as a
current, which is used as a signal for image generation. Only electrons that have a high enough
energy can create electron-hole pairs and can contribute to image generation. Electrons that have
a lower energy (e.g. secondary electrons) are not detected by the BSD detector.

The emission of backscattered electrons from a specimen is related to the atomic number of the
involved material: Elements with high atomic numbers generate more backscattered electrons (i.e.
the backscatter coefficient is higher). When imaging, regions that contain elements with higher
atomic numbers appear brighter. Regions that contain elements with lower atomic numbers ap-
pear darker.

Since the detector has a limited speed, it is recommended to use scan speed 6 or higher (slower),
especially at small magnifications. The lower the gain is, the faster is the detector.

3.3.1.2.4 HDAsB Detector

Purpose The HDAsB is an improved version of the angular-selective backscattered electron (AsB) detector.
It is integrated into the objective lens and therefore also referred to as cap-mounted BSD.

Function In comparison to the retractable BSD, the HDAsB detector allows operation at shorter working
distances. The HDAsB detector is equipped with four diode quadrants that can be controlled inde-
pendently using a dedicated menu. The HDAsB detector offers improved low kV capability be-
cause it has a thinner oxide layer than older versions of the AsB.

Info
The HDAsB detector enables BSE imaging at acceleration voltages above 1 kV.

The HDAsB detector has two operating modes:

§ Compositional mode:

produces images showing the atomic contrast of the specimen

§ Topography mode:

produces images showing the surface details of the specimen
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3.3.1.3 YAG BSD Detector

Purpose The YAG BSD detector is a scintillation type detector for backscattered electrons.

The YAG BSD detector has a high sensitivity and is specifically designed for high speed imaging.

It can be used in HV mode and in VP mode.

Function The YAG BSD detector uses yttrium aluminum garnet (YAG) as a fast scintillation material that is
mechanically and chemically resistant. Since it is a scintillation type detector, the YAG BSD detec-
tor does not have segments with changeable polarity and you can only use this detector for com-
position imaging. In comparison to segment based BSD detectors, the YAG BSD detector has a
faster response time.

Fig. 54: YAG BSD detector

Fig. 55: YAG BSD image of sandstone

3.3.1.4 STEM Detector

Purpose The optional STEM (Scanning Transmission Electron Microscopy) detector is an electron detector
that can be used to detect transmitted and scattered electrons underneath an ultrathin specimen.

The STEM unit is equipped with diodes that are switched on or off in order to allow dark field and
bright field imaging.
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Fig. 56: STEM detector

1 Incident electron beam (primary elec-
trons)

2 Thin specimen

3 Dark-field STEM detector;
detector-to-specimen distance (2 to
4 mm recommended)

4 Bright-field STEM detector

Info
Risk of malfunction: The diode segments are sensitive to the light that is used for illumination
in TV mode (infrared and white).

When you use a diode detector, always make sure that the TV illumination is switched off. If
the CCD Mode is set to Auto Detect, then the TV illumination is automatically switched off
when a diode detector is used.

Function The STEM detector is a pneumatically retractable multi-mode detector with a 12-stub specimen
holder for bright-field and dark-field detection. The STEM unit is equipped with semiconductor
diodes that are switched on or off in order to allow dark-field and bright-field imaging. The diode
area consists of four quadrants for the dark-field (DF) and one diode for the bright field (BF) imag-
ing.

The “cone angles” of the BF and DF signals depend on the specimen as well as the illumination
aperture. The center hole separates the DF and the BF signals, and the arrangement of the diodes
allows simultaneous detection of the bright-field and dark-field signals without the need for re-
alignment. Moving the detector in the Z-axis and changing the working distance makes it possible
to obtain optimum separation of the signal. A detector-to-specimen distance in the range of 2
mm to 4 mm is recommended for optimum imaging results.

The STEM detector is used in cases where the thickness of a specimen is similar to or less than the
dimensions of the interaction volume. The specimen must be mounted on a TEM grid with a thin
carbon-film support (approximately 10 nm thick). Electrons that pass through the target can then
be collected by the detector and used to form an image. The SmartSEM user interface allows to
select different imaging modes (DF or BF). It is also possible to mix the DF and BF signals.
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3.3.1.5 SCD Detector

Purpose The specimen current detector (SCD) detects the current absorbed in the specimen.

Function A highly sensitive amplifier is connected to the sample, measuring the sum of incoming PEs and
outgoing SEs and BSEs for each image pixel.

Fig. 57: Silicon chip

3.3.1.6 CL Detector

Purpose The Cathodoluminescence (CL) detector is an inclined detector that allows efficient visible or ultra-
violet light collection. The CL detector is ideal for use in geology, mineralogy, and materials sci-
ence applications where it can help in internal structural examination of rocks, ceramics, and
semiconductors.

1

2

3

4
5

Fig. 58: Schematics of the CL detector

1 Preamplifier 2 Photomultiplier

3 Objective lens 4 Light guide with collector electrode

5 Specimen

Function The prerequisite for using this detector is that the specimen emits light when interacting with the
primary electron beam. Differences in crystal structure or the presence of impurities in a cathodo-
luminescent material result in variations in the energy gap between the filled valence bands and
the empty conduction bands, and consequently a change in the CL emission.

The light (photons) emitted by the specimen is collected by the CL detector and converted into a
signal for imaging.

The CL detector is fully integrated into the automatic brightness and contrast control of the micro-
scope and can be used simultaneously with any of the detectors without degrading their perfor-
mance.

The detector can be used during energy-dispersive X-ray spectrometer (EDS) measurements and
wavelength-dispersive spectrometer (WDS) measurements at any valid magnification.
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Fig. 59: CL image of sandstone

3.3.2 Dual Joystick

Purpose The dual joystick is used for stage control and specimen navigation.

Position The dual joystick is placed on the microscope desk.

2 31

Fig. 60: Dual joystick

1 Break push button

Stops the stage in an emergency.

2 T/Z joystick

Controls the Z axis and the stage tilt (T).

3 X/Y/R joystick

Controls the X- and Y-axes and the
stage rotation by turning.

Function All axes are deflection-compensated. When the joystick is moved only slightly, the respective axis
moves slowly. Larger movements of the joystick result in a faster movement of the stage.

The X-, Y-, and Z-axes are magnification-compensated. When working at a low magnification, the
stage moves relatively fast. At higher magnifications the stage movement is slower. The stage is
moving with its maximum speed when viewing the specimen with the CCD (Charge Coupled De-
vice) camera.

The different axes can also be moved simultaneously.
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3.3.3 Control Panel

Purpose The control panel allows direct access to 14 of the most frequently used functions. It integrates a
full sized keyboard, 11 turning knobs, and 8 push buttons.

Info
he control panel facilitates daily routine tasks. All the functions can be applied by using the
mouse and by macro execution also.

Position The control panel is placed on the work desk.

1 2 3

6 7 8

4 5

11109
Fig. 61: Control panel

1 Stigmator X | Stigmator Y

Shapes the beam roundness by changing the stigmation deflectors.

2 Aperture X | Aperture Y

Adjusts the mid column shift and tilt deflectors for aligning the beam along the column
axis.

3 Scan Rotate

Rotates the scanning pattern 360° continuously.

This turning knob has a push button function to deactivate the scan rotate function and
reset the scan rotation to 0°.

4 Shift X | Shift Y

Shifts the scanned region of the specimen in the X and Y directions.

5 Brightness | Contrast

§ Brightness

Adjusts the image acquisition chain offset for the currently selected detector. Each
configured detector stores its own brightness.

§ Contrast

Adjusts the gain of the currently selected detector.
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6 Magnification | Reduced

§ Magnification

Adjusts the magnification of the system.

§ Reduced

Changes the scan field to a reduced area. The size of the area is determined by the
current sub scan area settings.

7 Wobble

Sweeps the acceleration voltage. If the aperture is slightly misaligned, a shift in X and/or
Y direction can be observed.

8 Freeze

Stops the scan and grabs one complete frame at the current imaging conditions.

9 Exchange | Resume

§ Exchange

Starts the pre-defined macro for specimen exchange with the airlock.

§ Resume

Starts the pre-defined macro to finish specimen exchange with the airlock.

10 Camera

Switches to chamber view.

11 Focus | Scan Speed +/−

§ Focus

Changes the focal point of the column by adjusting the magnitude of the objective
lens.

§ Scan Speed +/−

Increases (+) or decreases (−) the scan speed by doubling or halving the beam dwell
time with each click step.
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3.4 Software Description

3.4.1 SmartSEM User Interface

The SmartSEM software graphical user interface (GUI) allows you to monitor and operate most of
the active components of the microscope.

The following screenshot indicates the main elements of the SmartSEM user interface:

1 32

69 71112 810

54

Fig. 62: Screen layout of the user interface

1 Title Bar

Displays the name of the user interface and the logged-on user.

2 Menu Bar

Enables you to access to SmartSEM features via sub-menus.

3 AVI Toolbar

Contains the controls to set up, record, and playback video sequences of scanned images.

4 Toolbar

Provides quick access to SmartSEM tools.

5 Image Area with Data Zone

Displays image information and acquisition parameters from the microscope.

6 Thumbnails Panel

Displays thumbnail views of the contents of the eight image buffers.
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7 Status Bar

Displays the current machine state and contains the SEM Control Buttons.

8 Data Zone

Displays image information and acquisition parameters from the microscope.

9 Annotation Bar

Enables you to add information to the SEM image and provides several measurement
functions.

10 Panel Configuration Bar

Enables you to choose the panels to be placed in the Docking Panel.

11 Docking Panel

Enables you to arrange frequently used SmartSEM panels for convenient access.

12 Mini Bar

Provides quick access to recently used dialogs and to the recipe management.

3.4.2 Graphical Control Elements

The following graphical control elements are used in the SmartSEM GUI.

Screenshot Control
Element

Function

Tab Provides a group of graphical control elements.

Section Forms a group of control elements with related
functions.

Button Enables you to start an action.

Check-
box

Enables you to activate or deactivate a function.

Drop-
down list

Enables you to select the desired element.

Radio
button

Enables you to activate the desired option.

Scroll bar Enables you to adjust a value by moving the scroll
bar or pressing the arrow button until the desired
value is set.

Readout Displays the status of a system entity.

Enables you to select an action or a value by
opening a dialog with an input field.
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Screenshot Control
Element

Function

Input
field

Enables you to enter the desired value.

Progress
bar

Displays the progress of an action.

Slider Enables you to adjust the corresponding function.

Naviga-
tion box

Provides visual indication of the range and current
value of one- and two-dimensional parameters
such as Beam Shift or Stigmation.

3.4.3 User Access Levels and User Privileges

The user access level defines which parameters are displayed for selection purposes, e.g. in the
status window or annotation parameter selection.

SmartSEM distinguishes different user access levels. Depending on the user access level, different
parameters are accessible. User profiles are defined by the administrator.

Access: Menu Bar > Tools > Administrator

User Access Level Description

Novice Only the items assigned to the novice category are accessible. These
include most frequently used parameters.

Expert Items assigned to the novice and expert category are accessible.
These include parameters useful for advanced operators.

Service All items are accessible, also including infrequently used items and cal-
ibrations.

Additional to the user access levels there are user privileges which are part of the user profile:

User Privilege Description

Calibration Enables the user to perform instrument calibration operations.

Change Image Di-
rectory

Enables the user to change the location where all images are saved.

Change Toolbar Enables the user to change the toolbar.

Change User Direc-
tory

Enables the user to change the location where all user specific param-
eters and configurations are saved.

Extractor Enables the user to change the extractor voltage.
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User Privilege Description

Gun Align Enables the user to modify the alignment of the electron beam.

Gun Off Enables the user to switch off the field emission filament.

Stage Initialise Enables the user to initialize the motorized stage.

Supervisor Enables the user to perform the following actions:

§ Start the Administrator, create and edit users

§ Set User Max EHT

§ Modify the filament current

§ Set up, edit, and delete global stage coordinates

§ Save common macros and toolbars

§ Save common recipes

§ Activate Partial Vent on Standby, Z Move on vent, Protect Z,
Go to HV@Shutdown, EHT Off & Log Off, and Leave Gun
ON at Shutdown.

§ Use the bakeout function

Vent Enables the user to vent the specimen chamber.

3.4.4 SmartSEM Program Suite

The SmartSEM Program Suite comprises the EM server, which implements the internal communi-
cation between control software and microscope hardware, plus several programs and utilities.

The main purpose of the SmartSEM Program Suite is to access all necessary microscopy parame-
ters and software features to capture SEM data and optimize image acquisition.

Access: Windows start menu > SmartSEM

Program Description

ChamberScope Enables you to display the chamberscope image and the detector im-
age at the same time.

Option, requires particular hardware.

OptiProbe Calibra-
tion

Calibration of OptiProbe after cathode replacement or realigning of
the electron optical column

ReadMe Contains important information on the currently installed version.

Release Notes Contains an overview of all SmartSEM versions including new devel-
opments and specific details.

RemCon32 Serial interface for remote operation via RS232, e.g. for EDX

License: REMCON

SampleHolder-
Gallery

Enables you to inspect the dimensions of all possible specimen holders
as well as to set the dimensions of the custom specimen holders.

Enables you to activate the available specimen holders for SmartSEM.

SEM Drift Correc-
tion

Enables you to compensate for the drift of the specimen by using a
reference image and by controlling the beam shift.

License: DRIFT-CORR
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Program Description

Slideshow speed
setting

Enables you to adjust the slideshow speed for the Windows Photo
Viewer.

SmartSEM Admin-
istrator

Enables you to manage user profiles and configure instruments.

SmartSEM User
Accounting

Enables you to record important information during individual work-
ing sessions, e.g. logon/logoff time, number of TIFF files exported etc.

SmartSEM User In-
terface

Main software application

Access: Windows start menu > SmartSEM Service

Program Description

Calibration Wizard Service activities, for ZEISS service representatives only

Gun Monitor Enables you to monitor important parameters of the microscope.

GUN Service Service activities, for ZEISS service representatives only

Multi GIS Service Service activities, for ZEISS service representatives only

Service Centre Provides an overview of the state of the microscope.

Smart Stage Map-
ping

Service activities, for ZEISS service representatives only

SmartBackup Tool Enables you to back up configuration and calibration data

Stage Administra-
tor

Service activities, for ZEISS service representatives only

Upgrade Server
Database

Service activities, for ZEISS service representatives only
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4 Installation
Installation and commissioning are carried out by authorized ZEISS service representative. The in-
stallation requirements are to be observed and adhered to. After installation or retrofitting, thor-
oughly check that the Microscope System is in a safe operational state, making sure in particular
that all protective covers (e.g. protection against laser radiation) have been installed.
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5 Commissioning and First Operating Steps
This chapter describes the commissioning and the first operating steps of the Microscope System.
Further information on operation is available in the Online Help of your software.

 WARNING

Tilting hazard when removing the microscope from the crate
When removing the microscope from the wooden crate, it can tilt and crush a person.

4 Use a forklift to remove the microscope from the wooden crate.

 WARNING

Crushing hazard when lowering the microscope
The microscope and its components are heavy. When the load is lowered during transport and
positioning, body parts can be crushed.

4 Maintain a safe distance.

4 Do not walk or place your hands or feet under the load while it is being lowered.

4 Wear safety shoes and gloves.

Before the microscope is being unpacked the following safety warning have to be read and fully
understood. These safety warnings have to be obeyed at any time by every person in the same
room as the microscope.

 WARNING

Radiation hazard due to X-rays
X-rays are generated inside the microscope during operation. This is unavoidable because elec-
trons are accelerated by voltages up to 30 kV.

4 Do not remove any parts around the column and chamber that are essential for radiation
protection.

4 Use genuine ZEISS parts exclusively.

4 Ensure that all local safety and X-ray protection regulations are met.

4 Only authorized ZEISS service representatives are allowed to service the microscope.

 WARNING

Malfunction of medical devices near ion getter pumps
Magnetic fields present at the ion getter pumps may disturb the function of medical devices.
The magnetic fields are also present if the microscope is switched off.

If you wear medical implants that are susceptible to magnetic fields (e.g. cardiac pacemakers),
do the following:

4 Keep a distance of at least 30 cm from the ion getter pumps.

4 Follow the safety instructions provided by the pump manufacturer.
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NOTICE

Damage during transport
Sensitive components of the microscope can get damaged during transport.

4 The microscope may only be transported in air-suspended vehicles.

4 Moving parts must be secured during transport to prevent them from slipping or tipping
over.

4 Install shock/tilt watches.

4 Avoid rocking the crates back and forth.

4 Devices for transporting the microscope must be rated to handle its full weight and dimen-
sions. Note the weight information on the package and on the shipping document.

4 Check that none of the items has been damaged during shipment.

4 Otherwise contact your local ZEISS service representative.

5.1 Prerequisites for Commissioning and Operation

Read the instruction manual carefully before commissioning and keep the manual for further use.

§ Basic training and safety briefing successfully completed.

§ Chapter Safety read and understood.

§ Familiar with general Windows® based programs.

5.2 Switching On the Microscope System

5.2.1 Energizing the Microscope

Before energizing the microscope make sure that the following safety warnings have been read
and fully understood by each person who is in the same room as the microscope at any time:

 WARNING

Suffocation hazard due to lack of oxygen
Gaseous dry nitrogen is used to vent the specimen chamber during specimen exchange. Inhal-
ing nitrogen may cause unconsciousness.

4 During specimen exchange, keep the chamber door open as short as possible.

4 Do not inhale the air from within the specimen chamber.

4 Ensure that the area around the microscope is sufficiently vented.

4 If you begin to experience symptoms of asphyxia (for example: rapid breathing, loss of
mental alertness and/or muscular coordination, depression of sensations, emotional insta-
bility, fatigue) leave the room immediately and inform the facility’s safety officer.

 WARNING

Reaction products
Dangerous reaction products can be present in the specimen chamber during or after opera-
tion.

4 Ensure that there is an appropriate exhaust gas line to remove the waste gas of the pre-
vacuum pump and to transmit it to the outside.

4 Wear lint-free gloves when touching the inner parts of the specimen chamber or the speci-
men.
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Before energizing the microscope make sure that the following safety warnings have been read
and fully understood by the person operating the microscope:

 WARNING

Residual voltage at the mains plug
After unplugging the mains plug residual voltage is present at the pins of the plug which may
cause electrical shock.

4 After unplugging the mains plug wait at least 5 s before touching the pins of the mains
plug.

 WARNING

High leakage current
High leakage currents are present in the microscope. Contact may cause burn or electrical
shock.

4 Ensure proper grounding. For more information, refer to the Installation Requirements
document.

4 Do not operate the microscope without the separate ground connection.

 WARNING

Hazardous voltages inside the microscope
Contact may cause electrical shock or burn.

Hazardous voltages are present inside the microscope as long as the power cord is plugged in
or as long as the Main Switch of the EMO Circuit is in the ON position.

To completely cut off the microscope from any mains power:

4 with installed EMO Circuit set the Main Switch to the OFF position.

4 without EMO Circuit unplug the power cord by unplugging the CEE connector from the
CEE FEMALE RECEPTACLE of the mains supply.

 WARNING

Restart after emergency off
If the reason for the emergency off is not eliminated, it may be dangerous to restart the micro-
scope.

4 If the microscope has been de-energized due to an emergency, ensure that the reason for
the emergency off does not exist anymore.

4 Make sure it is safe to energize the microscope.

Prerequisite ü If the Emergency OFF (EMO) circuit is not installed:
The microscope was de-energized by unplugging the CEE connector from the mains supply.

ü If the EMO circuit is installed:
The microscope was de-energized either by turning the Main Switch to the OFF position or
by pressing the EMO button.

Procedure 1. Verify that the main shut-off valves for nitrogen at the facility installation are operable.
à Otherwise unlock and open the main shut-off valves.
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2. Make sure the circuit breakers (F10, F11) are in
the upper position.

3. If the EMO circuit is not installed, plug the CEE
connector into the CEE FEMALE RECEPTACLE of
the mains supply.

4. If the EMO circuit is installed, pull the EMO
button to release it.

5. Turn the Main switch counter-clockwise to the
Reset position and then back via OFF to the
ON position.

6. Press the green Start button.

5.2.2 Starting the Microscope

Info
If the system was powered off for a longer time period, the ion getter pump might fail to start.
In this case, bake-out the gun head (supervisor user rights required) or contact your local ser-
vice center. Refer to Baking out the Gun Head [} 138].
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To start the microscope, you need to use the buttons at the front of the plinth and follow a de-
fined procedure.

Prerequisite ü The microscope is energized.
The procedure depends on the mode in which the microscope is before the start-up:
OFF: Only used if a reset was necessary
STANDBY: If not in use, the microscope should be in this mode

Procedure 1. If the microscope is in the OFF mode, press the yellow STANDBY button at the front of
the plinth.
à The microscope goes into STANDBY mode.

The yellow STANDBY button lights up.

2. Press the green ON button.
à The ON button blinks green while the system is activated.
à When all subsystems are fully activated, the

ON button lights up green permanently.

5.3 Starting the Software

Procedure 1. Power up the computer and log in.
2. Start the SmartSEM user interface via the ZEISS SmartSEM icon on the desktop.

Alternatively, select Windows start menu > SmartSEM > SmartSEM User Interface.
à The EM Server opens while loading various drivers. The EM Server implements the inter-

nal communication between software and hardware of the microscope.
à The EM Server Log On dialog is displayed.

3. Enter the user name and password.
4. Click OK.

à The SmartSEM user interface opens and is ready to operate the microscope.

5.3.1 Calling up the Help

There are different ways to access topics in the Online Help.

Function Menu Shortcut Control Elements

Startup page Help F1 –

Table of Contents Help > Contents Ctrl+F1 –

Context-sensitive – § Shift+F1

§ F1 on focus

Question mark icon
in the main window
and in modal dialogs
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Detailed information about using the help system is given in the Online Help directly.

5.3.2 Keyboard Shortcuts

The following keys are shortcut keys and have special meaning.

Shortcut Function

<F2> Toggles Tool Bar on/off

<F2 + SHIFT> Hysteresis removal

<F3> Closes all windows except the Tool Bar and Status Bar

<F3 + SHIFT> Toggles PC Plane ON/OFF

<F4> Step to next Magnification Table entry, or Undo Centre Feature Mag-
nification

<F4 + CTRL> Step to previous Magnification table entry

<F4 + SHIFT> Exit from Magnification Table mode

<F5>, <F5 +
SHIFT>
<F6>, <F6 +
SHIFT> 
<F7>, <F7 +
SHIFT>
<F8>, <F8 +
SHIFT>

User defined macros

<F9> Keys help (displays this information)

<F11>, <F11 +
SHIFT>

User defined macros

<F12>, <F12 +
SHIFT>

Aborts Stage Movement

<TAB> Toggle coarse/fine

<CTRL + TAB> Performs Centre Point

<CTRL + SHIFT +
TAB>

Performs Centre Feature

<HOME> Resets Beam Shift to zero

<SCROLL LOCK> Toggles Freeze/Unfreeze

<PAUSE> Causes currently executing macro to continue

<*> Performs Find Image function

<CTRL + 2> Loads Second Image Window from display

<CTRL + A> Switches Annotation panel ON

<CTRL + B> Display Toolbar View dialog

<CTRL + D> Toggle Data Zone ON/OFF

<CTRL + E> Calls the Export TIFF dialog
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Shortcut Function

<CTRL + F> Starts Auto Focus fine

<CTRL + SHIFT +
F>

Starts Auto Focus coarse

<CTRL + G> Switches SEM Controls Panel ON

<CTRL + I> Switches SEM Status Panel ON

<CTRL + M> Switches to Annotation and inserts Point to Point Marker

<CTRL + ALT + M> Enable/Disable the Movable Crosshairs Marker

<CTRL + ALT + F> Enable/Disable Mouse Following for Movable Crosshairs Marker

<CTRL + O> Calls the Import TIFF dialog

<CTRL + P> Performs the Print Image function

<CTRL + S> Calls the Export TIFF dialog to save the image

<CTRL + ALT + S> Performs Auto Astigmatism Correction

<CTRL + SHIFT +
S>

Performs Auto Astigmatism Correction with Auto Focus

<CTRL + T> Calls Text Annotation

<CTRL + V> Displays the Vacuum status information

Keypad <+> Faster Scan

Keypad <-> Slower Scan

ARROW Keys Refer to Use of ARROW Keys

Image Buffer keys Refer to Image Buffer

<SHIFT> and dou-
ble click

Performs Centre Point function

5.4 Acquiring an Image

Info
Mobile phones in the microscope room can cause image quality infringements and in worst
case workflow interruptions.

This section describes basic procedures to obtain an image using the SE detector. To simplify the
procedure, the description uses the SEM Controls panel and status bar functions in the SmartSEM
software.

The procedure consists of the following steps:

§ Preparing the Specimen Holder [} 84]

§ Loading the Specimen Chamber [} 85]

§ Locating the Specimen [} 89]

§ Switching on the Gun [} 90]

§ Switching on the EHT [} 90]

§ Acquiring an Image [} 91]
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§ Optimizing the Image [} 93]

§ Saving the Image [} 96]

5.4.1 Preparing the Specimen Holder

Parts and Tools Designation Part no.

Hex key, 1.5 mm Delivered with the microscope

Stub Delivered with the microscope

Tweezers for specimen Delivered with the microscope

Specimen holder Delivered with the microscope

If necessary: carbon tape, conductive carbon,
adhesive metal tape, or similar

–

Appropriate specimen (with conducting prop-
erties, e.g. gold on carbon)

–

Lint-free gloves –

 WARNING

Biological hazards
Biological substances may pose a threat to the health of humans and other living organisms.

4 Keep a logbook of the biological substances loaded into the microscope and show it to
the ZEISS service representatives before they perform any work on the microscope.

 WARNING

Aggressive or toxic chemicals
Aggressive or toxic chemicals can cause chemical burns.

4 When handling aggressive or toxic chemicals, wear suitable protective clothing, gloves,
and eye/face protection.

4 Do not eat, drink, or smoke while handling toxic chemicals.

4 Refer to local safety regulations.

4 Read and follow the instructions in the material safety data sheet of the chemical. The ma-
terial safety data sheet can be obtained from the supplier of the chemicals.

NOTICE

Environmental risk due to disposal of aggressive or toxic chemicals
When disposing of aggressive or toxic chemicals, there is a threat of damage to the environ-
ment.

4 When disposing of waste that has been generated during a service operation (e.g. used ro-
tary pump oil), comply with all national and local safety and environmental protection reg-
ulations.
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NOTICE

Contamination caused by fingerprints
Contamination caused by fingerprints can lead to vacuum deterioration or prolonged pumping
times.

4 Always wear lint-free gloves when touching the specimen, specimen holder, or stage.

Procedure 1. To attach a specimen to the stub, use conduc-
tive carbon, adhesive metal tape, carbon tape,
or similar.
Ensure that the specimen area that you want to
analyze is in proper contact with the stub.

2. To insert the stub into the specimen holder, use
tweezers.

3. To fix the stub to the specimen holder, tighten
the location screw with the hex key.

4. Note down which fix position is occupied by the specimen.

5.4.2 Loading the Specimen Chamber

Info
If your microscope is equipped with the optional airlock, use the airlock for loading the speci-
men chamber. For more information refer to the respective instruction manual.

The procedure consists of the following steps:

§ Displaying the SEM Control Panel [} 86]

§ Driving the Stage to a Low Position [} 86]

§ Venting the Specimen Chamber [} 87]

§ Mounting the Specimen Holder [} 87]

§ Evacuating the Specimen Chamber [} 89]
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5.4.2.1 Displaying the SEM Control Panel

Prerequisite ü The SmartSEM user interface is started.

Procedure 1. From the Menu Bar, select Tools > Goto panel.
à The Panel Configuration Bar is displayed. It contains an alphabetical list of functions.

2. Double-right-click SEM Controls.
à The SEM Controls panel is added to the docking panel.

5.4.2.2 Driving the Stage to a Low Position

 CAUTION

Moving the specimen stage
Fingers can be trapped by the moving specimen stage.

4 Always close the chamber door before moving the specimen stage.

4 To remove parts fallen into or near to the stage use a tool (e.g. tweezers) instead of your
fingers.

Procedure 1. In the toolbar, click the TV icon.

à The inside of the specimen chamber is visible
in the Image Area.

2. In the SEM Controls panel, select the Stage tab.
3. Activate the Track Z checkbox.

à The current working distance (WD) is displayed in the Data Zone.
4. If the Data Zone is disabled, enable it via Menu Bar > View > Data Zone > Show Data

Zone.
5. Use the dual joystick to drive the specimen stage downwards to a low position. 

 NOTICE  Observe the stage movement via camera to avoid crashing.
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5.4.2.3 Venting the Specimen Chamber

 WARNING

Suffocation hazard due to lack of oxygen
Gaseous dry nitrogen is used to vent the specimen chamber during specimen exchange. Inhal-
ing nitrogen may cause unconsciousness.

4 During specimen exchange, keep the chamber door open as short as possible.

4 Do not inhale the air from within the specimen chamber.

4 Ensure that the area around the microscope is sufficiently vented.

4 If you begin to experience symptoms of asphyxia (for example: rapid breathing, loss of
mental alertness and/or muscular coordination, depression of sensations, emotional insta-
bility, fatigue) leave the room immediately and inform the facility’s safety officer.

Procedure 1. In the SEM Controls panel, select the Vacuum tab.
2. Click Vent.

à The Vent message box is displayed.
3. To start venting, click Yes.

INFO: If the Stage is not initialized system message is displayed, refer to Initializing the
Stage [} 134].
à The specimen chamber is purged with gaseous nitrogen.

5.4.2.4 Mounting the Specimen Holder

 WARNING

Suffocation hazard due to lack of oxygen
Gaseous dry nitrogen is used to vent the specimen chamber during specimen exchange. Inhal-
ing nitrogen may cause unconsciousness.

4 During specimen exchange, keep the chamber door open as short as possible.

4 Do not inhale the air from within the specimen chamber.

4 Ensure that the area around the microscope is sufficiently vented.

4 If you begin to experience symptoms of asphyxia (for example: rapid breathing, loss of
mental alertness and/or muscular coordination, depression of sensations, emotional insta-
bility, fatigue) leave the room immediately and inform the facility’s safety officer.

 CAUTION

Moving the specimen stage
Fingers can be trapped by the moving specimen stage.

4 Always close the chamber door before moving the specimen stage.

4 To remove parts fallen into or near to the stage use a tool (e.g. tweezers) instead of your
fingers.

 CAUTION

Closing the chamber door
Fingers can be pinched when closing the chamber door.

4 Use the door handle to close the chamber door.

4 Ensure not to get your fingers caught in the chamber door gap.
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NOTICE

Driving the stage
While the stage is driven manually, there is a risk of damaging the objective lens and/or the
specimen.

4 Ensure not to hit the objective lens while driving the stage.

4 Monitor the moving stage in TV mode.

4 To stop the moving stage immediately, press F12 or press the Break push button of the
dual joystick panel.

4 Manually lower the stage before you open the chamber door. Alternatively, activate the Z
move on Vent checkbox in the Stage tab of the SEM Controls panel.

NOTICE

Contamination caused by fingerprints
Contamination caused by fingerprints can lead to vacuum deterioration or prolonged pumping
times.

4 Always wear lint-free gloves when touching the specimen, specimen holder, or stage.

Procedure 1. Carefully open the chamber door.

2. If a specimen holder is mounted onto the specimen stage, remove it by sliding it out of the
dovetail rails.

3. Mount the prepared specimen holder by sliding
it into the dovetail rails.
Make sure that the dovetail is placed in the cor-
rect orientation so that the flat side of the
dovetail of the specimen holder is flush with
the milled edge of the specimen stage.

4. Check the chamber view to ensure the specimen does not hit any components when it is
introduced into the specimen chamber.

5. Carefully close the chamber door.
à The specimen holder and the specimen inside the chamber are visible in the Image

Area.
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5.4.2.5 Evacuating the Specimen Chamber

Procedure 1. In the SEM Controls panel, select the Vacuum tab.
2. Click Pump.

à Several vacuum status messages display the current vacuum levels.

5.4.3 Locating the Specimen

The procedure consists of the following steps:

§ Positioning the Stub under the Electron Beam [} 89]

§ Moving the Specimen to the Proper Height [} 89]

5.4.3.1 Positioning the Stub under the Electron Beam

NOTICE

Driving the stage
While the stage is driven manually, there is a risk of damaging the objective lens and/or the
specimen.

4 Ensure not to hit the objective lens while driving the stage.

4 Monitor the moving stage in TV mode.

4 To stop the moving stage immediately, press F12 or press the Break push button of the
dual joystick panel.

4 Manually lower the stage before you open the chamber door. Alternatively, activate the Z
move on Vent checkbox in the Stage tab of the SEM Controls panel.

Procedure 1. In the Stage Navigation Bar, select Stage Sideview from the upper drop-down list and
Stage Topview from the lower drop-down list.
INFO: To open the Stage Navigation Bar, navigate to View > Toolbars and activate
Stage Navigation Bar (for Widescreen users). Alternatively, you can access the Stage
Navigation Bar via Stage > Navigation.

2. Click Settings.
à The Stage Navigation Settings dialog is displayed.

3. In the Stage Navigation Settings dialog, click Show Holder Gallery.
à The Sample Holder Gallery dialog is displayed.

4. In the Sample Holder Gallery dialog, click the specimen holder you are using.
5. Activate the Is Available checkbox.
6. Close the Sample Holder Gallery dialog.
7. Close the Stage Navigation Settings dialog.
8. In the Stage Topview section of the Stage Navigation Bar, spot the stub with the speci-

men you want to observe.
9. To drive the stub directly under the electron beam, double-click the stub.

5.4.3.2 Moving the Specimen to the Proper Height

Procedure 1. In the Stage Navigation Bar, drag the Zoom View slider to the right end, so that the
schematics are zoomed in.

2. In the SEM Controls panel, select the Detectors tab.
3. In the Detectors section, select USB TV1 from the Signal A drop-down list.

à The inside of the specimen chamber is visible in the Image Area.
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4. Use the dual joystick to carefully move up the stage so that the stub you are using is in the
center of the upper schematic.
 NOTICE  Observe the camera image in order not to crash into the pole piece.

5.4.4 Switching on the Gun

NOTICE

Schottky field emitter
If the Schottky field emitter is switched on and off too frequently or inappropriately, its lifetime
is reduced.

4 Avoid switching off the gun during the working week.

4 Use Standby mode for the weekend or a break of up to a week.

4 When using the Standby mode, activate the Partial Vent on Standby function.

Prerequisite ü The chamber and the gun head have been evacuated.

Procedure 1. In the right part of the Status Bar, verify whether the gun is switched on or off.

à If  or  is displayed, the gun is already switched on and you can skip the fol-
lowing steps.

à If  is displayed, the gun is switched off. Follow the operating steps within this
chapter.

2. In the SEM Controls panel, select the Vacuum tab.
3. Verify that the EHT Vac ready readout is EHT Vac ready = Yes.

If not, the correct vacuum is not achieved. Check if the Pump procedure has been com-
pleted.

4. In the right part of the Status Bar, click .
à The pop-up menu for vacuum, gun, and EHT activation is displayed.

5. Click Gun On and monitor the gun vacuum.
à The gun runs up.
à This may take up to 5 minutes.

5.4.5 Switching on the EHT

When you switch on the EHT, the gun starts emitting electrons.

 WARNING

Radiation hazard due to X-rays
X-rays are generated inside the microscope during operation. This is unavoidable because elec-
trons are accelerated by voltages up to 30 kV.

4 Do not remove any parts around the column and chamber that are essential for radiation
protection.

4 Use genuine ZEISS parts exclusively.

4 Ensure that all local safety and X-ray protection regulations are met.

4 Only authorized ZEISS service representatives are allowed to service the microscope.

Prerequisite ü The chamber and the gun head have been evacuated.

ü The gun has been switched on.
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Procedure 1. In the SEM Controls panel, select the Vacuum tab.
2. Check that Vac Status = Ready is displayed.
3. In the SEM Controls panel, select the Gun tab.
4. Double-click the EHT Target readout.

à The EHT Target window is displayed.
5. In the input field, enter the required acceleration voltage in kV (e.g. 10) and click OK.

6. In the right part of the Status Bar, click .
à The pop-up menu for vacuum, gun, and EHT activation is displayed.

7. Click EHT On.
à The EHT runs up to the set voltage.
à In the right part of the Status Bar, the vacuum, gun, and EHT status buttons merge to

.

5.4.6 Acquiring an Image

Info
The following procedure describes the best way to quickly obtain an image without the con-
trol panel. You can also use the control panel to adjust aperture alignment, magnification/fo-
cus and brightness/contrast.

The procedure consists of the following steps:

§ Selecting the SE Detector [} 91]

§ Setting a Fast Scan Speed [} 92]

§ Setting a Low Magnification [} 92]

§ Adjusting Brightness and Contrast [} 92]

§ Visualizing Details on the Specimen Surface [} 92]

5.4.6.1 Selecting the SE Detector

Procedure 1. In the SEM Controls panel, select the Detectors tab.
2. In the Detectors section, select Signal A = SE2

from the Signal A drop-down list. 
INFO: We recommend using the SE detector to
obtain the first image. This detector provides a
good signal-to-noise ratio even at long working
distances.
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5.4.6.2 Setting a Fast Scan Speed

Procedure 1. In the SEM Controls panel, select the Scanning tab.
2. From the Scan Speed drop-down list, select a

fast scan speed, e.g. Scan Speed = 3.
INFO: The lower the scan speed number, the
faster the electron beam scans across the speci-
men. Scan Speed = 3 allows you to get an im-
age quickly.

5.4.6.3 Setting a Low Magnification

Procedure 1. In the Toolbar, select the MAGFOC icon.

à In the Status Bar, the current magnification
and working distance are displayed.

2. Hold down the left mouse button and drag the mouse within the Image Area to adjust the
magnification to 500 x.

3. Hold down the mouse wheel and drag the mouse within the Image Area to adjust the
working distance and focus the image.

5.4.6.4 Setting a Long Working Distance

Procedure 1. In the Status Bar, click .
à The WD window is displayed.

2. In the WD input field, enter 10.
3. Click OK.

à The working distance is set to WD = 10 mm.

5.4.6.5 Adjusting Brightness and Contrast

Procedure 1. In the SEM Controls panel, select the Detectors tab.
2. In the Signal Adjust section, use the scroll

bars to adjust brightness and contrast.

5.4.6.6 Visualizing Details on the Specimen Surface

Procedure 1. Select a detail on the specimen surface.
2. Verify the Magnification/Focus function is activated.
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3. To adjust the magnification, hold down the left mouse button and drag the mouse within
the Image Area in left/right direction.
à The current magnification is indicated in the Status Bar.

4. To adjust the focus, change the working distance. Hold down the mouse wheel and drag
the mouse within the Image Area in left/right direction.
à The current working distance is indicated in the Status Bar.

5. Adjust contrast and brightness again.

5.4.7 Optimizing the Image

Once you have generated an initial image, you can adjust various parameters to optimize the im-
age.

Info
The following procedure describes the best way to quickly optimize the image without the
control panel. You can also use the control panel to adjust aperture alignment, magnification/
focus and brightness/contrast.

The procedure consists of the following steps:

§ Adjusting the Magnification [} 93]

§ Moving the Field of View at High Magnifications [} 93]

§ Limiting the Scan Field [} 94]

§ Aligning the Aperture [} 94]

§ Selecting the Scan Speed [} 95]

§ Correcting Astigmatism [} 95]

5.4.7.1 Adjusting the Magnification

Procedure 1. To switch to the Coarse mode, in the Status Bar, click .

à The  button changes to .
2. Step by step, raise the magnification to 50,000 x and focus in between.

To adjust the magnification and the focus, hold down the left mouse button or the mouse
wheel, respectively, and drag the mouse within the Image Area.

5.4.7.2 Moving the Field of View at High Magnifications

If you want to move the field of view at high magnifications, use the Beam Shift function instead
of moving the stage.

Procedure 1. In the SEM Controls panel, select the Apertures tab.
2. Click Beam Shift.
3. To shift the beam, in the Beam Shift navigation

box, use the scroll bars or the red marker.
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5.4.7.3 Limiting the Scan Field

Prerequisite ü Adjusting the size and position of the small frame (reduced raster) requires the license RE-
DUCED.

Procedure 1. In the Toolbar, click the REDUCE icon.

à A small scan frame is displayed. This frame defines the specimen area to be scanned by
the electron beam.

à The image outside the scan frame is frozen.

2. To change the position of the scan frame, click on the green border line and use the mouse
to drag and drop the frame.

3. To change the size of the scan frame, click on the small blue squares on the green border
line and drag them to the desired size.

4. Focus the image in the reduced raster.

5.4.7.4 Aligning the Aperture

Info
Alternatively to aligning the aperture manually, use the Auto Wobble function via toolbar icon.

Procedure 1. In the SEM Controls panel, select the Apertures tab.
2. Activate the Focus Wobble checkbox.

INFO: Focus wobble is a function that sweeps the acceleration voltage. If the aperture is
misaligned, a lateral and vertical shift can be observed.

3. To adjust the wobble intensity, use the Wobble Amplitude scroll bar.
4. To accelerate the wobble speed, activate the Wobble Fast checkbox.
5. Click Aperture Align.
6. In the Aperture Align navigation box, use the scroll bars or the red marker to adjust the

aperture alignment until there is no movement of the detail in X- and Y-direction.
INFO: The specimen detail should just be pulsating without shifting.
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7. Deactivate the Focus Wobble checkbox.

8. Refocus the image.

5.4.7.5 Selecting the Scan Speed

Procedure 1. In the Toolbar, from the Faster/Slower drop-down list, select Scan Speed = 7.

Alternatively, in the SEM Controls panel, select the Scanning tab, and from the Scan Speed
drop-down list, select Scan Speed = 7.
à The scan speed is set to Scan Speed = 7.

2. Bring the image into focus.
3. Toggle between Coarse and Fine mode in the Status Bar, as appropriate.

5.4.7.6 Correcting Astigmatism

Procedure 1. Ensure that the Reduced Raster function is active.
2. Select a detail (e.g. a mark or an edge) on the specimen surface.

Ensure that the selected detail is in the raster. You can move the stage or shift the beam for
this purpose.

3. In the SEM Controls panel, select the Apertures tab.
4. Click Stigmation.
5. In the Stigmation navigation box, use the

scroll bars or the red marker to obtain the
sharpest possible image.
INFO: The specimen detail should just be pul-
sating without shifting.
INFO: To obtain optimum results, alternately
correct focus and astigmatism.

6. To deactivate the reduced raster, in the Toolbar, click the REDUCE icon.
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5.4.8 Saving the Image

Procedure 1. In the SEM Controls panel, select the Scanning tab.
2. Select Freeze on = End Frame from the drop-

down list.

3. Click Freeze.
à A red dot at the right bottom of the Image Area indicates that the image is frozen.

4. From the Menu Bar, select File > Save Image.
à The Export TIFF dialog is displayed.

5. To change the save path, click Change Directory.
à A file explorer window is displayed.

6. To confirm the selected path, click Select Folder.
7. Enter the filename in the Filename input field.
8. Click Save <file name>.tif.
9. To continue imaging, click Unfreeze in the Scanning tab.

5.5 Modifying Gun Parameters

5.5.1 Selecting the Gun Mode

The microscope can operate in different gun modes:

§ Imaging

§ Analytic

Imaging Gun Mode In Imaging gun mode, the temperature of the Schottky emitter and the extraction voltage are re-
duced in comparison to the Analytic gun mode. This leads to a reduction of the energy spread of
the primary electrons.

Imaging gun mode is suitable for lower probe currents. Imaging gun mode is especially useful at
low kV to reduce chromatic aberration and to achieve a better resolution.
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Analytic Gun Mode Analytic gun mode is suitable for higher probe currents. Overall, the probe current in Analytic gun
mode is about twice the probe current in Normal gun mode.

Info
After switching the gun mode, you can immediately work with the selected gun mode. For ap-
plications, which require a high probe current stability, wait 24 hours until a stability of 0.2 %/
h is reached. It is recommended not to change the gun mode during quantitative specimen
analysis.

Procedure 1. In the SEM Controls panel, select the Gun tab.
2. To switch to Imaging mode, click Imaging.
3. To return to Analytic mode, click Analytic.

5.5.2 Measuring the Probe Current

The probe current is the current that flows through the specimen. It corresponds to the total
number of electrons that hit the specimen.

Measuring the probe current using the Faraday cup ensures that the current displayed in the soft-
ware equals the incident probe current. The Faraday cup consists of a strongly absorbing material
with a cavity covered by a small aperture. If the beam is focused in this cavity, no secondary elec-
trons and no backscattered electrons leave the Faraday cup.

Parts and Tools Designation Part no.

Faraday cup 348342-8055-000

Procedure 1. Load the Faraday cup into the specimen chamber. Refer to Loading the Specimen Chamber
[} 85].

2. Evacuate the specimen chamber.
3. Switch on the gun. Refer to Switching on the Gun [} 90].
4. Switch on the EHT. Refer to Switching on the EHT [} 90].
5. Set a magnification that allows transmission of the complete electron beam into the cavity

of the Faraday cup through the aperture of the Faraday cup.
6. From the Panel Configuration Bar, select Specimen Current Monitor.

à The Specimen Current Monitor window is displayed.
7. Activate the SCM On checkbox.

8. Activate the Spot checkbox.
à Green crosshairs are displayed on the image. The crosshairs indicate the position of the

beam spot.
9. Grab the crosshairs and move them into the hole of the Faraday cup.

à The probe current is measured continuously.
à The measured probe current is displayed in the Specimen I readout.

Instruction Manual ZEISS SIGMA series | en-US | Rev. 7 | 352102-9344-006 97



5 Commissioning and First Operating Steps | 5.5 Modifying Gun Parameters ZEISS

5.5.3 Setting the Probe Current

You can set a lower probe current to analyze surface details at a high resolution or higher probe
currents for analytical purposes, e.g. to analyze the material of the specimen.

Info
The maximum achievable probe current depends on the currently selected EHT and the in-
stalled aperture configuration.

Procedure 1. In the SEM Controls panel, select the Gun tab.
2. Activate the OptiProbe checkbox.
3. Double-click the I Probe readout.

à The I Probe window is displayed.
4. In the input field, enter the desired value.

5.5.4 Continuously Modifying the Probe Current (License: OPTIPROBE)

Info
OptiProbe allows you to continuously adjust the probe current. The function automatically se-
lects a suitable aperture and the current mode while the extractor voltage is adjusted to meet
the probe current selected by the user.

Info
After cathode replacement or after re-alignment of the electron optical column, OptiProbe has
to be calibrated.

Prerequisite ü Requires the licenses OPTIPROBE and HIGH VOLTAGE

ü Particular hardware and the specimen current amplifier are installed.

Procedure 1. In the SEM Controls panel, select the Gun tab.
2. Activate the OptiProbe checkbox.
3. Use the I Probe slider to set the desired probe current.

à As soon as the probe current adjustment is finished, the OptiProbe Status readout
changes from Busy to Ready.

à The probe current displayed in the I Probe readout corresponds to the actual probe cur-
rent (± 15 %).

4. To deactivate the function, deactivate the OptiProbe checkbox.
INFO: If OptiProbe is deactivated, the I Probe readout continues to indicate the actual
probe current (± 15 %).

5.5.5 Changing the Extractor Voltage

The Extractor voltage is preset by the factory or by the ZEISS service representative. Within certain
limits, the operator may carefully increase the extractor voltage in order to optimize the probe
current for particular applications.

Info
Use a Faraday cup to measure the probe current when changing the extractor voltage.
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Info
The newly set extractor value is only valid for the current work session. After a restart of the
SmartSEM software, the microscope restores the nominal extractor voltage.

Info
Reducing the extractor voltage may impair the performance and resolution of the microscope.

4 Avoid reducing the extractor voltage.

4 If at all, reduce the extractor voltage only for a short time (1–2 h) and by maximum 500 V.

Prerequisite ü The user privilege Extractor is required to change the extractor voltage.

Procedure 1. From the Menu Bar, select Beam > Gun Setup.
à The Gun Service dialog is displayed.

2. To increase the extractor voltage, double-click the Extractor V Target readout.
à The Extractor V Target window is displayed.

3. Enter a higher value.
4. Click OK.

After you change the extractor voltage, calibrate the probe current, refer to Measuring the Probe
Current [} 97].

5.6 Finding Appropriate Detector Settings

5.6.1 Selecting a Detector

You need to select an appropriate detector depending on the application and the pressure mode.
In addition to the standard SE detector, several optional detectors are available.

For information on special set-up procedures for the detectors, refer to:

§ Setting up the InLens SE Detector [} 100]

§ Setting up the InLensDuo Detector [} 100]

§ Setting up the SE Detector [} 101]

§ Setting up the VPSE Detector [} 102]

§ Setting up the C2D Detector [} 103]

§ Setting up the HDAsB Detector [} 105]

§ Setting up the aBSD1-LH Detector [} 104]

§ Setting up the Manually Insertable BSD Detector [} 107]

§ Setting up the YAG BSD Detector [} 108]

§ Setting up the CL Detector [} 108]
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Procedure 1. Select the Detectors tab of the SEM Controls panel.
2. Select the detector from the Signal A drop-

down list.

5.6.2 Setting up the InLens SE Detector

The InLens SE detector collects the SE signal, acquiring mainly information about surface topogra-
phy.

Fig. 63: Silver nanoparticles embedded in zeolite, imaged at 1.5 kV.

The following settings are recommended for the InLens SE detector:

EHT Typical WD Recommended WD

20 V – 10 kV 0–5 mm * Short working distances are preferable for
good detection efficiency

10 kV – 20 kV 2–5 mm

* At EHTs between 20 V and 0.5 kV, a WD of exactly 0 is not possible.

Info
Avoid strong specimen tilting for the InLens SE detector.

Procedure 1. In the SEM Controls panel, select the Detectors tab.
2. From the Signal A drop-down list, select InLens.
3. Adjust the EHT and the working distance (WD) according to the suggestions in the table in

order to optimize the image.

5.6.3 Setting up the InLensDuo Detector

The InLens Duo detector allows imaging and mixing of a high contrast topography (SE) as well as
clear compositional contrast (BSE). In the BSE image, heavy elements are represented by brighter
pixels and light elements are represented by darker pixels. By adjusting the filtering grid, energy-
selected BSE images can be obtained. If the filtering grid voltage is set to 0, SE and BSE mixed im-
ages can be acquired.
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Fig. 64: Co-Re alloy at 1.5 kV, low magnification, SE mode (left) and BSE mode (right)

Fig. 65: Co-Re alloy 1.5 kV, high magnification, SE mode (left) and BSE mode (right)

The following settings are recommended for the InLensDuo detector:

EHT Typical WD Filtering Grid

500 V – 10 kV 0–5 mm BSE Mode

InLensDuo Grid > 400 V to filter out the SE
signal

20 V – 500 V 0–3 mm SE Mode

InLensDuo Grid = 0 V for the use as an addi-
tional SE detector, like an InLens SE detector,
refer to Setting up the InLens SE Detector
[} 100]

Info
Short working distances are preferable for good detection efficiency.

Avoid strong specimen tilting for the InLens Duo detector.

Procedure 1. In the SEM Controls panel, select the Detectors tab.
2. From the Signal A drop-down list, select InLensDuo.
3. To work in BSE mode, activate BSE Mode.

To work in SE mode, deactivate BSE Mode.
4. Adjust the EHT, the working distance (WD) and the InLens Duo grid voltage according to

the suggestions in the table in order to optimize the image.

5.6.4 Setting up the SE Detector

The SE detector collects the SE signal, highlighting the topography of the specimen.
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Fig. 66: An eledone tentacle

The following settings are recommended for the SE detector:

EHT Typical WD Collector Voltage

500 V – 5 kV 2–8 mm § Adjustable from −250 V to +400 V

§ Standard applications: +300 V

At a high magnification, you can opti-
mize the image by varying the collector
voltage.

§ Pseudo-backscattered (BSE) image:
−250 V to −50 V

This produces a topogaphic image of the
sample with no material contrast.

5 kV – 30 kV min. 6 mm

Procedure 1. In the SEM Controls panel, select the Detectors tab.
2. From the Signal A drop-down list, select SE2.
3. Adjust the EHT, working distance (WD), and collector voltage according to the suggestions

in the table in order to optimize the image.

Info

For detailed information on working with the SE detector refer to Acquiring an Image [} 83].

5.6.5 Setting up the VPSE Detector

The VPSE detector is designed for VP applications. The VP mode enables analyzing and imaging of
non-conducting, strongly gassing or moist specimens without any need for specimen preparation.

Fig. 67: A rosemary leaf.
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The following settings are recommended for the VPSE detector:

EHT Typical WD VPSE Bias

1 kV – 30 kV 7–10 mm Adjustable from 0 to 100 %

Prerequisite ü The microscope is operating in VP vacuum mode

Procedure 1. In the SEM Controls panel, select the Detectors tab.
2. From the Signal A drop-down list, select VPSE G4.
3. Adjust the EHT, working distance (WD), and VPSE bias according to the suggestions in the

table in order to optimize the image.

5.6.6 Setting up the C2D Detector

Fig. 68: C2D image of radiolaria

Procedure 1. In the SEM Controls panel, select the Detectors tab.
2. From the Signal A drop-down list, select C2D.
3. Open the Panel Configuration Bar.
4. Double-click C2D Control to open the C2D

Control panel.

5. Select C2D Gain = Low.
6. Adjust the C2D Bias scroll bar until you reach saturation.
7. Click C2D Auto Level.

If you are unable to reach saturation or if the image quality is not good, repeat the proce-
dure in high gain.
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5.6.7 Setting up the aBSD1-LH Detector

The aBSD1-LH detector is a pneumatically retractable backscattered electron detector which is in-
serted below the objective lens and is used for high efficiency and angle selective material charac-
terization.

Fig. 69: BSE images of NdFeB magnet surface showing different contrast on different segments of
the aBSD1-LH detector. The inner segment S1 shows combined material contrast and topography
(left). The outer segment S2-S5 shows mainly topography (right).

The following settings are recommended for the aBSD1-LH detector:

EHT Typical WD Detector Settings

0.5–30 kV 5–12 mm Compositional mode for obtaining an image
that is high in atomic number contrast

Use topographic mode for showing surface
details

Use individual settings for channeling con-
trast

Make use of different concentric rings of the
detector to get angular resolved BSE images

Use high or very high detector gain for low
accelerating voltage and/or low beam current

The EHT should be bigger than 2 kV to
achieve a significant detection efficiency.

Procedure 1. From the Panel Configuration Bar, select BSD Control.
The BSD Control panel enables you to change the polarity of the segments, select BSD
modes, and set the BSD gain.
à The BSD Control panel is displayed.

2. In the BSD Control panel, click BSD in to insert the detector.
à The stage is lowered by 20 mm to give space for the detector to be inserted.
à The detector is inserted.

3. In the SEM Controls panel, select the Detectors tab.
4. From the Signal A drop-down list, select BSD1 or BSD4 A depending on your detector

type and configuration.
INFO: A refers to the video channel. B, C, and D are also available if you have the four-
channel version.

5. Adjust the EHT and the working distance (WD) according to the suggestions in the table in
order to optimize the image.

6. In the BSD Control panel, click a quadrant symbol to toggle its status between on (white),
inverted (black), and off (gray).
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7. To choose the respective mode, click BSD: COMPO or BSD: TOPO.
The default setting for aBSD1-LH is BSD: COMPO. All five segments (S1–S5) are set to on
and an image that is high in atomic number contrast is obtained.
The default mode for BSD: TOPO is S1 off, S2 on, S3 on, S4 inv and S5 inv.

8. If you want to change the default setting to BSD: TOPO, click BSD: Set TOPO.
9. From the BSD Gain drop-down list, select Low, Medium, High, or Very High.

INFO: Since the detector has a limited speed, it is recommended to use scan speed 6 or
higher (slower), especially at small magnifications. The lower the gain is, the faster is the
detector.

5.6.8 Setting up the HDAsB Detector

The HDAsB detector is optionally available.

The HDAsB detector enables four outputs that can be used either for compositional imaging or
for topographical imaging.

Fig. 70: The crystalline structure of a silicon device

The following settings are recommended for the HDAsB detector:

EHT Typical WD Detector Settings

1.5 kV – 30 kV 3–10 mm § Use compositional mode for obtaining an
image that is high in atomic number con-
trast.

§ Use topography mode for showing sur-
face details.

§ Use individual settings for channeling
contrast.
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Procedure 1. In the SEM Controls panel, select the Detectors tab.
2. From the Signal A drop-down list, select HDAsB.
3. To open the Panel Configuration Bar, from the Menu Bar, select Tools > Goto Panel.

à The Panel Configuration Bar is displayed. It contains an alphabetical list of functions.
4. Double-click BSD Control.

à The BSD Control dialog is displayed.
à In the upper section, the BSD Control dialog

displays the four quadrants/outputs.

5. Click a quadrant symbol to toggle its status between on (white), inverted (black), and off
(gray).

6. To confirm the settings, click Apply.
7. To choose the respective mode, click BSD: COMPO or BSD: TOPO.

The default setting for HDAsB is BSD: COMPO. All four segments are set to on and an im-
age is obtained, which is high in atomic number contrast.

8. If you want to change the default setting to BSD: TOPO, click BSD: Set TOPO.
9. From the BSD Gain drop-down list, select the appropriate BSD Gain:

Low, Medium, High, or Very High.
The BSD Gain depends on the signal strength.
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5.6.9 Setting up the Manually Insertable BSD Detector

This procedure applies to all manually insertable BSD detectors apart from the YAG BSD detector.

Procedure 1. Pull up the pin at the detector.

2. Carefully push in the detector while checking with the chamber scope camera to make sure
there is nothing in the way.

3. Release the pin.
4. In the Detectors tab of the SEM Controls panel, select the respective detector from the

Signal A drop-down list.
5. Open the Panel Configuration Bar.
6. Double-click BSD Control to open the BSD

Control panel.
INFO: The BSD Control panel allows you to
change the polarity of the segments, select BSD
modes and set the BSD gain.

7. Click a segment symbol to change its status between on (white), inverted (black), or off
(gray).

8. To select compositional mode, click BSD: COMPO.
9. To select topography mode, click BSD: TOPO.
10. Select the BSD Gain from the drop-down list.
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5.6.10 Setting up the YAG BSD Detector

NOTICE

Inserting the YAG BSD detector
When you manually insert the detector, there is a risk to damage the YAG BSD detector.

4 Use the chamberscope image to observe if there is enough space between the objective
lens and the specimen.

4 If there is not enough space between the objective lens and the specimen, then lower the
stage position before you insert the detector.

4 Insert the YAG BSD detector carefully and observe the moving YAG BSD detector via the
chamberscope.

Procedure 1. Insert the detector.
If there is any resistance, make sure the silver
knob is untightened.

2. In the SEM Controls panel, select the Detectors tab.
3. From the Signal A drop-down list, select YAG BSD.
4. To optimize the image, adjust brightness and contrast. There are no further parameters to

change.
5. After use, retract the detector.

INFO: Because of the detector’s weight, there is only little risk for it to accidentally slide in.
Therefore, you do not have to fix the silver knob.

5.6.11 Setting up the CL Detector

The CL detector is optionally available.

The CL detector collects visible or ultraviolet light and is especially useful for internal structural ex-
aminations of rocks, ceramics, and semiconductors.

Fig. 71: Zircon grains
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Info
The CL signal is usually very weak and the resolution of the CL image is much worse than an
SE image.

4 Use the SE detector to navigate and focus before acquiring CL images.

The following settings are recommended for the CL detector:

EHT Typical WD

5 kV – 30 kV 6–10 mm

(min. 4 mm)

Procedure 1. In the SEM Controls panel, select the Detectors tab.
2. From the Signal A drop-down list, select CL.
3. Adjust the EHT and the working distance (WD) according to the suggestions in the table in

order to optimize the image.

5.7 Working with Variable Pressure

VP mode offers the possibility of analyzing and mapping non-conducting, strongly gassing or
moist specimens without any need for specimen preparation.

Info
In VP mode, the InLens SE detector, the InLensDuo detector, and the SE detector cannot be
used.

Mode Booster Chamber Pressure

High Vacuum HV On < 10⁻² Pa

Variable Pressure VP Off 2–133 Pa

Tab. 4: VP configuration

5.7.1 Changing to Standard VP Mode

Info
If the VP system has not been used for several days, start with moderate pressure up to 30 Pa
for the first 10 minutes.

Afterwards the vacuum system is conditioned and the VP mode can be used with its full range.

Info
A higher pressure can be set within a few seconds. Achieving a lower pressure may require
some more time, because the specimen chamber has to be evacuated by the pre-vacuum
pump.

Prerequisite ü The microscope is operating in HV vacuum mode

Procedure 1. In the SEM Controls panel, select the Vacuum tab.
2. In the Variable Pressure section, click VP.

à The system sets the chamber pressure to the value displayed in the VP Target field. If
you have not changed it, it is the value of the last VP session.
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à The transition is indicated in the status bar of the SmartSEM software.
3. Wait until the system is ready for VP operation and Chamber Status = At VP is displayed.

à This takes approximately 20 s.
4. To change the chamber pressure, use the VP Target scroll bar.

Alternatively double-click into the VP Target field, enter desired pressure value and click
OK.
Refer to Working with Variable Pressure [} 109] to determine the correct pressure value.

5.7.2 Returning to HV Mode

HV mode is the standard mode of a FESEM. It offers the possibility of analyzing and mapping con-
ducting specimens. In HV mode, the pressure in the specimen chamber is less than 10⁻⁶ mbar.

Info
When switching from VP to HV mode, the column chamber valve closes automatically, as a rel-
atively poor vacuum is available in the specimen chamber when opening the TIV.

Prerequisite ü The microscope is operating in VP vacuum mode

Procedure 1. In the SEM Controls panel, select the Vacuum tab.
2. In the Variable Pressure section, click HV.

à The transition is indicated in the status bar of the SmartSEM software.
This takes approximately 20 s.

5.8 Working with Optional Accessories

5.8.1 Using the Optional Airlock

5.8.1.1 Unloading the Specimen Using an Airlock

You can unload the specimen either manually or with pre-defined airlock macros to simplify the
specimen exchange.

This procedure consists of the following steps:

§ Driving the specimen holder to the transfer position.

Either refer to Driving to Transfer Position via Airlock Macros [} 110] or to Driving to Transfer
Position without Airlock Macros [} 111].

§ Unloading the Specimen Holder from the Airlock [} 112]

5.8.1.1.1 Driving to Transfer Position via Airlock Macros

Prerequisite ü A specimen is loaded in the specimen chamber and is to be exchanged for another specimen.

Procedure 1. To open the Stage Navigation Bar, navigate to View > Toolbars and activate Stage
Navigation Bar (for Widescreen users). Alternatively, you can access the Stage Naviga-
tion Bar via Stage > Navigation.
à The Stage Navigation Bar is displayed.

2. From the Panel Configuration Bar, select Airlock.
3. Click Specimen Change to start the pre-defined macro.

INFO: The airlock macros can be modified according to your individual requirements. Con-
tact your local ZEISS service representative for assistance.
The macro automatically performs the following actions:
à The EHT is switched off.
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à The column chamber valve is closed in order to separate gun head area and specimen
chamber.

à The specimen stage is driven to the transfer position.
à The airlock is evacuated.
à The gate valve opens.
à The illumination is turned on in the airlock

chamber.

5.8.1.1.2 Driving to Transfer Position without Airlock Macros

Prerequisite ü A specimen is loaded in the specimen chamber and is to be exchanged for another specimen.

Procedure 1. Switch off the EHT.
2. To open the Stage Navigation Bar, navigate to View > Toolbars and activate Stage

Navigation Bar (for Widescreen users). Alternatively, you can access the Stage Naviga-
tion Bar via Stage > Navigation.
à The Stage Navigation Bar is displayed.

3. From the Panel Configuration Bar, select Airlock.
4. Click Close Column Chamber Valve.

à The column chamber valve is closed in order
to separate gun head area and specimen
chamber.

5. Select Stage Points List from the Panel Configuration Bar.
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6. Double-click $Exchange.
 NOTICE  If the stage is at a short working distance, there is a risk to damage the
microscope or the specimen. Ensure there is enough space between objective lens
and specimen before moving the specimen stage.
à The specimen stage is driven to the transfer position.

7. To change to Transfer mode, click Transfer in the Airlock panel.
Alternatively, on the control panel, press Transfer.
à The airlock is evacuated.
à The gate valve opens.
à The illumination is turned on in the airlock chamber.

5.8.1.1.3 Unloading the Specimen Holder from the Airlock

 WARNING

Suffocation hazard due to lack of oxygen
Gaseous dry nitrogen is used to vent the specimen chamber during specimen exchange. Inhal-
ing nitrogen may cause unconsciousness.

4 During specimen exchange, keep the chamber door open as short as possible.

4 Do not inhale the air from within the specimen chamber.

4 Ensure that the area around the microscope is sufficiently vented.

4 If you begin to experience symptoms of asphyxia (for example: rapid breathing, loss of
mental alertness and/or muscular coordination, depression of sensations, emotional insta-
bility, fatigue) leave the room immediately and inform the facility’s safety officer.

Procedure 1. To transfer the specimen holder from the speci-
men chamber into the airlock, insert the airlock
rod.

2. Turn the knob clockwise to attach the speci-
men holder to the airlock rod.

3. Retract the airlock rod.
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4. On the control panel, press Vent, to change to
Vent mode. 
Alternatively, click Vent in the Airlock panel.

à The gate valve is closed. The airlock chamber is vented with nitrogen.
5. Take hold of the airlock handle and open the

airlock door.

6. To exchange the whole specimen holder, Turn
the knob counter-clockwise and detach the
specimen holder from the airlock rod.

7. Remove the specimen holder from the dovetail.
8. Mount the exchange specimen holder onto the

dovetail. Ensure that the airlock rod mount
faces the threaded rod.
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9. Attach the specimen holder to the airlock rod by turning the knob clockwise.

5.8.1.2 Loading the Specimen Using an Airlock

You can load the specimen either manually or with pre-defined airlock macros to simplify the
specimen exchange.

Info
If you want to use a navigation camera at the airlock to navigate the stage, you have to ac-
quire an overview image before the sample holder is introduced into the specimen chamber.

This procedure consists of the following steps:

§ Loading the Specimen Holder into the Airlock [} 114]

§ Closing the gate valve and opening the column chamber valve

Either refer to Controlling the Valves via Airlock Macros [} 116] or to Controlling the Valves
without Airlock Macros [} 117].

5.8.1.2.1 Loading the Specimen Holder into the Airlock

 WARNING

Suffocation hazard due to lack of oxygen
Gaseous dry nitrogen is used to vent the specimen chamber during specimen exchange. Inhal-
ing nitrogen may cause unconsciousness.

4 During specimen exchange, keep the chamber door open as short as possible.

4 Do not inhale the air from within the specimen chamber.

4 Ensure that the area around the microscope is sufficiently vented.

4 If you begin to experience symptoms of asphyxia (for example: rapid breathing, loss of
mental alertness and/or muscular coordination, depression of sensations, emotional insta-
bility, fatigue) leave the room immediately and inform the facility’s safety officer.

Prerequisite ü The airlock is vented

ü The correct specimen holder is mounted and is retracted into the airlock

ü The specimen chamber is unloaded

Procedure 1. Insert the stub with the new specimen into the specimen holder and fix the stub to the
specimen holder.

2. Check that the airlock rod is fully retracted.
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3. To use an airlock camera for navigation, ac-
quire an overview image with the airlock cam-
era:
Press the button of the navigation camera at
the airlock.
Wait until the image is acquired and displayed
in the Image Navigation section of the Stage
Navigation Bar.

4. Close the airlock door.
5. On the control panel, press Transfer, to

change to Transfer mode. 
Alternatively, click Transfer in the Airlock
panel.

à The airlock is evacuated, the gate valve opens, and the illumination is turned on in the
airlock chamber.

6. To transfer the specimen holder, insert the airlock rod into the specimen chamber.
à The specimen holder slides into the dovetail

at the specimen stage.
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7. Turn the knob counter-clockwise in order to
detach the specimen holder from the airlock
rod.

8. Retract the airlock rod.

5.8.1.2.2 Controlling the Valves via Airlock Macros

Procedure 1. In the Airlock panel, click Resume Exchange to start the pre-defined macro.
The macro automatically performs the following steps:
à The gate valve is closed.
à The column chamber valve is opened.

INFO: The airlock macros can be modified
according to your individual requirements.
Contact your local ZEISS service representa-
tive for assistance.

2. Switch on the EHT. Refer to Switching on the EHT [} 90].

9 You can now continue working with the microscope.

9 If you acquired an overview image with an airlock camera, you can now navigate the stage by
double-clicking in the overview image.
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5.8.1.2.3 Controlling the Valves without Airlock Macros

Procedure 1. On the control panel, press Vent, to change to Vent mode. 
Alternatively, click Vent in the Airlock panel.
à The gate valve is closed.
à The airlock chamber is vented with nitrogen.

2. Click Open Column Chamber Valve.

à The column chamber valve is opened.
3. Switch on the EHT. Refer to Switching on the EHT [} 90].

9 You can now continue working with the microscope.

9 If you acquired an overview image with an airlock camera, you can now navigate the stage by
double-clicking in the overview image.
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5.8.2 Using the Optional Plasma Cleaner

5.8.2.1 Activating the Plasma Cleaner

The Plasma Cleaner is an optional accessory that allows you to decontaminate the specimen
chamber and any loaded specimens. The plasma is fully contained in the Plasma Cleaner unit. The
radicals migrate into the specimen chamber and chemically react with unwanted hydrocarbons.

After a plasma cleaning cycle, the specimen surface provides optimal imaging conditions even at
very low imaging voltages.

Info
Depending on the plasma cleaner model, T pump mode and purging are available and the
Plasma Cleaning panel looks different.

Info
You can view a log file that contains all relevant events concerning the Plasma Cleaner via
Panel Configuration Bar > Plasma Cleaning > View Log. The log file can be used for trou-
bleshooting and to determine when the next plasma cleaning process should be scheduled.

Fig. 72: Plasma Cleaner.Log

NOTICE

Gases
Unstable pressure or unwanted reactions between the plasma and gases injected into the
chamber can damage the specimen or the vacuum system.

If a gas injection system or the charge compensation function are active, the gas injection af-
fects the pressure range and can create unwanted reactions between the plasma and the in-
jected gas.

4 Make sure the chamber pressure is stable during plasma cleaning.

4 Do not use the GIS or the charge compensator when using the plasma cleaner.

NOTICE

Plasma cleaning
Plasma can damage sensitive specimens.

4 Always test the plasma cleaner on specimens of the same material before cleaning any im-
portant specimen.

Procedure 1. If your microscope is equipped with the airlock, make sure that the gate valve of the airlock
is closed. Do not use the airlock while using the Plasma Cleaner.
For more information refer to the instruction manual of the airlock.

2. Switch off the EHT.
 NOTICE  The pressure range applied during plasma cleaning can damage the
electron source. To protect the electron source from the harmful pressure range,
close the column chamber valve.
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3. From the Panel Configuration Bar, select Plasma Cleaning.
à The Plasma Cleaning panel is displayed.

4. Check that the Plasma Cleaner controller hard-
ware is switched on and the Connected LED is
active in the software.

5. From the Recipe drop-down list, select a
recipe.
INFO: There are several preset recipes for dif-
ferent purposes that cannot be edited. Addi-
tionally, you can create custom recipes.

6. To start the plasma cleaning, click Start clean-
ing.

à The current status is displayed in the Plasma Cleaning Sequence section.
à If the selected recipe involves nitrogen purges, the number of purge cycles is displayed

next to the flow chart. The arrow indicates which steps will be repeated.
7. Wait until the Finished LED is active.

This indicates that the plasma cleaning process is complete.
INFO: If you wish to abort the cleaning cycle while it is still running, click Stop cleaning.
à The chamber is pumped.

8. Wait until Vac Status = Ready is displayed in the Vacuum tab of the SEM Controls panel.
à The gun and the EHT can then be switched back on and you can return to regular micro-

scope operation. Refer to Switching on the Gun [} 90] and Switching on the EHT [} 90].

5.8.2.2 Creating Custom Recipes

There are several preset recipes for different purposes that cover most applications. Additionally,
you can create custom recipes for special purposes.

Procedure 1. From the Panel Configuration Bar, select Plasma Cleaning.
à The Plasma Cleaning panel is displayed.

2. Click Edit Recipes.
à The Plasma Cleaning Recipe List is displayed and displays the available recipes.

INFO: The preset recipes are marked as Fixed in the Type column and cannot be edited
or deleted.
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3. To create a new recipe, click Add.

à The Cleaning Recipe window is displayed.
4. Enter a name for the cleaning recipe.
5. Select the desired values according to your specific application.

In particular, the plasma power and the plasma time can be changed for the customized
recipes.

6. If a plasma cleaner with purge option is installed and if nitrogen purge cycles are necessary,
activate the Purge checkbox.
à This adds additional values that can be edited.

7. If required, activate T pump mode.
This option provides a faster cleaning at better vacuum.

8. Once the settings are complete, click Ok.

à The recipe is added to the list of available recipes.
à In the Type column, the new recipe is displayed as User, which tells you that the recipe

can be edited or deleted.
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5.8.2.3 Setting up the Schedule

If you want to schedule the next plasma cleaning, you can set up a date and time for an auto-
mated decontamination cycle.

NOTICE

Plasma cleaning
Plasma can damage sensitive specimens.

4 Always test the plasma cleaner on specimens of the same material before cleaning any im-
portant specimen.

NOTICE

Gases
Unstable pressure or unwanted reactions between the plasma and gases injected into the
chamber can damage the specimen or the vacuum system.

If a gas injection system or the charge compensation function are active, the gas injection af-
fects the pressure range and can create unwanted reactions between the plasma and the in-
jected gas.

4 Make sure the chamber pressure is stable during plasma cleaning.

4 Do not use the GIS or the charge compensator when using the plasma cleaner.

Procedure 1. From the Panel Configuration Bar, select Plasma Cleaning.
à The Plasma Cleaning panel is displayed.

2. To select a date for your cleaning schedule, click the Calendar icon.

3. In the input field on the left side of the Calendar icon, enter a time.
4. Activate the Schedule cleaning cycle at: checkbox.

à The cleaning cycle schedule is now active. 30 seconds before the scheduled cleaning cy-
cle, a countdown will be displayed to inform you that a cleaning cycle is about to start.

5. To abort the countdown and start the cleaning cycle right away, click Start Now.
6. To abort the countdown and cancel the scheduled cleaning cycle, click Cancel.
7. To start the cleaning cycle as scheduled, no action needs to be taken.

5.8.2.4 Returning to Regular Operation

Procedure 1. If a cleaning cycle is currently running, click Stop cleaning to abort the cleaning cycle.
2. Close the Plasma Cleaning window.

à The chamber is pumped.
3. Wait until Vac Status = Ready is displayed in the Vacuum tab of the SEM Controls panel.
4. Switch on gun and EHT. Refer to Switching on the Gun [} 90] and Switching on the EHT

[} 90].
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5.8.3 Using the Optional Raman Spectroscopic Microscope

5.8.3.1 Acquiring an Image with the Optional Raman Spectroscopic Microscope

Raman spectroscopy is a non-destructive analytical technique that can be used to identify and im-
age various material parameters, such as chemical composition and crystallographic orientation.
The specimen is illuminated with a monochromatic laser beam, which interacts with the molecules
of the specimen. The spectrum of the scattered light is analyzed.

The stage position and working distance of the SEM and the Raman spectroscopic microscope are
not identical:

Fig. 73: SEM and Raman working distance

Prerequisite ü SmartSEM is started

Procedure 1. Open the SEM Raman Correlation window.
à INFO: The scan rotation is automatically adjusted to match the different rotations of the

Raman microscope and the SEM. Do not change the scan rotation.
2. Activate the Use auto calibration data check-

box.

3. Use the dual joystick to shift the specimen in X direction and in Y direction until the region
of interest on the specimen is centered.

4. Use the dual joystick to shift the specimen in Z
direction until the image is roughly in focus.
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5. Use the buttons in the Manual stage control
section of the SEM Raman Correlation win-
dow to refine the adjustment.
INFO: If you use the Manual stage control,
then the backlash correction is automatically
activated. The backlash correction ensures the
required relative accuracy of the stage.

6. Save the SEM image.
à In the Raman Correlation tab, a message is

displayed that asks you to focus the image.

7. Focus the image.
8. In the Raman Correlation tab of the SEM Ra-

man Correlation window, click Move to Ra-
man
The following steps are executed automatically:

à The image of the USB TV camera is automati-
cally displayed to let you see the movement
towards the Raman objective and the Raman
working distance.
INFO: The speed of the dual joystick de-
pends on the magnification. If the image of
the USB TV camera is displayed, then the
stage travels with maximum speed.

à The stage moves the specimen to the Raman position.
à After the movement is finished, the SEM image is displayed again.

INFO: Not all stage positions are within the reach of both, the SEM and the Raman mi-
croscope. In this case, a message is displayed in the message field. Often a rotation of
the specimen towards the Raman microscope helps. Use the compucentric rotation to ro-
tate the specimen.

9. Check that the objective is in the position x = 0, y = 0, and z = 0.
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10. Use the dual joystick to shift the specimen in Z direction until the image is in focus.

à The image becomes brighter.
11. To correlate the Raman microscope with the electron microscope, overlay the Raman image

to the SEM image:
Import the SEM image via File > Import > Import SEM Image

12. In the Project Manager window, drag the light microscope image and drop it on the SEM
image.
à A menu is displayed.

13. Select Use as Overlay in the menu.
à The light microscope image is overlaid to the SEM image.
à The Image Transform and Overlay window is displayed.
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14. In the Transformation tab of the Image Transform and Overlay window, activate the Lis-
ten (Click and Move) checkbox.

15. Click on the light microscope image and accurately align it with the SEM image.
à The Raman microscope is correlated with the electron microscope.

16. To extract a bitmap image, click Extract Bit-
map.

à INFO: For bigger fields of view, use stitching.
17. Acquire Raman spectra or Raman maps.
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18. When you are finished acquiring the Raman spectra, then move the stage back to the posi-
tion x = 0, y = 0, and z = 0.
à INFO: The position x = 0, y = 0, and z = 0 is

the reference position for the correlating
SEM position.

19. To go back to SEM imaging, click Move to SEM in the Raman Correlation tab of the
SEM Raman Correlation window.

5.9 Shutting down the System

5.9.1 Finishing the Work Session

To finish your work session, you need to switch off the EHT.

Change to STANDBY mode when the microscope is not operated, even for longer periods. The
filament will continue to be heated, and the vacuum in the electron optical column and in the
specimen chamber will be maintained.

The STANDBY mode is also the recommended mode to store the microscope. In this case, acti-
vate the Partial Vent on Standby checkbox in the Vacuum tab of the SEM Controls panel. This
can help to prevent oil vapors from penetrating into the specimen chamber during the period of
storage.

NOTICE

Schottky field emitter
If the Schottky field emitter is switched on and off too frequently or inappropriately, its lifetime
is reduced.

4 Avoid switching off the gun during the working week.

4 Use Standby mode for the weekend or a break of up to a week.

4 When using the Standby mode, activate the Partial Vent on Standby function.

Prerequisite ü The microscope is in ON mode.

Procedure 1. Click the All: button in the status bar.

2. Select EHT Off from the pop-up menu.
3. Only when interrupting work for longer periods between 2 and 7 days: In the Vacuum tab

activate the Partial Vent on Standby checkbox.
à This maintains the gun vacuum, and switches off and protects the turbo pump.

4. Exit the SmartSEM user interface. Refer to Exiting the SmartSEM User Interface [} 127].
5. Close all programs and software.
6. Select Windows start button > Power icon > Shut down.
7. At the front of the plinth, press the Standby button.
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à The microscope switches to Standby mode.

5.9.2 Closing the SmartSEM User Interface

5.9.2.1 Logging off from the SmartSEM User Interface

Procedure 1. From the Menu Bar, select File > Log Off.
à A system message is displayed.

2. Click Yes.
3. Close the EM Server.

à A system message is displayed.
4. Click Yes.

INFO: The EM server remains active.

5.9.2.2 Exiting the SmartSEM User Interface

Procedure 1. From the Menu Bar, select File > Exit.
à A system message is displayed.

2. Click Yes.
3. Close the EM Server.

à A system message is displayed.
4. Click Yes.
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5.9.3 De-energizing the Microscope

This procedure completely cuts off the microscope from the electrical main supply.

 WARNING

Residual voltage at the mains plug
After unplugging the mains plug residual voltage is present at the pins of the plug which may
cause electrical shock.

4 After unplugging the mains plug wait at least 5 s before touching the pins of the mains
plug.

Prerequisite ü The microscope is in Standby mode, refer to Finishing the Work Session [} 126], or in OFF
mode

Procedure 1. If the microscope is not yet in OFF mode, press the Off button at the front of the plinth.
à When all subsystems are fully deactivated,

the Off button lights up red permanently.

2. Close and lock the main shut-off valves at the installation site.
3. If the EMO circuit is not installed, unplug the

power cord by unplugging the CEE connector
from the CEE FEMALE RECEPTACLE of the
mains supply.

4. If the EMO circuit is installed, switch the Main
Switch to its OFF position.

9 The microscope is completely cut off from the electrical main supply.
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5.10 Performing an Emergency Shutdown

If an emergency occurs and you quickly must shut down the microscope, then you need to per-
form an emergency shutdown.

 WARNING

Residual voltage at the mains plug
After unplugging the mains plug residual voltage is present at the pins of the plug which may
cause electrical shock.

4 After unplugging the mains plug wait at least 5 s before touching the pins of the mains
plug.

NOTICE

Components in the high voltage circuitry
When the microscope, especially the gun, is fully on, an abrupt shutdown of all electrical sup-
plies may damage some components in the high voltage circuitry, mainly the cathode.

4 Use the emergency off only in an emergency situation with personnel injury.

Procedure 1. If the EMO circuit is not installed, unplug the
power cord by unplugging the CEE connector
from the CEE FEMALE RECEPTACLE of the
mains supply.

2. If the EMO circuit is installed, press the EMO
button on the top of the plinth.
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6 Care and Maintenance
To ensure the best possible performance of the Microscope System, maintenance must be per-
formed on a regular basis. To maintain operational safety and reliability of the Microscope Sys-
tem, we recommend entering into a ZEISS Protect service agreement. Please keep the service
logs for your Microscope System.

Info
Additional information and detailed descriptions are available in the further applicable docu-
ments, or ask your ZEISS Sales & Service Partner.

6.1 Safety During Cleaning and Maintenance

Only conduct preventive measures described in the Instruction Manual. All pursuing tasks of main-
tenance, service and cleaning not described here must only be performed by an authorized ZEISS
service representative. Any unauthorized intervention in the Microscope System or any use outside
the scope of the intended use can lead to injuries and property damage, and voids all rights to
warranty claims. Only original spare parts from ZEISS may be used.

6.2 Maintenance Schedule

To maintain best possible performance of the Microscope System, it is essential to perform pre-
ventive maintenance on a regular basis. The recommended intervals depend on the total uptime
of the Microscope System.

§ 24 hours, 7 days a week: semiannually

§ 8 hours, 5 days a week: annually

Info
Keep track of maintenance work and contact the ZEISS service representative in time.

A list of ZEISS locations and authorized service partners can be found at:

http://www.zeiss.com/microscopy

6.3 Maintenance Work

Only conduct maintenance work described in this document. All tasks of maintenance, service and
repair not described here must only be performed by an authorized ZEISS service representative.

6.3.1 Change of Consumables and Chemicals

The change of consumables and chemicals is a scheduled interruption of operation to replenish
process consumables and chemicals.

The change of consumables and chemicals has to be performed by a ZEISS service representative
at mandatory intervals.

The times scheduled are designed for the maximum equipment performance level (i.e. 24 h per
day of permanent operation).

Interval Component/Part

Every 6000 h*

(filament on)

Field emission gun (filament)*
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Interval Component/Part

Yearly or as required

(and after exchange of field emission gun)

§ Standard aperture

§ Anode aperture

§ Extractor aperture

§ Anode aluminum seal

§ Copper seal at gun head

Yearly or as required Tip seal and tip O-ring of the pre-vacuum
pump

Yearly performance check § SE detector

§ InLens SE detector

§ All optional detectors

* There is no warranty on field emission guns; manufacturers do not guarantee any lifetime.

Emitter lifetime depends on several operating parameters, mainly on the filament temperature.
An emitter can be destroyed by a catastrophic arc between the filament and the extractor
electrode.

Tab. 5: Schedule for the change of consumables

6.3.2 Servicing the Pre-vacuum Pump

For maintenance of the pre-vacuum pump, refer to the instruction manual of the pump provided
by the pump manufacturer.

You can find this documentation in the document folder of your microscope.

6.4 Care and Cleaning Work

All care and cleaning work not described here must only be performed by an authorized ZEISS ser-
vice representative.

NOTICE

Functional impairment due to dirt and moisture
Dirt, dust and moisture can impair the Microscope System’s functionality and can cause short-
circuits.

4 The ventilation slots must be unobstructed at all times.

4 Perform regular maintenance and cleaning according to the instructions in this document
and according to the instructions in the applicable documents.

4 Make sure that no cleaning liquid or moisture gets inside the Microscope System.

4 In case of damage, the affected parts of the Microscope System must be taken out of op-
eration.
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6.4.1 Cleaning the Microscope

 CAUTION

Isopropanol
Isopropanol is highly flammable and irritating to the eyes.

Vapors may cause drowsiness and dizziness.

4 Wear suitable gloves.

4 Keep away from sources of ignition.

4 Do not smoke.

4 In case of contact with the eyes, rinse immediately with plenty of water and seek medical
advice.

4 Avoid contact with skin.

4 Do not breathe vapor.

In case you have to clean the microscope always use a lint-free cloth.

In case you need a cleaning liquid, only isopropanol on a lint-free cloth may be used for cleaning
parts of the microscope. Where cleaning with isopropanol is allowed and necessary is mentioned
in the relevant chapters of the manual.

Covers of the microscope which have been secured by a screw must not be removed. Please con-
tact the Zeiss service in case cleaning is necessary below these covers.
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7 Troubleshooting
The following table provides hints for solving common problems. If you cannot solve the problem
or if you are unsure about a certain technical difficulty, contact your local ZEISS service represen-
tative.

Symptom Cause Measure

Drift: Specimen seems to
be moving

§ Charging effects

§ Nonconductive specimen

§ Ensure proper conduction
of the specimen

§ Optimize specimen prepa-
ration

§ Apply a charge compensa-
tion method

Stub not correctly fixed by
screw.

Fix the stub correctly.

Gun is switched off auto-
matically

Gun has been switched off for
safety reasons since gun vac-
uum is worse than
2 × 10⁻⁸ mbar

Refer to Baking out the Gun
Head [} 138]

Image is bad at low EHT
(e.g. 1 kV)

Working distance is too long Reduce the working distance
to a maximum of 7 mm

Image is noisy. Noise re-
duction methods do not
help

Field emission gun is used up Contact your local ZEISS ser-
vice representative to have the
field emission gun replaced

Image quality degrades,
but there is no change in
total emission current

Field emission gun has been
damaged due to arcing

Contact your local ZEISS ser-
vice representative to have the
field emission gun replaced

InLens image is noisy Working distance is too long Reduce the working distance
to a maximum of 7 mm

No InLens image EHT exceeds 20 kV Reduce the EHT to a maximum
of 20 kV

Microscope is dead Circuit breaker is tripped
(lower position)

Check the circuit breakers

Refer to Checking the Position
of the Circuit Breakers [} 140]

Stored position of the
specimen stage cannot be
approached correctly

PC has crashed Restart the PC

Stage needs to be driven to a
well-defined position

Refer to Initializing the Stage
[} 134]

After a power failure, the
stored stage position can-
not be approached cor-
rectly

Stage needs to be initialized Refer to Initializing the Stage
[} 134]

SE image is noisy Scintillator is used up Contact your local ZEISS ser-
vice representative to have the
scintillator replaced

Specimen current is low Field emission gun is used up Contact your local ZEISS ser-
vice representative to have the
field emission gun replaced
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Symptom Cause Measure

Stage does not move Stage needs to be initialized Refer to Initializing the Stage
[} 134]

If this does not solve the prob-
lem, contact your local ZEISS
service representative

Stored position of the
specimen stage cannot be
approached correctly

Absolute stage movement is
required, stage needs to be
driven to a well-defined posi-
tion

Refer to Initializing the Stage
[} 134]

Microscope does not vent No nitrogen Check nitrogen supply

No compressed air Check compressed air supply

Vac ready = OK is not
displayed after specimen
exchange

System vacuum is bad due to a
vacuum leak at the chamber
door

Check the chamber door seal
for cleanliness

If required, refer to Replacing
the Chamber Door Seal
[} 137]

Vac ready = OK is dis-
played very late after
specimen exchange

Gas ballast is activated at the
pre-vacuum pump

Deactivate gas ballast at the
pre-vacuum pump

Vac ready = OK is dis-
played abnormally fast

Penning gauge has not been
identified correctly

Restart the microscope

If this does not solve the prob-
lem, contact your local ZEISS
service representative

Gun vacuum is worse
than 2 × 10⁻⁸ mbar

The pumping capacity of the
ion getter pump decreases in
the course of time, thus deteri-
orating the gun vacuum

Refer to Baking out the Gun
Head [} 138]

Tab. 6: Troubleshooting

7.1 Chamber

7.1.1 Initializing the Stage

If a stored stage position cannot be approached or if the stage does not move or does not move
accurately, the stage needs to be initialized.

 CAUTION

Moving the specimen stage
Fingers can be trapped by the moving specimen stage.

4 Always close the chamber door before moving the specimen stage.

4 To remove parts fallen into or near to the stage use a tool (e.g. tweezers) instead of your
fingers.

Prerequisite ü The specimen chamber has been evacuated, refer to Loading the Specimen Chamber [} 85]

ü Requires the Stage Initialise privilege
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ü No coolstage is fitted

ü If there are any large specimens inside the chamber, remove them before initializing

Procedure 1. From the Menu Bar, select Stage > Stage Initialise.
à The Initialise Stage window is displayed.

2. Confirm via Yes.
à The stage initialization process takes a few minutes.
à INFO: If initialization of the stage does not solve the stage problem, contact your local

ZEISS service representative.

7.1.2 Defining the Post Initialization Position of the Stage

You can configure the position to which the stage drives after the initialization procedure. Other-
wise, the stage drives to the center position.

 CAUTION

Moving the specimen stage
Fingers can be trapped by the moving specimen stage.

4 Always close the chamber door before moving the specimen stage.

4 To remove parts fallen into or near to the stage use a tool (e.g. tweezers) instead of your
fingers.

Prerequisite ü Requires the Supervisor privilege.

Procedure 1. From the Windows start menu, select SmartSEM > SmartSEM Administrator.
à The SmartSEM Administrator Log on window is displayed.

2. Enter user name and password.
3. To confirm, click OK.

à The SmartSEM Administrator window is displayed showing the user list.
4. Click Column/Stage.
5. In the Stage Post Initialisation Position input fields, enter the desired position.

Alternatively, use the dual joystick to navigate to the desired position and click Set to cur-
rent position.

6. To activate the function, activate the Post Init. Posn Valid checkbox.

7.1.3 Changing the Joystick TV Angle

In TV mode (chamberscope), it can occur that dual joystick and stage seem to move to opposite
directions. This is because the selected CCD camera is installed at a certain angle relative to the
stage. Thus, the camera shows a side-inverted view. To remedy this, you need to change the joy-
stick TV angle setting in the software.

Info
If you are working with two CCD cameras: The joystick TV angle can only be set for one CCD
camera. When selecting the other CCD camera, you have to change the setting.
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 CAUTION

Moving the specimen stage
Fingers can be trapped by the moving specimen stage.

4 Always close the chamber door before moving the specimen stage.

4 To remove parts fallen into or near to the stage use a tool (e.g. tweezers) instead of your
fingers.

Prerequisite ü Requires the Supervisor privilege.

Procedure 1. From the Windows start menu, select SmartSEM > SmartSEM Administrator.
à The SmartSEM Administrator Log on window is displayed.

2. Enter user name and password.
3. To confirm, click OK.
4. The SmartSEM Administrator window is displayed showing the user list.
5. Click Column/Stage.
6. In the Stage Options section, double-click the Joystick TV Angle input field.
7. Enter an angle depending on the installation lo-

cation of the CCD camera.
If the CCD camera is installed at the back, enter
180°.
If the CCD camera is installed at the front, enter
0°.
If the CCD camera is installed at the side, enter
90°.

180°

0°

90°

chamber door

7.1.4 Resetting the Touch Alarm

To prevent damage, a touch alarm is integrated in the microscope. If the specimen or the speci-
men holder touches the chamber walls, the detectors, or the objective lens, the stage is stopped
immediately. An audible warning sounds and an on-screen message is displayed.

Prerequisite ü The EM server shows the message WARNING Stage Touching.

Procedure 1. To accept the warning, click OK.
2. Move the stage in the reverse direction away from the touch.

7.1.5 Checking the Water Flow and Temperature

Procedure 1. In the Panel Configuration Bar, double-click Water Flow/Temperature.
à The Water Flow/Temperature panel is displayed.

2. Check the entries.
à If a value is critical, it is displayed in red.
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7.1.6 Replacing the Chamber Door Seal

Possible reasons for replacing the chamber door seal are the following:

§ Chamber door does not close tightly

§ Bad chamber vacuum

The procedure consists of the following steps:

§ Venting the Specimen Chamber [} 87]

§ Replacing the O-ring [} 137]

§ Evacuating the Specimen Chamber [} 89]

7.1.6.1 Replacing the O-ring

 WARNING

Suffocation hazard due to lack of oxygen
Gaseous dry nitrogen is used to vent the specimen chamber during specimen exchange. Inhal-
ing nitrogen may cause unconsciousness.

4 During specimen exchange, keep the chamber door open as short as possible.

4 Do not inhale the air from within the specimen chamber.

4 Ensure that the area around the microscope is sufficiently vented.

4 If you begin to experience symptoms of asphyxia (for example: rapid breathing, loss of
mental alertness and/or muscular coordination, depression of sensations, emotional insta-
bility, fatigue) leave the room immediately and inform the facility’s safety officer.

 CAUTION

Moving the specimen stage
Fingers can be trapped by the moving specimen stage.

4 Always close the chamber door before moving the specimen stage.

4 To remove parts fallen into or near to the stage use a tool (e.g. tweezers) instead of your
fingers.

 CAUTION

Closing the chamber door
Fingers can be pinched when closing the chamber door.

4 Use the door handle to close the chamber door.

4 Ensure not to get your fingers caught in the chamber door gap.

NOTICE

Contamination caused by fingerprints
Contamination caused by fingerprints can lead to vacuum deterioration or prolonged pumping
times.

4 Always wear lint-free gloves when touching the specimen, specimen holder, or stage.
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Procedure 1. Carefully open the chamber door.

2. On the inside of the chamber door, remove the chamber door O-ring.
 NOTICE  If you use a metal tool to remove the O-ring, then you may damage the
sealing surface. If necessary, then only use a plastic or wooden tool to remove
the O-ring.

3. Inspect the groove that holds the O-ring and remove any contamination.
4. Insert the new chamber door O-ring.
5. Close the chamber door.

7.2 Column

7.2.1 Baking out the Gun Head

The gun vacuum deteriorates with time. It is possible to perform a bake-out operation as a regular
maintenance procedure to restore the vacuum.

The procedure consists of the following steps:

§ Switching off the Gun [} 138]

§ Starting the Bakeout [} 139]

§ Switching on the Gun [} 90]

7.2.1.1 Switching off the Gun

NOTICE

Schottky field emitter
If the Schottky field emitter is switched on and off too frequently or inappropriately, its lifetime
is reduced.

4 Avoid switching off the gun during the working week.

4 Use Standby mode for the weekend or a break of up to a week.

4 When using the Standby mode, activate the Partial Vent on Standby function.
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Procedure 1. In the right part of the Status Bar, click  or .
à The pop-up menu for Vacuum, Gun and EHT activation is displayed.

2. Click Shutdown Gun.
3. Wait until the gun has ramped down.

à This may take up to 5 minutes.

7.2.1.2 Starting the Bakeout

Info
You cannot work with the microscope while the bakeout procedure runs.

NOTICE

Hot surfaces during bakeout
Parts of the enclosure in the upper range of the column may become hot during bakeout, par-
ticularly after a long bakeout cycle.

4 Do not place any combustible objects on the grids of the electron optical column during
bakeout.

4 After the bakeout procedure, let surfaces cool down before working around the column.

4 Only advanced operators are allowed to perform the bakeout procedure.

Prerequisite ü Requires the Supervisor privilege and the user level Service

ü Only advanced operators are allowed to perform the bakeout procedure

Procedure 1. In the Panel Configuration Bar, double-click Bakeout.
à The Bakeout dialog is displayed.

2. If the Full service bakeout checkbox is available, deactivate the Full service bakeout
checkbox.
INFO: Full service bakeout includes column heating that may lead to column misalignment.

3. From the Bakeout drop-down list, select a bakeout cycle.
For 2 hours heating / 1 hours cooling, select Quick.
For 8 hours heating / 2 hours cooling, select Overnight.
For 40 hours heating / 3 hours cooling, select Weekend.
For a cycle defined by the operator, select User.
INFO: You can switch to Standby mode while the bake-out procedure is running. Before
you switch to Standby mode, ensure that the Partial Vent on Standby checkbox is deacti-
vated in the SEM Controls panel.

4. To start the bakeout procedure, click Bakeout
Start.
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7.2.2 Calibrating OptiProbe

After cathode replacement or after re-alignment of the electron optic column, OptiProbe has to
be calibrated. A calibration wizard facilitates the calibration procedure.

Parts and Tools Designation Part no.

Faraday Cup

orifice diameter at least 200 μm

348342-8055-000

Procedure 1. Load the Faraday cup into the specimen chamber.
2. Set WD = 5 mm and select spot mode.
3. Focus the spot into the orifice of the Faraday cup.
4. From the Windows start menu, select SmartSEM > OptiProbe Calibration.

à The OptiProbeCal dialog is displayed.
5. Click OK.

à The OptiProbeCal window is displayed.
6. To start the calibration, click Start.

à The User Action window is displayed.
7. Click OK.

à An automatic calibration routine is performed, which takes about fifteen minutes.
à When the calibration procedure is finished, a message is displayed.

8. To finish the dialog, click Yes.
à Now OptiProbe is ready to be used.

7.3 Power Circuit

7.3.1 Checking the Position of the Circuit Breakers

NOTICE

Persisting electrical problems
Tripped circuit breakers or blown fuses may be a hint for an electrical problem in the micro-
scope.

4 If a circuit breaker keeps tripping or a fuse keeps blowing, de-energize the microscope
completely and contact your ZEISS service representative for assistance.

No. Value Type Circuit

F10 10 A Circuit breaker Plinth electronics, PC

F12 10 A Fuse Rotary pump 1

Procedure 1. Check if the circuit breaker (F10) on the rear
side of the plinth is tripped.

2. If the circuit breaker is tripped, push the circuit breaker upwards.
3. If the rotary pump 1 is not working, check and possibly replace the fuse (F12).
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7.4 Detectors

7.4.1 Lubricating the Rod

The rod from the aSTEM, BSD4, BSD1, and BSD1-VP detector mechanics need to be lubricated
once a year with TEM oil 300.

Parts and Tools Designation Part no.

TEM oil 300 000000-0484-955

Isopropanol –

Lint-free cloth –

Lint-free gloves –

 CAUTION

Contact with TEM oil 300
TEM Oil 300 may be irritating to the skin and mucous membranes. The separate safety data
sheet contains additional information.

4 Avoid contact with skin.

4 Wear suitable gloves.

4 In case of contact with the eyes, rinse immediately with plenty of water and seek medical
advice.

4 After contact with the skin, wash immediately with plenty of water and soap.

 CAUTION

Isopropanol
Isopropanol is highly flammable and irritating to the eyes.

Vapors may cause drowsiness and dizziness.

4 Wear suitable gloves.

4 Keep away from sources of ignition.

4 Do not smoke.

4 In case of contact with the eyes, rinse immediately with plenty of water and seek medical
advice.

4 Avoid contact with skin.

4 Do not breathe vapor.

NOTICE

Unsuitable lubricants
When using unsuitable lubricants, the vacuum system may be contaminated.

4 Only use TEM oil 300 for lubricating.

Procedure 1. Retract the respective detector.
2. Clean the rod with isopropanol with a clean, lint-free cloth.
3. Spread some drops of TEM oil 300 across the rod.

Use a clean, lint-free cloth.
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7.5 PC

7.5.1 Cleaning up the PC

It is important to periodically clean up the PC. This shortens the boot sequence and loading times.

If necessary, refer to standard Windows manuals for instructions to do this.

Procedure 1. Backup the database to the server or to other storage.
2. Delete the temporary files.
3. Check for adequate free space on the hard drives.
4. Backup the log file (EMServer.log).
5. Erase the original log files in the LOG folders.
6. Check that Windows updates are applied and that service packs are applied.

INFO: Each service pack includes all the patches since the last major release.
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8 Decommissioning and Disposal
This chapter contains information on the decommissioning and disposal of the Microscope Sys-
tem.

8.1 Decommissioning

If the Microscope System is not used for an extended period such as several months, it should be
shut down completely and secured against unauthorized access. Complete decommissioning of
the Microscope System should be executed by your ZEISS service representative.

 WARNING

Malfunction of medical devices near ion getter pumps
Magnetic fields present at the ion getter pumps may disturb the function of medical devices.
The magnetic fields are also present if the microscope is switched off.

If you wear medical implants that are susceptible to magnetic fields (e.g. cardiac pacemakers),
do the following:

4 Keep a distance of at least 30 cm from the ion getter pumps.

4 Follow the safety instructions provided by the pump manufacturer.

 WARNING

Biological hazards
Biological substances may pose a threat to the health of humans and other living organisms.

4 Keep a logbook of the biological substances loaded into the microscope and show it to
the ZEISS service representatives before they perform any work on the microscope.

 WARNING

High leakage current
High leakage currents are present in the microscope. Contact may cause burn or electrical
shock.

4 Ensure proper grounding. For more information, refer to the Installation Requirements
document.

4 Do not operate the microscope without the separate ground connection.

 WARNING

Radiation hazard due to X-rays
X-rays are generated inside the microscope during operation. This is unavoidable because elec-
trons are accelerated by voltages up to 30 kV.

4 Do not remove any parts around the column and chamber that are essential for radiation
protection.

4 Use genuine ZEISS parts exclusively.

4 Ensure that all local safety and X-ray protection regulations are met.

4 Only authorized ZEISS service representatives are allowed to service the microscope.
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 WARNING

Reaction products
Dangerous reaction products can be present in the specimen chamber during or after opera-
tion.

4 Ensure that there is an appropriate exhaust gas line to remove the waste gas of the pre-
vacuum pump and to transmit it to the outside.

4 Wear lint-free gloves when touching the inner parts of the specimen chamber or the speci-
men.

 WARNING

Suffocation hazard due to lack of oxygen
Gaseous dry nitrogen is used to vent the specimen chamber during specimen exchange. Inhal-
ing nitrogen may cause unconsciousness.

4 During specimen exchange, keep the chamber door open as short as possible.

4 Do not inhale the air from within the specimen chamber.

4 Ensure that the area around the microscope is sufficiently vented.

4 If you begin to experience symptoms of asphyxia (for example: rapid breathing, loss of
mental alertness and/or muscular coordination, depression of sensations, emotional insta-
bility, fatigue) leave the room immediately and inform the facility’s safety officer.

Procedure 1. Switch off the Microscope System.
2. Pull the mains plug.

8.2 Transport and Storage

 WARNING

Tilting hazard when removing the microscope from the crate
When removing the microscope from the wooden crate, it can tilt and crush a person.

4 Use a forklift to remove the microscope from the wooden crate.

 WARNING

Crushing hazard when lowering the microscope
The microscope and its components are heavy. When the load is lowered during transport and
positioning, body parts can be crushed.

4 Maintain a safe distance.

4 Do not walk or place your hands or feet under the load while it is being lowered.

4 Wear safety shoes and gloves.
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NOTICE

Damage during transport
Sensitive components of the microscope can get damaged during transport.

4 The microscope may only be transported in air-suspended vehicles.

4 Moving parts must be secured during transport to prevent them from slipping or tipping
over.

4 Install shock/tilt watches.

4 Avoid rocking the crates back and forth.

4 Devices for transporting the microscope must be rated to handle its full weight and dimen-
sions. Note the weight information on the package and on the shipping document.

4 Check that none of the items has been damaged during shipment.

4 Otherwise contact your local ZEISS service representative.

The following regulations must be observed before and during transport:

§ Check if there is any moving equipment available on-site that can be used to safely transport
the Microscope System to the installation room. In clean-room environments, this check is
mandatory.

§ The Microscope System may only be transported in air-suspended vehicles.

§ Moving parts must be secured during transport to prevent them from slipping or tipping over.

§ Avoid rocking the crates back and forth.

§ Devices for transporting the Microscope System must be rated to handle its full weight and di-
mensions.

§ Note the weight information on the package and on the shipping document.

§ Where possible, the original packaging must be used for shipping or transport.

Fork lift and a
hand pallet truck

For on-site transport and unloading a fork lift and a hand pallet truck are necessary.

§ Ensure all hallways and corners are wide enough to be passed with the hand pallet truck.

§ Please check the location requirements for door and hallway widths.

§ Check the entrance to the building and to the final site for suitable ramps and compliant ele-
vators that can match the weights of the system where necessary.

§ Some components, such as the tables, are large, heavy or bulky and may require extra assis-
tance to get the units into the allocated site.

Maximum shock
resistance

§ Do not drop or bump the boxes during movement or storage. (Any acceleration shall be
< 10 g.)

§ Evaluate packaging shock and tilting sensors on delivery and after internal transport.

Packaging The microscope is delivered in two wooden crates:

§ Microscope plinth

Wrapped with recyclable polyethylene-foil and shipped in a reusable wooden crate.

Dimensions and weight of crate:

1350 × 1000 × 2000 mm³ (W × D × H), appr. 750 kg

§ Microscope console and accessories

Console, valve, damper, monitors, cables, pipes etc. are wrapped with recyclable polyethyl-
ene-foil or packed in separate cartons and shipped in a reusable wooden crate.

1400 × 1350 × 1122 mm³ (W × D × H), appr. 350 kg

Check that none of the items has been damaged during shipment.

Guidelines for
Unpacking

Due to the heavy weight of microscopes, a forklift has to be used to remove the microscopes
from the wooden crate:

§ The forklift used must have a sufficient load capacity.
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§ Refer to the weights of the microscope stated in this chapter.

Guidelines for
Transporting

A hand pallet truck has to be used to move the unpacked microscope:

§ Ensure all hallways and corners are wide enough to be passed with the hand pallet truck.

Conditions during
Storage and

Transport

The packed microscope has to be stored in a dry place.

Allowable
temperature

Allowable temperature during on-site storage and transport:

§ Between −10 °C and +70 °C

Info
24 hours before installation of the Microscope System it is required that the boxes be at
recommended room temperature to avoid ingress of humidity, which is very harmful to optical
paths, and to ensure effective stability of the Microscope System during installation and test-
ing.

8.3 Disposal

The Microscope System and its components must not be disposed of as domestic waste or
through municipal disposal companies. They must be disposed of in accordance with applicable
regulations (WEEE Directive 2012/19/EU). ZEISS has implemented a system for the return and recy-
cling of devices in member states of the European Union that ensures suitable reuse according to
the EU Directives mentioned. The customer is responsible for decontamination.

NOTICE

Environmental risk due to disposal of aggressive or toxic chemicals
When disposing of aggressive or toxic chemicals, there is a threat of damage to the environ-
ment.

4 When disposing of waste that has been generated during a service operation (e.g. used ro-
tary pump oil), comply with all national and local safety and environmental protection reg-
ulations.

Info
Detailed information on disposal and recycling is available from your ZEISS Sales & Service Part-
ner.

8.4 Decontamination

A decontamination statement must be submitted before returning any used objects to the ZEISS
location.

If reliable decontamination cannot be guaranteed, the hazard must be marked according to appli-
cable regulations. In general, a well-visible warning sign must be affixed to the article itself and to
the outside of the packaging, together with detailed information on the type of contamination.
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9 Technical Data and Conformity
This chapter contains important technical data as well as information on the conformity.

9.1 Performance Data and Specifications | Sigma 300 and Sigma 300 VP

The Microscope System must only be operated in closed rooms. It is recommended to install the
Microscope System in a dark room where artificial illumination, sunlight or other light sources
cannot interfere with image acquisition. The Microscope System should not be installed near win-
dows with direct sunlight or radiators. Compliance with the installation requirements of the Mi-
croscope System and the availability of the requested supplies is the responsibility of the customer
and has to be provided at the time of installation. Due to continuous development, we reserve the
right to change specifications without notice.

The Microscope System must be plugged into a properly installed power socket with protective
earth contact using the supplied mains cable. The protective earth connection must not be im-
paired by the use of extension cables.

Info
Your ZEISS Sales & Service Partner will provide you with the detailed installation requirements.

Weight and Sizes Main Components Length
(mm)

Width (mm) Height
(mm)

Weight (kg)

Plinth + column 822 960 1757 636

Table + PC 1133 1076 826 85

Static damping block 180 180 160 44

Quiet mode option 324 324 300 17.0

Pre-vacuum pump 430 250 290 26

Electron Optics Parameter Description

SEM resolution Gemini column in high resolution configuration (max. probe current
20 nA) at optimum working distance:

§ 1.0 nm at 30 kV (STEM mode)

§ 1.0 nm at 15 kV

§ 1.6 nm at 1 kV

Acceleration volt-
age

Range: 20 V to 30 kV

Adjustment: Continuously variable in 10 Volt steps

Probe current 20 nA high resolution configuration: 3 pA to 20 nA

100 nA high current configuration: 6 pA to 100 nA

Probe current selection via seven apertures (six apertures in case of
100 nA configuration) with electromagnetic selection and precise
alignment

Optional OptiProbe module for continuous probe current adjust-
ment

Magnification Range: 10x – 2,000,000x referenced to Polaroid 5" × 4.5" image for-
mat
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Parameter Description

Electron source Filament: Schottky field emitter

Automatic emitter run-up: Safe controlled run-up to the target
emitter conditions

Objective lens Type: Gemini electromagnetic/electrostatic objective lens system (80º
conical final lens) with water cooling for best thermal stability and re-
producibility

Focus Working distance: Range from 0.1 mm to 50 mm, depending on
operating conditions and stage configuration

Focus compensation: Automatic compensation to minimize focus
changes over the entire acceleration voltage range

Dynamic focus: For correction of focus on tilted specimens

Focus wobble: For assistance in aperture alignment, with adjustable
amplitude and speed

Rotation compensation: Automatic correction of apparent image
rotation with changes in working distance

Beam shift For precise adjustment of image position at high magnifications

Maximum scan
speed

50 ns/pixel

Image framestore 4:3 format with 16 bit dynamic range

§ 1024 × 768 pixels

§ 2048 × 1536 pixels

§ 3072 × 2304 pixels

§ 4096 × 3072 pixels

§ 6144 × 4608 pixels

§ 8192 × 6144 pixels

§ 12288 × 9216 pixels

§ 24576 × 18432 pixels

§ 32768 × 24576 pixels

Dual channel and quad mode are only available for maximum
12k × 9k and scan speed 2 upwards.

32k × 9k is only available for normal scans, scan speed 2 upwards.

DCFA is limited to maximum 4k × 3k.

32k × 24k can only be used for SmartSEM (not in combination with
Zen applications).

System control SmartSEM user interface operated by mouse and keyboard

Windows 10 multilingual operating system

Specimen Chamber
and Stage

Parameter Description

Specimen chamber
dimensions

§ 365 mm inner diameter

§ 275 mm height

Free accessory
ports

10
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Parameter Description

Dedicated EDS
ports

1

Analytical working
distance

8.5 mm

Specimen stage Type: 5-axes motorized Cartesian controlled via the SmartSEM user
interface or operated by a dual joystick control box

Mounting: Drawer-type door

Movements:

§ X/Y = 125 mm

§ Z = 50 mm

§ T = −10° to 90°

§ R = 360° continuous

INFO: The movements may be reduced by specimen size, operating
conditions, and accessories attached.

Accessory ports: Two accessory ports on the stage door are pro-
vided

Specimen weight: Up to 0.5 kg all axes, up to 2 kg without tilt, up
to 5 kg on XY platform only

Specimen current monitor with integrated Touch Alarm (audible
touch alarm warning with on-screen message)

Specimen mounts: One carousel 9x specimen holder for 13 mm di-
ameter stubs included in base tool configuration, various specimen
holders available as option

Plasma cleaner
(optional)

Integrated plasma cleaner: Chamber mounted plasma cleaner for
removal of hydrocarbon contamination from both specimen and
chamber; integrated software control for user defined cleaning cycles
without user interaction after starting the cleaning process

Vacuum Modes § High vacuum

§ Variable pressure (optional) 10–133 Pa

Detection System Parameter Description

InLens detectors InLens SE detector:

High efficiency annular scintillator detector mounted in Gemini col-
umn with optically coupled photomultiplier.

Chamber detectors SE detector:

Everhart-Thornley SE detector with optically coupled photomultiplier;
collector bias adjustable from −250 to +400 V

VPSE detector (optional, only for VP mode):

Fourth generation variable pressure secondary electron detector for
imaging in VP mode with up to 85 % improvement in Weber contrast
ratio

C2D detector (optional; only for VP mode):
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Parameter Description

Cascade Current Detector with floating amplifier electronics, for en-
hanced imaging in Variable Pressure mode up to 133 Pa. Delivers de-
tail at low kV for specimens that demand higher pressures, e.g. poly-
mers, bio specimens, pharmaceuticals, powders, and fibers. Enhanced
signal-to-noise ratio versus VPSE detector.

aBSD1-LH detector (optional):

Pneumatically retractable 5 segment multi-mode solid state BSE de-
tector; enables materials contrast, crystal orientation, and topographic
imaging

HDBSD detector (optional):

High definition retractable four quadrant or five segment 16 mm solid
state diode backscattered detector fitted below the objective lens as-
sembly. Provides superb compositional BSE imaging at low kV of met-
als, polymers, minerals, etc. both in HV and VP modes.

YAG BSD detector (optional):

Robust, fully retractable, YAG-crystal-based BSE scintillator detector
with rise time ~200 ns. Easy to use with no amplifier gain adjustment
required.

HDAsB detector (optional):

Crystallographic and channeling contrast imaging of metals and min-
erals. Four-quadrant solid state BSD diode (each segment 10 mm²) in-
tegrated in the Gemini objective lens for the detection of angular se-
lective backscattered (AsB) electrons. BSD imaging is possible at accel-
eration voltages above 1 kV. Allows operation at short working dis-
tance.

Modified instrument resolution because of the 2 mm additional
height of the HDAsB detector is indicated in the resolution values. The
WD indication is automatically corrected, i.e. the displayed WD is the
real distance between the specimen surface and the HDAsB detector
bottom side.

CL detector (optional):

Cathodoluminiscence (CL) chamber detector (option for non-VP con-
figurations, included in VP option)

aSTEM detector (optional):

Pneumatically retractable multi-mode annular Scanning Transmission
Electron Microscopy (aSTEM) detector, with 12x specimen holder; en-
ables bright field (BF), dark field (DF), oriented dark field (ODF), and
high angle annular dark field (HAADF) transmission imaging

Chamber camera Color CCD camera with white-light illumination and IR illumination.

Specimen current
monitor

Auto ranging for precise current measurement in the range of 1 pA to
10 μA

For more details refer to the document Product Specification.
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9.2 Performance Data and Specifications | Sigma 500 and Sigma 500 VP

The Microscope System must only be operated in closed rooms. It is recommended to install the
Microscope System in a dark room where artificial illumination, sunlight or other light sources
cannot interfere with image acquisition. The Microscope System should not be installed near win-
dows with direct sunlight or radiators. Compliance with the installation requirements of the Mi-
croscope System and the availability of the requested supplies is the responsibility of the customer
and has to be provided at the time of installation. Due to continuous development, we reserve the
right to change specifications without notice.

The Microscope System must be plugged into a properly installed power socket with protective
earth contact using the supplied mains cable. The protective earth connection must not be im-
paired by the use of extension cables.

Info
Your ZEISS Sales & Service Partner will provide you with the detailed installation requirements.

Weight and Sizes Main Components Length
(mm)

Width (mm) Height
(mm)

Weight (kg)

Plinth + column 822 960 1757 636

Table + PC 1133 1076 826 85

Static damping block 180 180 160 44

Quiet mode option 324 324 300 17.0

Pre-vacuum pump 430 250 290 26

Electron Optics Parameter Description

SEM resolution Gemini column in high resolution configuration (max. probe current
20 nA) at optimum working distance:

§ 0.8 nm at 30 kV (STEM mode)

§ 0.8 nm at 15 kV

§ 1.3 nm at 1 kV

Acceleration volt-
age

Range: 20 V to 30 kV

Adjustment: Continuously variable in 10 Volt steps

Probe current 20 nA high resolution configuration: 3 pA to 20 nA

100 nA high current configuration: 6 pA to 100 nA

Probe current selection via seven apertures (six apertures in case of
100 nA configuration) with electromagnetic selection and precise
alignment

Optional OptiProbe module for continuous probe current adjust-
ment

Magnification Range: 12x – 2,000,000x referenced to Polaroid 5" × 4.5" image for-
mat

Electron source Filament: Schottky field emitter

Automatic emitter run-up: Safe controlled run-up to the target
emitter conditions
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Parameter Description

Objective lens Type: Gemini electromagnetic/electrostatic objective lens system (80º
conical final lens) with water cooling for best thermal stability and re-
producibility

Focus Working distance: Range from 0.1 mm to 50 mm, depending on
operating conditions and stage configuration

Focus compensation: Automatic compensation to minimize focus
changes over the entire acceleration voltage range

Dynamic focus: For correction of focus on tilted specimens

Focus wobble: For assistance in aperture alignment, with adjustable
amplitude and speed

Rotation compensation: Automatic correction of apparent image
rotation with changes in working distance

Beam shift For precise adjustment of image position at high magnifications

Maximum scan
speed

50 ns/pixel

Image framestore 4:3 format with 16 bit dynamic range

§ 1024 × 768 pixels

§ 2048 × 1536 pixels

§ 3072 × 2304 pixels

§ 4096 × 3072 pixels

§ 6144 × 4608 pixels

§ 8192 × 6144 pixels

§ 12288 × 9216 pixels

§ 24576 × 18432 pixels

§ 32768 × 24576 pixels

Dual channel and quad mode are only available for maximum
12k × 9k and scan speed 2 upwards.

32k × 9k is only available for normal scans, scan speed 2 upwards.

DCFA is limited to maximum 4k × 3k.

32k × 24k can only be used for SmartSEM (not in combination with
Zen applications).

System control SmartSEM user interface operated by mouse and keyboard

Windows 10 multilingual operating system

Specimen Chamber
and Stage

Parameter Description

Specimen chamber
dimensions

§ 358 mm inner diameter

§ 270.5 mm height

Free accessory
ports

14

Dedicated EDS
ports

2
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Parameter Description

Analytical working
distance

8.5 mm

Specimen stage Type: 5-axes motorized eucentric controlled via the SmartSEM user
interface or operated by a dual joystick control box

Mounting: Drawer-type door

Movements:

§ X/Y = 130 mm

§ Z = 50 mm

§ T = −4° to 70°

§ R = 360° continuous

INFO: The movements may be reduced by specimen size, operating
conditions, and accessories attached.

Accessory ports: Two accessory ports on the stage door are pro-
vided

Specimen weight: Up to 0.5 kg

Specimen current monitor with integrated Touch Alarm (audible
touch alarm warning with on-screen message)

Specimen mounts: One carousel 9x specimen holder for 13 mm di-
ameter stubs included in base tool configuration, various specimen
holders available as option

Plasma cleaner
(optional)

Integrated plasma cleaner: Chamber mounted plasma cleaner for
removal of hydrocarbon contamination from both specimen and
chamber; integrated software control for user defined cleaning cycles
without user interaction after starting the cleaning process

Vacuum Modes § High vacuum

§ Variable pressure (optional) 10–133 Pa

Detection System Parameter Description

InLens detectors InLens SE detector:

High efficiency annular scintillator detector mounted in Gemini col-
umn with optically coupled photomultiplier.

InLensDuo detector (optional):

Column-mounted scintillator detector and optically coupled photo-
multiplier with energy filtering grid adjustable from 0 V to −1.5 kV.
Enables two detection modes:

SE detection mode: high efficiency InLens SE detection with filtering
grid disabled.

BSE detection mode: high efficiency InLens detection of energy and
angle selective BSE using the energy filtering grid.

Simultaneous usage of the two detection modes is not possible. VP
range is limited to 50 Pa.

Chamber detectors SE detector:

Everhart-Thornley SE detector with optically coupled photomultiplier;
collector bias adjustable from −250 to +400 V
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Parameter Description

VPSE detector (optional, only for VP mode):

Fourth generation variable pressure secondary electron detector for
imaging in VP mode with up to 85 % improvement in Weber contrast
ratio

C2D detector (optional; only for VP mode):

Cascade Current Detector with floating amplifier electronics, for en-
hanced imaging in Variable Pressure mode up to 133 Pa. Delivers de-
tail at low kV for specimens that demand higher pressures, e.g. poly-
mers, bio specimens, pharmaceuticals, powders, and fibers. Enhanced
signal-to-noise ratio versus VPSE detector.

aBSD1-LH detector (optional):

Pneumatically retractable 5 segment multi-mode solid state BSE de-
tector; enables materials contrast, crystal orientation, and topographic
imaging

HDBSD detector (optional):

High definition retractable four quadrant or five segment 16 mm solid
state diode backscattered detector fitted below the objective lens as-
sembly. Provides superb compositional BSE imaging at low kV of met-
als, polymers, minerals, etc. both in HV and VP modes.

BSD4 detector (optional):

Pneumatically retractable multi-mode solid state Backscattered Elec-
tron Detector (BSD); enables materials contrast, crystal orientation,
and topographic imaging; diode with 4 sectors and one additional
segment. Provides 4 parallel outputs for 3D surface reconstruction
and surface roughness measurements. Can be used in conjunction
with optional metrology software.

YAG BSD detector (optional):

Robust, fully retractable, YAG-crystal-based BSE scintillator detector
with rise time ~200 ns. Easy to use with no amplifier gain adjustment
required.

HDAsB detector (optional):

Crystallographic and channeling contrast imaging of metals and min-
erals. Four-quadrant solid state BSD diode (each segment 10 mm²) in-
tegrated in the Gemini objective lens for the detection of angular se-
lective backscattered (AsB) electrons. BSD imaging is possible at accel-
eration voltages above 1 kV. Allows operation at short working dis-
tance.

Modified instrument resolution because of the 2 mm additional
height of the HDAsB detector is indicated in the resolution values. The
WD indication is automatically corrected, i.e. the displayed WD is the
real distance between the specimen surface and the HDAsB detector
bottom side.

CL detector (optional):

Cathodoluminiscence (CL) chamber detector (option for non-VP con-
figurations, included in VP option)
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Parameter Description

aSTEM detector (optional):

Pneumatically retractable multi-mode annular Scanning Transmission
Electron Microscopy (aSTEM) detector, with 12x specimen holder; en-
ables bright field (BF), dark field (DF), oriented dark field (ODF), and
high angle annular dark field (HAADF) transmission imaging

Chamber camera Color CCD camera with white-light illumination and IR illumination.

Specimen current
monitor

Auto ranging for precise current measurement in the range of 1 pA to
10 μA

For more details refer to the document Product Specification.

9.3 Installation Requirements

Info
For a complete list of the installation requirements, refer to the document Installation Require-
ments.

Location
Requirements

Parameter Requirement

Installation site Exclusively inside buildings

Recommended
room size

Min. 3.6 m × 5.0 m × 2.3 m

Service area Min. 0.8 m at each side

Entrance Min. 0.8 m wide

Hallways Min. 1.0 m wide

Corners Min. 1.2 m wide

Transport ways Free of staircases

Installation cate-
gory

II

Floor stability > 1000 kg/m2

Exhaust Line If toxic chemicals or biological specimens are used an exhaust line is recommended to remove the
waste gas of the pre-vacuum pump and to transmit it to the outside.

Electrical Supplies Parameter Requirement

Nominal AC volt-
age

230 VAC 1/N/PE or

208 VAC 2/PE

The provided electrical connection must be in accordance with the ap-
plicable electrical codes for the country of installation. In order to
avoid disturbance from other installed machines, ZEISS recommends
using a separate power connection to the main distribution panel.

Protection class Class I

Nominal frequency 50–60 Hz

Instruction Manual ZEISS SIGMA series | en-US | Rev. 7 | 352102-9344-006 155



9 Technical Data and Conformity | 9.3 Installation Requirements ZEISS

Parameter Requirement

Momentary inter-
ruption

Less than a half cycle

System connection The microscope is delivered with a 3 m long power cord that is
equipped with a 200–250 VAC CEE MALE PLUG 2P3W 6h 16A (blue)
according to IEC 60309.

The supplied connection cable must not be replaced with another
one. Otherwise, the conformity with listed standards becomes invalid.

The building installation should provide the corresponding 200–250
VAC CEE FEMALE RECEPTACLE 2P3W 6h 16A (blue) with the correct
wiring 1/N/PE or 2/PE and the desired approvals of the country used.

To avoid disturbance from other installed machines Carl Zeiss Mi-
croscopy recommends to use a separate power connection to the
main distribution panel.

Power consump-
tion

Max. 3 kVA, dependent on accessories

Circuit breaker (at
house installation)

16 A Type C

Ampere interrupt-
ing capacity (AIC)

1500 A rms without external EMO box

10000 A rms with external EMO box

Protective ground High leakage currents are present in the microscope. Therefore, the
microscope has to be connected to a separate protective ground.

An exclusive grounding connection to earth must be provided as part
of the building installation, i.e. a grounding screw terminal (Ø 8 mm)
which is directly connected to the PE of the FEMALE RECEPTACLE as
short as possible. (refer to picture)

This grounding connection must not be common to other electrical
equipment.

A grounding wire AWG10 (≥ 5 m) is delivered with the microscope. It
serves as connection between the grounding screw terminal (Ø 8 mm)
and the microscope (Ø 6 mm).

Cross section: Min. AWG10 (between grounding screw terminal and
PE of the CEE FEMALE RECEPTACLE)2
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Cooling Water Major components of the microscope such as electron-optic lenses, parts of the electronics and
the turbo molecular pump are water-cooled. Any cooling solution has to fulfil the following re-
quirements.

Parameter Requirement

Water flow rate > 1.5 l/min

Pressure 2–3 bar

Water tempera-
ture

18–22 °C

Stability 0.5 °C/10 min

Heat dissipation 1 kW

Connection hose 8 mm inside diameter. One 25 m roll is delivered with the microscope.

Instrument con-
nection

Quick exchange connectors. Two are delivered with the microscope.

Nitrogen Gaseous dry nitrogen is used to vent the specimen chamber during specimen exchange. The nitro-
gen can be taken either from a gas cylinder or from an in-house supply system.

The connection must be equipped with an appropriate pressure reducer and a shut-off valve that
is secured against accidental re-activation.

Parameter Requirement

Flow rate Approx. 3 l/min for ventilation of specimen chamber with chamber
door open

Pressure 0.2–3.3 bar

Quality 4.6 with nitrogen content > 99.996 %

Connection hose 4 mm inside diameter. 10 m are delivered with the microscope.

Instrument con-
nection

Quick exchange connector. One is delivered with the microscope.

Compressed Air Compressed air is used to operate several valves and the auto leveling system. The necessary com-
pressed air can be either generated by a compressor (part no. 345596-0000-000) or taken from a
gas cylinder or from an in-house supply system.

The connection must be equipped with an appropriate pressure reducer and a shut-off valve that
can be secured against accidental re-activation.

Parameter Requirement

Typical flow rate Less than 1 l/min during normal operation

Pressure 0.6–0.8 MPa (6–8 bar)

Quality Oil-free

Connection hose 4 mm inside diameter. 10 m of pipe are delivered with the micro-
scope.

Instrument con-
nection

Quick exchange connector. One is delivered with the microscope.

INFO: Due to acoustic noise and vibrations the compressor – if used –
should be installed in a separate room.
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Environmental
Requirements

Parameter Requirement

Ambient tempera-
ture

Appr. 21±4 °C

Stability of ambi-
ent temperature

0.5 °C/h

For long-running
experiments:
Long-term stability
of ambient tem-
perature

2 °C/24 h

Relative humidity Less than 65 %

Altitude Max. 2000 m above sea level to guarantee an undisturbed operation

Pollution degree 2

Electrical field The microscope is a class A device (industrial). The microscope is de-
signed to operate in a controlled electromagnetic environment. This
means that devices with RF transmitters such as mobile phones or
DECT phones must not be used in close proximity.

Vibrations Horizontal vibrations (in x/y-direction)

Up to 10 Hz: less than 0.04 mm/s

10–20 Hz: less than 0.17 mm/s

20–70 Hz: less than 0.30 mm/s

Above 70 Hz: less than 20 mm/s

Vertical vibrations (in z-direction)

Up to 8 Hz: less than 0.03 mm/s

8–45 Hz: less than 0.15 mm/s

Above 45 Hz: less than 2.00 mm/s

Magnetic stray
fields

Less than 3 mG peak to peak between 10 Hz and 1 kHz (Sigma 300)

Less than 1 mG peak to peak between 10 Hz and 1 kHz (Sigma 500)

Acoustic noise Sigma 300:

Less than 53 dB for frequencies up to 200 Hz

Less than 42 dB for frequencies from 200 up to 300 Hz

Less than 50 dB for frequencies higher than 300 Hz

Sigma 500:

Less than 50 dB for frequencies up to 200 Hz

Less than 40 dB for frequencies from 200 up to 400 Hz

Less than 45 dB for frequencies higher than 400 Hz
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9.3.1 Layout and Connections

A

B
C

D

E

F

12

3 4

G

1   Static vibration damper A Mains power supply 208...230 V,
max. 16 A

2   Pre-vacuum pump Equipotential bonding bar, afety
earth

3   Plinth and column Vacuum exhaust

4    Computer workplace Chilled water supply

Dry compressed air

Dry nitrogen supply

Additional standard local mains
power sockets, max. 13 A
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9.3.2 System Layout
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9.4 Applicable Standards and Regulations

Observe all general and country-specific safety regulations as well as applicable environmental
protection laws and regulations.

The Microscope System is in compliance with the requirements of the following regulations and
directives:

2006/42/EC Machine Directive

2011/65/EU RoHS Directive

2014/30/EU Electromagnetic Compatibility

KN 11 Industrial, scientific and medical equipment –
Radio-frequency disturbance characteristics –
Limits and methods of measurement

KN 61000-6-2 Electromagnetic compatibility (EMC) – Part
6-2: Generic standards – Immunity standard
for industrial environments

EN 60204-1:2006/A1:2009 Safety of machinery – Electrical equipment of
machines – Part 1: General requirements

EN 61010-1:2010 Safety requirements for electrical equipment
for measurement, control, and laboratory use
– Part 1: General requirements

EN 61326-1:2018 Electrical equipment for measurement, con-
trol and laboratory use – EMC requirements –
Part 1: General requirements

EN ISO 12100:2010 Safety of machinery – General principles for
design – Risk assessment and risk reduction

EN ISO 13849-1:2015 Safety of machinery – Safety related parts of
control systems – Part 1: General principles
for design

The product and its accessories have been classified as instrument category 9 (laboratory equip-
ment or comparable standard). The product and its accessories comply with the EU-regulations
2011/65/EU (RoHS) and 2012/19/EU (WEEE), as applicable for the product.

In addition to the European and international guidelines and standards, the 21 CFR §1040.10:
"Performance Standards for light emitting products - laser products" applies for the USA.

The following EMC user notice is for Korea only:

기종별 사용자안내문

A급기기(업무용방송통신기자재) 이기기는업무용(A급) 전자파적합기기로서
판매자또는사용자는이점을주의하시기바라
며, 가정외의지역에서사용하는것을목적으
로합니다.

European and International Directives / Standards: For more information on ISO, CSA, SEMI certifi-
cates or CE Declarations of Conformity, contact your ZEISS Sales & Service Partner.

ZEISS works according to a certified Environment Management System according to ISO 14001.
The product was developed, tested and produced in accordance with the valid regulations and
guidelines for environmental law of the European Union.
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10 Parts and Tools

NOTICE

Spare parts and consumables
Using spare parts or consumables that are not provided by ZEISS can lead to property damage.

4 Only genuine spare parts and consumables supplied by ZEISS are to be used in servicing
the microscope.

4 Contact your ZEISS service representative for information regarding how to order spare
parts and consumables.

4 Unless otherwise authorized by ZEISS, all spare parts and consumables must be installed by
a ZEISS service representative.

10.1 Tools and Accessories

Required Parts/Tools Part Number

Faraday cup 348342-8055-000

3 mm Allen key 000000-0015-247

1.5 mm Allen key 000000-0151-883

Small pliers –

Specimen holders Refer to specimen holder catalog.

Stubs –

Tweezers –

Lint-free cloth –

Lint-free gloves –
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aBSD

Annular Backscattered Electron Detector

AIC

Ampere Interrupting Capacity

Aperture

Mechanical limitation of an opening ori-
ented perpendicular to the optical axis,
which filters out electrons whose trajec-
tories (tracks) do not run close to the op-
tical axis.

AsB

Angle-selective Backscattered

aSTEM

Annular Scanning Transmission Electron
Microscopy

Astigmatism

Lens aberration that distorts the shape of
the electron beam, compensated by the
stigmator.

Backscattered electrons

High-energy electrons that are liberated
from the specimen surface when the
specimen is hit by the primary electron
beam.

Bakeout

Degassing of surfaces of a vacuum sys-
tem by heating during the pumping
process.

Beam booster

Anode and liner tube of the Gemini col-
umn are connected mechanically and
electrically forming the beam booster. A
booster voltage (UB, liner voltage) of
+8 kV is applied to the beam booster, so
that a high beam energy is maintained
throughout the entire column. The beam
booster technique has two main advan-
tages: It minimizes beam widening, that
may occur due to stochastic electron-
electron interactions. Consequently there
is almost no loss in beam brightness,
even at low acceleration voltages. Sec-
ondly, the beam booster technique en-
hances protection against external stray
fields.

BSD

Backscattered Electron Detector

BSE

Backscattered Electron

C2D

Cascade Current Detector

CC

Charge Compensator, Charge Compensa-
tion

CCD

Charge-Coupled Device

CL

Cathodoluminescence

Condenser

Device that collects and focuses the elec-
tron beam onto the specimen.

D

Depth

DECT

Digital Enhanced Cordless Telecommuni-
cations

Depth of field

Distance along the optical axis which an
object in the specimen can be moved
while remaining in focus.

EBIC

Electron Beam Induced Current

EBSD

Electron Backscatter Diffraction

EC

European Community

EDS

Energy Dispersive X-ray Spectroscopy

EDX

Energy Dispersive X-ray Spectroscopy
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EHT

Extra High Tension

EIGA

European Industrial Gases Association

EM server

A server that implements the internal
communication between control soft-
ware and microscope hardware.

EMC

Electromagnetic Compatibility

EMO

Emergency Off

Eucentric

Type of stage, the rotation axes of which
intersect in the same point. The specimen
surface is located in the eucentric point,
where the tilt axis meets the beam axis.
This guarantees that the focus is main-
tained when the specimen is tilted at a
certain working distance.

Extractor

Positive electrode that attracts electrons
from the filament.

Faraday cup

Small insulated metal container,
equipped with an aperture where elec-
trons can enter but not escape. Used to
measure the specimen current in the mi-
croscope.

FESEM

Field Emission Scanning Electron Micro-
scope

Focus wobble

Function that sweeps the focus of the
objective lens backwards and forward
through the focus on the specimen
plane. When the aperture is misaligned a
lateral shift is observed.

GIS

Gas Injection System

GUI

Graphical User Interface

H

Height

HD

High Definition, an imaging component's
or technique's attribute of yielding an in-
creased amount of information per area
compared to concurrent components or
techniques

HDAsB

High Detection Angle-selective Backscat-
tered

HDBSD

High Detection Backscattered Electron
Detector

HV

High Vacuum

IGC

Industrial Gases Council

IGP

Ion Getter Pump

IR

Infrared

MSDS

Material Safety Data Sheet

Operator

A trained person, who is assigned to op-
erate the microscope. Basic operator:
Person who has been trained to perform
fundamental operation sequences. Ad-
vanced operator: Technically skilled per-
son who has in addition been trained to
perform basic maintenance tasks.

OptiProbe

Optional function which allows you to
continuously adjust the probe current.

PC

Personal Computer

PE

Protective Earth (ground)

PE

Primary Electron
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Penning gauge

Device for measuring high vacuum in the
vacuum system.

Pre-vacuum pump

A pump for generating a pre-vacuum.

Primary electron beam

Narrowly bundled beam of accelerated
electrons that hit the specimen surface.

R

R-axis (Rotation)

RF

Radio Frequency

SCD

Specimen Current Detector

Schottky field emitter

Type of electron source in which emis-
sion occurs at or near the work function
barrier.

Scintillator

Substance that absorbs electrons and in
response, fluoresces photons while re-
leasing the previously absorbed energy.

SE

Secondary Electron

Secondary electrons

Low-energy electrons that are emitted
from the specimen surface when the
specimen is hit by the primary electron
beam. Secondary electrons are generated
by inelastic scattering.

SEM

Scanning Electron Microscope

SEMI

Semiconductor Equipment and Materials
International (SEMI) is a industry associa-
tion comprising companies involved in
the electronics design and manufacturing
supply chain.

SmartSEM

Operating software for ZEISS scanning
electron microscopes.

SMT

Semiconductor Manufacturing Technolo-
gies

STEM

Scanning Transmission Electron Micro-
scope

Stigmator

Compensates astigmatism (lens aberra-
tion), so that the electron beam becomes
rotationally symmetrical.

Suppressor

Electrode (anode) that suppresses un-
wanted thermionic emission from the
shank of the Schottky field emitter.

T

T-axis (Tilt)

TEM

Transmission Electron Microscope

U

Voltage

UIF

User Interface

User

Person examining a sample under the mi-
croscope.

VP

Variable Pressure

VPSE

Variable Pressure Secondary Electron

W

Width

WD

Working Distance

WDS

Wavelength Dispersive X-ray Spec-
troscopy

WDX

Wavelength Dispersive X-ray Spec-
troscopy
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WEEE

Waste Electrical and Electronic Equip-
ment

X

X-axis

X-ray

Type of high energy electromagnetic ra-
diation, that is generated during the op-
eration of electron microscopes.

Y

Y-axis

YAG

Yttrium Aluminum Garnet

Z

Z-axis

ZEISS

ZEISS is an internationally leading tech-
nology enterprise operating in the fields
of optics and optoelectronics. Further in-
formation about ZEISS can be found at
www.zeiss.com.

ZEISS Sales & Service Partner

The Sales & Service Partner is generally in
the field for customer support in a re-
gional area and / or a clearly defined cus-
tomer group.

ZEISS service representative

Specially trained service expert, either
ZEISS staff or authorized service partner
of ZEISS.
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A
aBSD1-LH detector  63, 104
Accessory  162
Adjusting

Probe current  98
Analytic gun mode  34, 96
Aperture  130
Arcing  131
aSTEM detector  141

B
Backscattered electron  36
Backscattered electrons  57
Bakeout  133, 138
Baking out the gun head  138
Beam booster  33
BSD detector  57, 60, 107
BSD1-VP detector  141
BSD4 detector  141
BSE  57

C
C2D detector  52, 103
Cathodoluminescence  36, 67
CCD camera  52
Chamber CCD camera  52
Chamber door seal  137
Chamberscope  52
Charging  133
Checking

Position of the circuit breaker  140
Temperature  136

Chemicals  130
Circuit breaker  140
CL detector  67, 108
Comissioning  78
Compressed air  134
Consumable and chemical  130
Consumables  130
Contamination  146
Control panel  69
Cover panel, protective  23

D
Decontamination  146
Detector  36, 99

aBSD1-LH  63, 104
aSTEM  141
BSD  57, 60, 107
BSD1-VP  141
BSD4  141
C2D  52, 103
CL  67, 108
Everhart-Thornley  44
HDAsB  57, 64, 105
HDBSD  57, 60
InLens Duo  56
InLens SE  38, 100
InLensDuo  100
SCD  67
SE  44, 101
STEM  65
VPSE  49, 102
YAG BSD  65, 108

Detector settings  100
Disposal  143, 146
Drift  133
Dual joystick  68

E
EHT  33
Electron optical column  32
Emergency shutdown  129
Emitter life  130
Everhart-Thornley detector  44
Extractor voltage  98

F
Faraday cup  97
Field emission gun  131
Filament  131
Focus wobble  93
Fuse  140

G
Gas ballast  134
Gemini 1 column  32
General Safety Information  11
GUI  71
Gun  131
Gun head, bakeout  138
Gun mode

Analytic  34, 96
Imaging  34, 96
Normal  34, 96

Gun vacuum  134

H
Hazard
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Biological hazard  12
Burn hazard  12
Chemical hazard  13
Electrical hazard  14
High pressure hazard  14
Magnetic field hazard  14
Mechanical hazard  16
Radiation hazard  16
Suffocation hazard  17

Hazards  12
Prevention  12

HDAsB detector  57, 64, 105
HDBSD detector  57, 60

I
Illumination  115
Image

Acquisition  83, 91
Optimization  93
Quality  133
Saving  96

Imaging gun mode  34, 96
Initializing the stage  134
InLens Duo detector  56
InLens SE detector  38, 100
InLensDuo detector  100
Installation  76
Intended use  10, 11

J
Joystick TV angle  135

K
Keyboard Shortcut  82

L
License

REDUCED  94
Lubricating the rod  141

M
Main Switch  25
Maintenance  130

Consumable and chemical  130
interval  130
schedule  130
work  130

Microscope
De-energizing  128
Shutdown  143
Switching on  79, 81

N
Nitrogen  134

O
ON/OFF switch  24
Online help  81
Operation  78
Operator

Basic  11
Training  11

Optimizing the image  93
OptiProbe  98, 140

P
Penning gauge  134
Performance data  147, 151
Plasma cleaner  118

Recipe  119
Schedule  121

Power failure  133
Preventive maintenance  12
Primary electron  35
Probe current  97, 98

Q
Quiet Mode  31

R
Raman spectroscopy  122
Recipe

Plasma cleaning  119
Related documents  8
Replacing the chamber door seal  137
Requirements for personnel  11
Resetting the touch alarm  136

S
Safe operation conditions  11
Safety  10, 130

devices  22
interlocks  22
Safety label  18
Safety procedures  11

Saving images  96
SCD detector  67
Scintillator  130
SE detector  44, 101
Secondary electron  35
Service  11
Servicing the pre-vacuum pump  131
Setting the probe current  98
Shortcuts  82
Shutdown

Emergency  129
Finishing the work session  126
Microscope  143

Signal detection  34
SmartSEM
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User interface  71
SmartSEM program suite  74
SmartSEM user interface  71
Software  8, 71
Software manual  8
Spare parts  12
Special Keys  82
Specimen current  97
Stage

Post initialization position  135
Stage control  68
Stage initialization  134
Starting SmartSEM  81
Starting the microscope  81
STEM detector  65
Switching off

Gun  139
Microscope  128

Switching on
EHT  90
Gun  90
Microscope  79, 81

Switiching to standby  126
System vacuum  134

T
Temperature  136
Tool  162
Touch alarm, reset  136
Transfer position  111, 112
Transmitted electron  36
Troubleshooting  133
Type plate  22

U
User access level  73
User interface  71
User privilege  73

V
Vacuum  134
Vacuum mode  109

High Vacuum (HV)  110
Variable Pressure (VP)  109

Vacuum system  30, 31
Variable pressure  109
Variable pressure mode  31
VP mode  31
VPSE detector  49, 102

W
Warning

labels  18
lights  18

Weight and Sizes  147, 151

Y
YAG BSD detector  65, 108

Z
ZEISS

Portal  8
Service agreements  130
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Carl Zeiss Microscopy GmbH
Carl-Zeiss-Promenade 10
07745 Jena
Germany

phone: +49 1803 33 63 34
fax: +49 3641 64 3439

info.microscopy.de@zeiss.com
www.zeiss.com/microscopy
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